
ID_INDICATOR_EXT 0x1E700



ID_INDICATOR_CAPS 0x1E701



ID_INDICATOR_NUM 0x1E702



ID_INDICATOR_SCRL 0x1E703



ID_INDICATOR_OVR 0x1E704



ID_INDICATOR_REC 0x1E705



ID_INDICATOR_KANA 0x1E706



ID_SEPARATOR 0x10000



New
Opens a fresh Corel WEB.DESIGNER Application Window to allow you to create a new Web document. You can 
also open a new Corel WEB.DESIGNER Application Window by pressing CTRL + N.



Open
Opens the Open dialog box to enable you open a local Web page or a Web page from the Internet. You can also 
access the Open dialog box by pressing CTRL + O.



ID_FILE_CLOSE 0x1E102



Save
Saves the current Web page. When you save a Web page for the first time, Corel WEB.DESIGNER displays the 
Save As dialog box to allow you to name your file. We recommend that you save your Web pages in your server 
root folder. You can also save a document by pressing CTRL + S.



Save As
Opens the Save As dialog box to allow you to name and save your current file. To save a document with its 
existing name and folder, click File, Save. It is recommended that you save your Web page inside your server 
root folder.



ID_FILE_PAGE_SETUP 0x1E105



Print Setup
Opens the Print Setup dialog box to allow you to select a printer and a printer connection and to modify your 
print properties.



Print
Opens the Print dialog box to allow you to regulate the range of printed pages, the number of copies, the 
destination printer, and the appearance of your printed document. You can also open the Print dialog box by 
pressing CTRL + P.



ID_FILE_PRINT_PREVIEW 0x1E108



ID_FILE_UPDATE 0x1E109



ID_FILE_SAVE_COPY_AS 0x1E10A



ID_FILE_SEND_MAIL 0x1E10B



Recent File
Displays an ordered list of the most recently accessed Corel WEB.DESIGNER documents. To open a file listed in 
the Recent File list, click the appropriate filename.



Recent File
Displays an ordered list of the most recently accessed Corel WEB.DESIGNER documents. To open a file listed in 
the Recent File list, click the appropriate filename.



Recent File
Displays an ordered list of the most recently accessed Corel WEB.DESIGNER documents. To open a file listed in 
the Recent File list, click the appropriate filename.



Recent File
Displays an ordered list of the most recently accessed Corel WEB.DESIGNER documents. To open a file listed in 
the Recent File list, click the appropriate filename.



Recent File
Displays an ordered list of the most recently accessed Corel WEB.DESIGNER documents. To open a file listed in 
the Recent File list, click the appropriate filename.



Recent File
Displays an ordered list of the most recently accessed Corel WEB.DESIGNER documents. To open a file listed in 
the Recent File list, click the appropriate filename.



Recent File
Displays an ordered list of the most recently accessed Corel WEB.DESIGNER documents. To open a file listed in 
the Recent File list, click the appropriate filename.



Recent File
Displays an ordered list of the most recently accessed Corel WEB.DESIGNER documents. To open a file listed in 
the Recent File list, click the appropriate filename.



Recent File
Displays an ordered list of the most recently accessed Corel WEB.DESIGNER documents. To open a file listed in 
the Recent File list, click the appropriate filename.



Recent File
Displays an ordered list of the most recently accessed Corel WEB.DESIGNER documents. To open a file listed in 
the Recent File list, click the appropriate filename.



ID_FILE_MRU_FILE10 0x1E119



ID_FILE_MRU_FILE11 0x1E11A



ID_FILE_MRU_FILE12 0x1E11B



ID_FILE_MRU_FILE13 0x1E11C



ID_FILE_MRU_FILE14 0x1E11D



ID_FILE_MRU_FILE15 0x1E11E



ID_FILE_MRU_FILE16 0x1E11F



ID_FILE_MRU_LAST 0x1E11F



Clear
Deletes the selected text or object without copying it to the Windows Clipboard. You can also delete selected text
by pressing DELETE.



ID_EDIT_CLEAR_ALL 0x1E121



Copy
Copies selected data to the Windows Clipboard and replaces any previous Clipboard contents. You can also copy 
data to the Clipboard by pressing CTRL + C.



Cut
Removes selected data from your document and copies it to the Windows Clipboard. The copied text replaces 
any previous Clipboard contents. You can also cut and copy data by pressing CTRL + X.



Find
Opens the Find dialog box to allow you to search for text and other Web page elements including, fonts, styles, 
and special characters. You can also activate a search by pressing CTRL + F.



Paste
Adds a copy of the contents of the Windows Clipboard to your Web document at the cursor location. You can also
paste the Clipboard contents into your Web page by pressing CTRL + V.



ID_EDIT_PASTE_LINK 0x1E126



ID_EDIT_PASTE_SPECIAL 0x1E127



ID_EDIT_REPEAT0x1E128



Replace
Opens the Replace dialog box to allow you to replace a search string with alternate text or objects. You can also 
open the Replace dialog box by pressing CTRL + H.



Select All
Selects the contents of your current Web page. You can also select the contents of your current Web page by 
pressing CTRL + A.



Undo
Reverses the most recent action performed. You can also reverse your most recent action by pressing CTRL + Z.



Redo
Reverses the action performed by the Undo command. You can also redo actions by pressing CTRL + SHIFT + Z.



ID_WINDOW_NEW 0x1E130



ID_WINDOW_ARRANGE 0x1E131



ID_WINDOW_CASCADE 0x1E132



ID_WINDOW_TILE_HORZ 0x1E133



ID_WINDOW_TILE_VERT 0x1E134



ID_WINDOW_SPLIT 0x1E135



About Corel WEB.DESIGNER
Opens a dialog box that displays the application version, your registration status, and informative Web contacts.



Exit
Closes the Corel WEB.DESIGNER window and exits the application. Corel WEB.DESIGNER prompts you to save 
any changes you've made to your file prior to closing the program. You can also close Corel WEB.DESIGNER by 
pressing ALT + F4 or by clicking the Close icon in the Title Bar.



Search For Help On
Opens the Corel WEB.DESIGNER Help index to allow you to conduct a search for specific information. From the 
Search For Help On index, you can jump to instructions for using Corel WEB.DESIGNER and various other 
reference information. You can also access the Online Help index by clicking the Index button at the top of the 
Corel WEB.DESIGNER Help window.



ID_HELP_USING 0x1E143



Screen/Menu Help
Converts your mouse to a question mark pointer and activates Corel WEB.DESIGNER's Context-Sensitive Help. 
Clicking the Screen/Menu Help button or clicking Help, Screen/Menu Help and choosing a menu command or tool 
displays the corresponding Help topic. To access the main help file, click Help, Contents, or press F1. You can also
activate the Screen/Menu Help by pressing SHIFT+F1.



ID_HELP 0x1E145



ID_DEFAULT_HELP 0x1E146



ID_NEXT_PANE 0x1E150



ID_PREV_PANE 0x1E151



ID_OLE_INSERT_NEW 0x1E200



ID_OLE_EDIT_LINKS 0x1E201



ID_OLE_EDIT_CONVERT 0x1E202



ID_OLE_EDIT_CHANGE_ICON 0x1E203



ID_OLE_EDIT_PROPERTIES 0x1E204



ID_OLE_VERB_FIRST 0x1E210



ID_OLE_VERB_LAST 0x1E21F



Standard Toolbar
Shows or hides the Standard toolbar in the current Corel WEB.DESIGNER Application Window.



Status Bar
Shows or hides the Status Bar to allow you to display the function of a Corel WEB.DESIGNER menu command or 
toolbar button. Enabling the Status bar will display the Page Performance Indicator to allow you to estimate the 
download time of your Web page.



ID_RECORD_FIRST 0x1E900



ID_RECORD_LAST 0x1E901



ID_RECORD_NEXT 0x1E902



ID_RECORD_PREV 0x1E903



ID_APPLY_NOW 0x1EA00



ID_INSERT_CGISCRIPT_FORMHANDLER 0x11170



ID_INSERT_CGISCRIPT_GENERIC 0x11171



ID_INSERT_CGISCRIPT_IMAGESOURCE 0x11172



ID_INSERT_PAGEDEPOTSCRIPT 0x11173



Bold
Applies the boldface attribute to selected text.



Italic
Applies the italics attribute to selected text.



Underline
Applies the underline attribute to selected text.



Align left
Aligns the selected text or image to the left side of the page.



Center
Centers the selected text or image.



Align right
Aligns the selected text or image to the right side of the page.



ID_STYLE_COLOR 0x17536



ID_DEBUG_VIEW_DEBUG 0x17537



Page Properties
Opens the Page Properties dialog box allowing you to adjust the title, background, and text color of your Corel 
WEB.DESIGNER document.



Select All
Selects the contents of your current Web page. You can also select the contents of your current Web page by 
pressing CTRL + A.



Find Next
Activates the search specified in the Find dialog box. You can also activate a search by pressing F3.



Properties
Displays the property settings for the selected element. To edit an object's properties, select the element, click 
Edit, Properties, and adjust the settings in the Properties dialog box.



Document Tree
Displays the hierarchical structure of the HTML formatting tags for your Web page. Expand or collapse the 
display of embedded tags in the Document Tree by clicking the  or 
 key next to the appropriate code. To edit the HTML code for your Web page, click View, Document Source.

Expands the HTML entries to 
display all embedded text, objects, 
and HTML tags.
Collapses the HMTL entries to 
display only the main formatting 
code.

ID_VIEW_URLBAR 0x1753D



Formatting Toolbar
Shows or hides the Formatting toolbar in the current Corel WEB.DESIGNER Application Window.



New Window
Opens a new Corel WEB.DESIGNER Application Window to allow you to view multiple Corel WEB.DESIGNER pages
simultaneously.



ID_VIEW_RELOAD 0x17541



ID_VIEW_OPTIONS 0x17542



Form
Opens the Form Action Handler in the Form Properties dialog box to allow you to specify the URL of the CGI script
that will process your form's data. Click OK to insert a new HTML form at your cursor position.



Form Field, Text Field
Adds a text field element to the active form. All form commands are available from the Insert menu and the 
Forms toolbar.



Form Field, Button
Adds a button element to the active form. All form commands are available from the Insert menu and the Forms 
toolbar.



Form Field, Check Box
Adds a check box element to the active form. All form commands are available from the Insert menu and the 
Forms toolbar.



Form Field, Radio Button
Adds a radio button element to the active form. All form commands are available from the Insert menu and the 
Forms toolbar.



Form Field, List/Menu
Adds a list or menu element to the active form. All form commands are available from the Insert menu and the 
Forms toolbar.



ID_INSERT_INTELLIFIELD_TEXTFIELD 0x17549



ID_INSERT_INTELLIFIELD_BUTTON 0x1754A



ID_INSERT_INTELLIFIELD_CHECKBOX 0x1754B



ID_INSERT_INTELLIFIELD_RADIOGROUP 0x1754C



ID_INSERT_INTELLIFIELD_LIST 0x1754D



ID_INSERT_OBJECT 0x1754E



Image
Opens the Image Properties dialog box to allow you to specify an image to add to your current document.



ID_INSERT_HYPERTEXTLINK 0x17550



Horizontal Rule
Adds a Horizontal Rule to your Corel WEB.DESIGNER Web page. Double-click the Horizontal Rule to open the 
Horizontal Rule Properties dialog box to allow you to edit the properties of the horizontal rule.



ID_INSERT_TABLE 0x17552



ID_FORMAT_STYLE 0x17554



Ordered List
Displays selected text in a numbered list, corresponding to the HTML <OL> and <LI> tags. To remove the 
Ordered List format from list items, select the text and click Format, Ordered List.



Unordered List
Displays selected text in a bulleted list, corresponding to the HTML <UL> and <LI> tags. To remove the 
Unordered List format from list items, select the text and click Format, Unordered List.



Hyperlink
Opens the Hyperlink Properties dialog box to allow you to define a new hyperlink URL for the selected text or 
image on your Web page.



ID_GO_BACK 0x17558



ID_GO_FORWARD 0x17559



ID_GO_HOME 0x1755A



ID_BOOKMARK_ADDBOOKMARK 0x1755B



ID_BOOKMARK_EDITBOOKMARK 0x1755C



Spelling Check
Opens the Spell Check dialog box to allow you to verify the spelling of all text in your Corel WEB.DESIGNER 
document.



Contents
Displays the opening Help screen. From the Contents page, you can jump to instructions for using Corel 
WEB.DESIGNER and various types of reference information. Click the Contents button at the top of the Help 
window to open the Contents page from any point in the Corel WEB.DESIGNER help system.



Document Source
Displays the HTML source code that corresponds to Corel WEB.DESIGNER's WYSIWYG presentation of your 
current Web page.



Forms Toolbar
Shows or hides the Forms toolbar in the current Corel WEB.DESIGNER Application Window.



ID_SHOW_HIDDEN_CHARS 0x17561



Style Toolbar
Shows or hides the Style toolbar in the current Corel WEB.DESIGNER Application Window.



Text style
Specifies formatting for headings, preformatted text, block quotations, and definition lists.



Emphasis
Applies the Emphasis style to selected text.



Strike-through
Applies the Strike-through style to selected text.



Teletype
Applies the Typewritten or Teletype style to selected text.



Strong emphasis
Applies the Strong Emphasis style to selected text.



Example code
Applies the Example Code style to selected text.



Literal (sample)
Applies the Sample style to selected text.



Typed text
Applies the Keyboard or Typed Text style to selected text.



Variable
Applies the Variable style to selected text.



Citation
Applies the Citation style to selected text.



Short quotation
Applies the Short Quotation style to selected text.



Author
Applies the Author style to selected text.



Term definition
Applies the Term Definition style to selected text.



Surname (Person)
Applies the Person style to selected text.



Acronym
Applies the Acronym style to selected text.



Abbreviation
Applies the Abbreviation style to selected text.



Inserted text
Applies the Inserted Text style to selected text.



Deleted text
Applies the Deleted Text style to selected text.



ID_STYLE_SUBSCRIPT 0x17575



ID_STYLE_SUPERSCRIPT 0x17576



ID_STYLE_BIG 0x17577



ID_STYLE_SMALL 0x17578



ID_STYLE_CENTER 0x17579



ID_STYLE_NOBR 0x1757A



ID_STYLE_BLINK 0x1757B



ID_STYLE_ANCHOR 0x1757C



Options
Opens the Options dialog box to allow you to enable or disable the welcome on startup message, the application 
launch messages, Corel WEB.DRAW's image transparency option, and the lower case file name command. You 
can also select the modem speed for estimating the download time displayed by the Page Performance Indicator.



ID_FILE_PRINT_SETUP_GRAYED 0x1757E



ID_FILE_PRINT_PREVIEW_GRAYED 0x1757F



ID_FILE_PRINT_GRAYED 0x17580



ID_INSERT_CGI 0x17581



ID_FORMAT_STYLE_GRAYED 0x17582



ID_TOOLS_SPELLCHECK_GRAYED 0x17583



ID_EDIT_UNDO_GRAYED 0x17584



Font selection
Specifies a font to apply to selected text.



Font size
Specifies the size of selected text. You can set absolute or relative values for the font size.



Font/cell color
Adds color to text or to table-cell backgrounds.



ID_EDIT_COPY_TEXT 0x17589



ID_EDIT_PASTE_TEXT 0x1758A



Image map editor
Opens the image map editor to allow you to edit or create an image map file for the selected image.



ID_FORMAT_LIST_DEFINITION 0x1758C



ID_FORMAT_LIST_MENU 0x1758D



ID_FORMAT_LIST_DIR 0x1758E



Paragraph
Inserts a blank space and moves your cursor to a new line on the Corel WEB.DESIGNER screen (hard return). You 
can also create a paragraph break by pressing ENTER.



Line Break
Moves your cursor to a new line on the Corel WEB.DESIGNER screen (soft return). You can also create a line 
break by pressing SHIFT + ENTER.



Ordered List
Formats the first entry for an ordered or numbered list at your cursor position, corresponding to the HTML <OL> 
and <LI> tags.



Unordered List
Formats the first entry for an unordered or bulleted list at your cursor position, corresponding to the HTML <UL> 
and <LI> tags.



ID_INSERT_LIST_DEFINITION 0x17593



ID_COLOR0 0x17594



ID_COLOR1 0x17595



ID_COLOR2 0x17596



ID_COLOR3 0x17597



ID_COLOR4 0x17598



ID_COLOR5 0x17599



ID_COLOR6 0x1759A



ID_COLOR7 0x1759B



ID_COLOR8 0x1759C



ID_COLOR9 0x1759D



ID_COLOR10 0x1759E



ID_COLOR11 0x1759F



ID_COLOR12 0x175A0



ID_COLOR13 0x175A1



ID_COLOR14 0x175A2



ID_COLOR15 0x175A3



ID_COLOR_DEFAULT 0x175A4



ID_COLOR_CUSTOM 0x175A5



ID_IMAGE_MAP_EDITOR_TOOLBAR 0x175A6



ID_IMAGE_MAP_SELECT 0x175A7



ID_IMAGE_MAP_RECTANGLE 0x175A8



ID_IMAGE_MAP_CIRCLE 0x175A9



ID_IMAGE_MAP_POLYGON0x175AA



ID_IMAGE_MAP_BACKGROUND 0x175AB



ID_IMAGE_MAP_BACKGROUND_COMMENT 0x175AC



Normal
Formats the current paragraph in Normal font by removing all existing HTML tags from the text.



Heading
Applies a heading style to selected text that corresponds to the HTML tags <H1> through <H6>. To format a 
paragraph of text with a Heading style, position your cursor in the paragraph, click Format, and choose a 
Heading style.



Heading
Applies a heading style to selected text that corresponds to the HTML tags <H1> through <H6>. To format a 
paragraph of text with a Heading style, position your cursor in the paragraph, click Format, and choose a 
Heading style.



Heading
Applies a heading style to selected text that corresponds to the HTML tags <H1> through <H6>. To format a 
paragraph of text with a Heading style, position your cursor in the paragraph, click Format, and choose a 
Heading style.



Heading
Applies a heading style to selected text that corresponds to the HTML tags <H1> through <H6>. To format a 
paragraph of text with a Heading style, position your cursor in the paragraph, click Format, and choose a 
Heading style.



Heading
Applies a heading style to selected text that corresponds to the HTML tags <H1> through <H6>. To format a 
paragraph of text with a Heading style, position your cursor in the paragraph, click Format, and choose a 
Heading style.



Heading
Applies a heading style to selected text that corresponds to the HTML tags <H1> through <H6>. To format a 
paragraph of text with a Heading style, position your cursor in the paragraph, click Format, and choose a 
Heading style.



Block Quotation
Indents selected text and inserts paragraph breaks before and after the block quotation tag, corresponding to 
the HTML <BLOCKQUOTE> tag. To format a paragraph of text with the HTML <BLOCKQUOTE> tag, position your 
cursor at any point in the paragraph and click Format, Block Quotation.



Preformatted Text
Displays selected text in a monospace font and retains all line breaks and spaces and corresponds to the HTML 
<PRE> tag. To format a paragraph of text with the HTML <PRE> tag, position your cursor at any point in the 
paragraph and click Format, Preformatted Text.



Applet
Opens the Applet Properties dialog box to allow you to insert a Java Powered applet into your Corel 
WEB.DESIGNER document. This command quickly merges predesigned applets.



Bookmark
Opens the Bookmark dialog box to allow you to mark the selected text as a target for a hyperlink.



Templates
Creates a new Web document from a predesigned template. Click File, Templates and choose a template from 
the Open Template dialog box. Double-click the template file name or select the file and click Open. The 
template's structure provides a sample on which to base your new Web page. You can also open a Corel 
WEB.DESIGNER template by pressing CTRL + T. The preview window in the Template dialog box will show you a 
bitmap image of the selected template.



Refresh Window
Redraws the Corel WEB.DESIGNER Application Window according to your latest specifications. Click View, Refresh
Window if any distortion occurs when you update a document or if your changes do not take effect immediately.



Corel WEB.MOVE
Launches Corel WEB.MOVE from your Corel WEB.DESIGNER Application Window. Corel WEB.MOVE allows you to 
create animations and save them as animated .GIFs or applets written in the Java Programming Language. 
Animations can be automatically published back to Corel WEB.DESIGNER.



Corel WEB.DRAW
Launches Corel WEB.DRAW from your Corel WEB.DESIGNER Application Window. Corel WEB.DRAW is an image 
creation program based on the award-winning CorelDRAW illustration technology. Images can be automatically 
published back to Corel WEB.DESIGNER.



Corel WEB.WORLD
Launches Corel WEB.WORLD from your Corel WEB.DESIGNER Application Window. Corel WEB.WORLD allows you 
to create exciting VRML files. VRML files can be automatically published back to Corel WEB.DESIGNER.



Corel WEB.GALLERY
Launches Corel WEB.GALLERY from your Corel WEB.DESIGNER Application Window. Corel WEB.GALLERY provides 
over 7500 Internet-ready images in .GIF or .JPG formats. It contains backgrounds, buttons, bullets, separators, 
alphabets, icons, arrows, clipart, and photos. You can drag and drop WEB.GALLERY images directly onto your 
Corel WEB.DESIGNER page.



ID_TOOLS_CORELWEBTRANSIT 0x175BF



Screen/Menu Help
Converts your mouse to a question mark pointer and activates Corel WEB.DESIGNER's Context-Sensitive Help. 
Clicking the Screen/Menu Help button or clicking Help, Screen/Menu Help and choosing a menu command or tool 
displays the corresponding Help topic. To access the main help file, click Help, Contents, or press F1. You can also
activate the Screen/Menu Help by pressing SHIFT+F1.



Technical Support
Lists contacts for technical support and customer service information.



Applications Toolbar
Shows or hides the Applications toolbar in the current Corel WEB.DESIGNER Application Window.



Bookmarks
Marks all bookmarks in your current Corel WEB.DESIGNER document with a color that you choose from the Page 
Properties dialog box in the File menu. The bookmark color specification will not be displayed in a browser 
window and can be toggled on or off with the Bookmarks command in the View menu. The default bookmark 
identification color is red.



ID_VIEW_WELCOMEONSTARTUP 0x175C4



HTML File
Inserts and merges an existing .HTML file with your current Corel WEB.DESIGNER document by using the HTML 
File command, you can merge all .HTML files, including those containing Java Powered applets.



ID_INSERT_ANIMATION 0x175C6



ID_INSERT_VRML 0x175C7



Insert Table
Opens the Table Properties dialog box to allow you to define the settings and appearance of a new table in Corel 
WEB.DESIGNER page.



Insert Cell
Adds a cell to the table at your cursor position. The Insert Cell command is not available when your cursor lies 
outside of the table's border.



Insert Rows/Columns
Adds a row or column to the table at your cursor position. The Insert Rows/Columns command is not available 
when your cursor lies outside of the table's border.



ID_TABLE_INSERTCAPTION 0x175CB



Table Properties
Opens the Table Properties dialog box to allow you to define the number of rows and columns contained within 
your table's boundaries, the width of the table, its alignment, layout, cell padding, and cell spacing. The Table 

Properties dialog box appears when you click , Table, Insert Table, or Table, Table Properties. The Table 
Properties command is not available when your cursor lies outside of the table's border.



Select Cell
Selects the cell indicated by your cursor position. You must select cells before you can modify their properties. 
The Select Cell command is not available when your cursor lies outside of the table's border.



Select Row
Selects the row indicated by your cursor position. You must select a row before you can modify its properties. 
The Select Row command is not available when your cursor lies outside of the table's border.



Select Table
Selects the entire table and its contents. Most often, the Select Table command is used to align a table on your 
Corel WEB.DESIGNER page, but clicking Table, Select Table can also be used to delete a table and its contents 
from your screen. The Select Table command is not available when your cursor lies outside of the table's border.



Embedded File
Opens the Embedded File Properties dialog box to allow you to insert any file in your Corel WEB.DESIGNER 
document. The Embedded File command quickly merges files of any type with your Web pages to allow you to 
create more advanced and efficient Web documents.



Set Browser
Opens the Select HTML Browser dialog box to allow you to select a browser for previewing your Corel 
WEB.DESIGNER documents. The first time you access the Set Browser command, you must locate the browser 
that you want to launch. Choose Tools, Browser Preview to launch the specified browser directly from the Corel 
WEB.DESIGNER Application Window. To change your default specification, click Tools, Set Browser and type the 
folder for the new viewing device. To view Web pages that contain embedded files such as applets or VRML, you 
may have to download the appropriate plug-in applications for your browser.



Cell Properties
Opens the Cell Properties dialog box to allow you to adjust a selected cell's size and layout. The Cell Properties 
dialog box controls a cell's width, type, and alignment. The Cell Properties command is not available when your 
cursor lies outside of the table's border.



Delete Column
Deletes a column from all rows in the current table. The Delete Column command is not available when your 
cursor lies outside of the table's border.



Delete Row
Deletes a row from the current table. If you do not select the row, Corel WEB.DESIGNER deletes the row indicated
by your cursor position. The Delete Row command is not available when your cursor lies outside of the table's 
border.



ID_SELECTROW 0x175D5



Browser Preview 
Launches a Web browser directly from the Corel WEB.DESIGNER Application Window. To view your documents as 
they will appear to visitors to your Web page, you must first set a default browser by clicking Tools, Set Browser 
and locating a viewing device. To open a current Corel WEB.DESIGNER document in the specified browser, click 
Tools, Browser Preview. To view Web pages that contain embedded files such as applets or VRML, you may have 
to download the appropriate plug-in applications for your browser.



Delete Cell
Deletes a cell from the current table. If you do not select the cell, Corel WEB.DESIGNER deletes the cell indicated 
by your cursor position. The Delete Cell command is not available when your cursor lies outside of the table's 
border.



WebMaster Suite Web Page
Opens the Corel WebMaster Suite Web Page directly from the Corel WEB.DESIGNER window. Free product 
updates, tutorials, and other related software are available at this site (http://www.corel.com/webmaster).



ID_INSERT_FRAME 0x175D9



ID_SOUND_PICKER_PLAY 0x175DA



ID_SOUND_PICKER_STOP 0x175DB



ID_SOUND_PICKER_HELP 0x175DC



Tutorial
Opens the Corel WEB.DESIGNER tutorial — a hands-on approach to learning Corel WEB.DESIGNER.



Insert Row Frame
Adds a row inside the current frame.



Insert Column Frame
Adds a column inside the current frame.



Delete Frame
Deletes the selected frame from the document. The frame itself will be removed but the content document 
associated with the frame will not be deleted. You can delete all of the frames from your Web page document 
except the last frame because a document must have at least one frame.



ID_PANE_PROPERTIES 0x175E1



Select Column
Selects the column indicated by your cursor position. You must select a column before you can modify its 
properties. The Select Column command is not available when your cursor lies outside of the table’s border.



Decrease Indent
Enables you to decrease the indentation of the selected text.



Increase Indent
Enables you to increase the indentation the selected text.



Corel WEB.DATA
Launches Corel WEB.DATA from your Corel WEB.DESIGNER Application Window. Corel WEB.DATA allows you to 
quickly and easily convert and organize raw database material into HTML for publishing on the World Wide Web. 
The converted database can be automatically published back to Corel WEB.DESIGNER.



New With Frames
Launches the Frame Wizard to allow you to quickly and easily add frames to your new Web document.



Properties
Opens the Select Properties dialog box to enable you to change the properties of the frames within your Web 
page and the properties of the entire page.



Split Frame
Adds another row to a row frame or adds another column to a column frame.



ID_FILE_IMPORTWORDPROCESSORFILE 0x175E9



Import Word Processor File
Launches the NET Transit wizard to enable you to automatically convert your word-processor files to HTML. The 
NET Transit wizard guides you step by step through the conversion process and enables you to define the 
appearance of your finished HTML file.



Publish to the Internet
Launches the Instant Publishing wizard to allow you to automatically publish your Corel WEB.DESIGNER 
documents to PageDepot, a World Wide Web site maintained by Microcrafts Inc. The Instant Publishing wizard 
guides you step by step through the Web-publishing process and allows you to choose a publishing package, to 
transfer your files to a remote destination using FTP, or to set up and pay for your personal World Wide Web site.



ID_INSERT_BACKGROUNDCOLORIMAGE 0x175EC



ID_INSERT_BACKGROUNDSOUND 0x175ED



Marquee
Opens the Marquee Properties dialog box to enable you to add scrolling bands of text to your Corel 
WEB.DESIGNER documents. Because marquees are not included in the HTML 2.0 specification, this feature is not 
supported by all Web browsers. To view marquees, preview your Web documents using Microsoft's Internet 
Explorer 3.0.



CGI
Opens the Insert CGI Script dialog box to allow you to insert a Generic, Image Source, Form Action Handler, or 
PageDepot CGI script to your Web page. The PageDepot CGI scripts enable you to insert a page hit counter, a 
guest book, an email form, and a site search to your Corel WEB.DESIGNER document. The PageDepot CGI scripts 
are only available if you have published your Web page on the PageDepot site provided by Microcrafts Inc.



ActiveX
Opens the ActiveX dialog box which enables you to insert an ActiveX control into your Corel WEB.DESIGNER Web 
page.



Blinking text
Causes the selected text to Blink when it is displayed in a Web browser. Blinking text is not supported by all Web 
browsers.



ID_TABLE_INSERT 0x175F3



Merge Cells
Merges the selected cells in the current table. To merge cells, you must have more than one cell selected. 



Split Cells
Opens the Split Cells dialog box, allowing you to split table cells into vertically into columns or horizontally into 
rows.



ID_TOOLS_CORELWEBPHOTOPAINT 0x175F6



Publish to Internet
Launches the Instant Publishing wizard to allow you to automatically publish your Corel WEB.DESIGNER 
documents to PageDepot, a World Wide Web site maintained by Microcrafts Inc. The Instant Publishing wizard 
guides you step by step through the Web-publishing process and allows you to choose a publishing package, to 
transfer your files to a remote destination using FTP, or to set up and pay for your personal World Wide Web site.



No Frames Page
Adds the message “This Web browser does not support frames” to your Web document. This message 
corresponds to the HTML <NOFRAMES> tag and will be displayed if the user’s browser does not support frames.



Set Server Root 
Identifies the server root folder where you will store your Corel WEB.DESIGNER pages and referenced files. The 
server root folder provides a base location for relative URLs to images and other .HTML files. After changing your 
server root folder, restart Corel WEB.DESIGNER to accept the settings.



ID_FILE_OPEN_FROM_WEB 0x1765C



FTP
Opens the FTP dialog box, which enables you to transfer files using File Transfer Protocol (FTP).



ID_OPEN_TEMPLATE_HELP 0x1765E



Corel WEB.PhotoPaint
Launches Corel WEB.PhotoPaint from your Corel WEB.DESIGNER Application Window. Corel WEB.PhotoPaint 
allows you to edit images and video files, retouch photographs, and create original artwork with powerful, 
bitmap-based image editing and painting tools. You can automatically edit and update images in your Corel 
WEB.DESIGNER pages using Corel WEB.PhotoPaint.



Frame Source
Displays the HTML source code that corresponds to the selected frame in your current Web page. This command 
is only available if you have used the Frame wizard to create a Web page containing frames.



IDC_CURSOR_CROSSHAIR 0x100E5



IDC_TRANSPARENCY_FLAG 0x10213



IDC_FILENAME_LOWERCASE 0x10214



IDC_ALIGNMENT0x103E9



IDC_CHKWIDTH 0x103EA



IDC_WIDTH 0x103EB



IDC_WIDTH_PIXEL 0x103EC



IDC_WIDTH_PERCENT 0x103ED



IDC_ROWS 0x103EE



IDC_COLS 0x103EF



IDC_CELLS 0x103F0



IDC_BORDERSIZE 0x103F1



IDC_CELLPADDING 0x103F2



IDC_CELLSPACE 0x103F3



IDC_OPENPROGRESS_FILENAME 0x10FCC



IDC_OPENPROGRESS_PROGRESS 0x10FCD



IDC_OPENPROGRESS_ABORT 0x10FCE



IDC_PAGE_DEPOT_SCRIPT_LIST 0x11175



IDC_URL 0x1138C



IDC_URLBAR 0x1138E



IDC_STATIC_VERSION 0x117B7



IDC_STATIC_URL 0x117B8



IDC_STATIC_INTELLIGENT 0x117B9



IDC_STATIC_INSTRUCTIONS 0x117BA



IDC_STATIC_URL_CGI 0x117BB



IDC_STATIC_LENGTH_OR_LINES 0x117BC



IDC_STATIC_LIST_LABEL 0x117BD



IDC_STATIC_SORRY_TEXT 0x117BE



IDC_STATIC_SORRY 0x117BF



IDC_STATIC_SORRY_BOX 0x117C0



IDC_STATIC_INS_BOX 0x117C1



IDC_STATIC_DESCRIPTION 0x117C2



IDC_STATIC_VALUE 0x117C3



IDC_STATIC_INITIALLY_SELECTED 0x117C4



IDC_STATIC_ITEM 0x117C5



IDC_VIEW_SRC_EDIT 0x12710



IDC_VIEW_SOURCE_OK 0x12711



IDC_VIEW_SOURCE_CANCEL 0x12712



IDC_DBV_BUTTON_SET_ALL 0x12713



IDC_DBV_BUTTON_CLEAR_ALL 0x12714



IDC_DBV_CHECK_BLOCK 0x12715



IDC_DBV_CHECK_LINE 0x12716



IDC_DBV_CHECK_HR 0x12717



IDC_DBV_CHECK_GRAPHIC 0x12718



IDC_DBV_CHECK_FORM 0x12719



IDC_DBV_CHECK_OBJECT 0x1271A



IDC_DBV_CHECK_DOUBLEBUFFER 0x1271B



IDC_DBV_CHECK_LIST 0x1271C



IDC_DBV_CHECK_FORM_DELIMITER 0x1271D



IDC_EDIT_VALUE0x1271E



IDC_EDIT_HEIGHT_PIXELS 0x1271F



IDC_EDIT_VALUE_MULTI 0x12720



IDC_EDIT_HSPACE_PIXELS 0x12721



IDC_EDIT_WIDTH_PIXELS 0x12722



IDC_EDIT_VSPACE 0x12723



IDC_EDIT_WIDTH_PERCENT 0x12724



IDC_EDIT_WIDTH 0x12725



IDC_EDIT_BORDER 0x12726



IDC_EDIT_HSPACE 0x12727



IDC_EDIT_IMAGE_SOURCE 0x12728



IDC_EDIT_IMAGE 0x12729



IDC_EDIT_ALTERNATE_TEXT 0x1272A



IDC_EDIT_SOUND 0x1272B



IDC_EDIT_FONTSIZE 0x1272C



IDC_EDIT_CODEBASE 0x1272D



IDC_EDIT_TITLE 0x1272E



IDC_EDIT_SIZE_WIDTH 0x1272F



IDC_EDIT_NAME 0x12730



IDC_EDIT_SIZE_LENGTH_OR_LINES0x12731



IDC_EDIT_LABEL0x12732



IDC_EDIT_HEIGHT 0x12733



IDC_EDIT_ITEM_LABEL 0x12734



IDC_EDIT_MARGIN_WIDTH 0x12735



IDC_EDIT_VALUE_SINGLE 0x12736



IDC_EDIT_URL 0x12737



IDC_EDIT_SIZE_LINES 0x12738



IDC_EDIT_COMMENT 0x12739



IDC_EDIT_URL_CGI 0x1273A



IDC_BUTTON_ADD_CUSTOM 0x1273B



IDC_BUTTON_ADD 0x1273C



IDC_BUTTON_REMOVE 0x1273D



IDC_BUTTON_BROWSE 0x1273E



IDC_BUTTON_COLOR 0x1273F



IDC_BUTTON_EDIT 0x12740



IDC_BUTTON_BROWSE_CGI 0x12741



IDC_BUTTON_FONTCOLOR 0x12742



IDC_BUTTON_CREATE 0x12743



IDC_BUTTON_LINKCOLOR 0x12744



IDC_BUTTON_VLINKCOLOR 0x12745



IDC_BUTTON_ALINKCOLOR 0x12746



IDC_BUTTON_MODIFY 0x12747



IDC_BUTTON_BROWSE_SOUND 0x12748



IDC_BUTTON_CONFIGURE 0x12749



IDC_BUTTON_PROPERTIES 0x1274A



IDC_COMBO_ATTRIBUTE 0x1274B



IDC_COMBO_COLOR 0x1274C



IDC_COMBO_ALIGNMENT 0x1274D



IDC_COMBO_ITEMS 0x1274E



IDC_COMBO_INTELLIGENT 0x1274F



IDC_CHECK_MULTIPLE_SELECTIONS 0x12750



IDC_CHECK_INITIALLY_SELECTED 0x12751



IDC_LIST_ATTRIBUTE 0x12752



IDC_LIST_ITEMS 0x12753



IDC_LIST_FAMILIES 0x12754



IDC_LIST_AGENTS 0x12755



IDC_LIST_OBJECTS 0x12756



IDC_UPDOWN 0x12757



IDC_RADIO_HEIGHT_DEFAULT 0x12758



IDC_RADIO_HEIGHT_PIXELS 0x12759



IDC_RADIO_WIDTH_DEFAULT 0x1275A



IDC_RADIO_WIDTH_PIXELS 0x1275B



IDC_RADIO_WIDTH_PERCENT 0x1275C



IDC_RADIO_ALIGNMENT_DEFAULT 0x1275D



IDC_RADIO_WIDTH_PIXELS2 0x1275E



IDC_RADIO_ALIGNMENT_LEFT 0x1275F



IDC_RADIO_WIDTH_PERCENT2 0x12760



IDC_RADIO_ALIGNMENT_CENTER 0x12761



IDC_RADIO_ALIGNMENT_RIGHT 0x12762



IDC_RADIO_SHADING_DEFAULT 0x12763



IDC_RADIO_SHADING_UNSHADED 0x12764



IDC_RADIO_BORDER_DEFAULT 0x12765



IDC_RADIO_BORDER_ZERO 0x12766



IDC_RADIO_BORDER_PIXELS 0x12767



IDC_RADIO_HSPACE_DEFAULT 0x12768



IDC_RADIO_HSPACE_PIXELS 0x12769



IDC_RADIO_VSPACE_DEFAULT 0x1276A



IDC_RADIO_VSPACE_PIXELS 0x1276B



IDC_RADIO_GIF 0x1276C



IDC_RADIO_JPG 0x1276D



IDC_RADIO_TYPE_SINGLE_LINE 0x1276E



IDC_RADIO_TYPE_MULTI_LINE 0x1276F



IDC_RADIO_TYPE_PASSWORD_FIELD 0x12770



IDC_RADIO_TYPE_SUBMIT0x12771



IDC_RADIO_TYPE_RESET 0x12772



IDC_RADIO_TYPE_SELECTED 0x12773



IDC_RADIO_TYPE_BUTTON 0x12774



IDC_RADIO_TYPE_UNSELECTED 0x12775



IDC_RADIO_TYPE_CHECKED 0x12776



IDC_RADIO_TYPE_UNCHECKED 0x12777



IDC_RADIO_FORM_ACTION_TYPE_STANDARD 0x12778



IDC_RADIO_FORM_ACTION_TYPE_INTELLIGENT 0x12779



IDC_RADIO_TYPE_MENU 0x1277A



IDC_RADIO_TYPE_LIST_BOX 0x1277B



IDC_EDDEBUG_TREE 0x1277C



IDC_STATIC_HEIGHT 0x1277D



IDC_CHECK_IBLINK 0x1277E



IDC_RADIO_SCALING_NONE 0x1277F



IDC_RADIO_SCALING_PIXELS 0x12780



IDC_RADIO_SCALING_PERCENT 0x12781



IDC_STATIC_WIDTH_PIXELS 0x12782



IDC_STATIC_HEIGHT_PIXELS 0x12783



IDC_STATIC_WIDTH_LABEL 0x12784



IDC_STATIC_HEIGHT_LABEL 0x12785



IDC_CHECK_SCALE_WIDTH 0x12786



IDC_CHECK_SCALE_HEIGHT 0x12787



IDC_EDIT_ERRORS 0x12788



IDC_EDIT_SS_IMAGE_MAP0x1278D



IDC_CHECK_USE_MAP 0x1278E



IDC_STATIC_SS_IMAGE_MAP 0x1278F



IDC_ANIMATE_IMAGE 0x12790



IDC_ANIMATE_LOCN 0x12791



IDC_ANIMATE_ELEMENT 0x12792



IDC_STATIC_ELEMENT 0x12793



IDC_STATIC_COORDS 0x12794



IDC_STATIC_ELEMENT_FRAME 0x12795



IDC_STATIC_COORDS_FRAME 0x1279A



IDC_STATIC_IMAGE_FRAME 0x1279B



IDC_EDIT_URL_STANDARD 0x1279C



IDC_STATIC_URL_STANDARD 0x1279D



IDC_STATIC_TARGET 0x1279E



IDC_BUTTON_BROWSE_STANDARD 0x1279F



IDC_STATIC_OBJECT 0x127A0



IDC_COMBO_OBJECT 0x127A1



IDC_BUTTON_CONFIGURE_OBJECT 0x127A2



IDC_SPELL_WORD 0x127A3



IDC_SPELL_ERRSTRING 0x127A4



IDC_SPELL_SUGGESTIONS 0x127A5



IDC_SPELL_SKIP 0x127A6



IDC_SPELL_ADD 0x127A7



IDC_SPELL_ADD_REPLACEMENT 0x127A8



IDC_SPELL_ADD_PERSONAL 0x127A9



IDC_SPELL_ADD_PERSONAL_REPLACE 0x127AA



IDC_OPEN_HELP 0x127AB



IDC_THES_WORD 0x127AC



IDC_THES_SUGGESTIONS0x127AD



IDC_EDITDICT_FILENAME 0x127AE



IDC_EDITDICT_ENTRIES 0x127AF



IDC_EDITDICT_REPLACEMENT 0x127B0



IDC_EDITDICT_ADD 0x127B1



IDC_EDITDICT_DELETE 0x127B2



IDC_RADIO_LINK_STANDARD 0x127B3



IDC_RADIO_LINK_CGI 0x127B4



IDC_RADIO_LINK_OBJECT 0x127B5



IDC_STATIC_DESCRIPTION_FRAME 0x127B6



IDC_MARQUEE_BUTTON_BGCOLOR 0x127B8



IDC_CREDIT 0x127B9



IDC_NEXT 0x127BA



IDC_BROWSER_PATH_BROWSE_BUTTON 0x127BB



IDC_BROWSE_BTN 0x127BC



IDC_SPLITCELL_HELP 0x127BD



IDC_STATIC_REQUIRED 0x127BE



IDC_BUTTON2 0x127BF



IDC_BUTTON_OK2 0x127C0



IDC_PREV 0x127C1



IDC_BUTTON_CANCEL 0x127C2



IDC_BUTTON_APPLY 0x127C3



IDC_EDIT_DOC_ROOT 0x127C4



IDC_BUTTON_HELP 0x127C5



IDC_BUTTON3 0x127C6



IDC_STATIC_ICON 0x127C7



IDC_BROWSER_HELP 0x127C8



IDC_STATIC_SERIAL 0x127C9



IDC_STATIC_NAME 0x127CA



IDC_BOOKMARK 0x127CB



IDC_EDIT_APPLET_CLASS 0x127CC



IDC_OTHER_BOOKMARK 0x127CD



IDC_CHECK1 0x127CE



IDC_CHECK_USE_IMAGE_DEFAULTS 0x127CF



IDC_MARQUEE_REPEAT_CONTINUOUSLY 0x127D0



IDC_LAUNCH_CHECK 0x127D1



IDC_DISPLAY_WELCOME 0x127D2



IDC_CHECK_BGSOUND_NONSTOP 0x127D3



IDC_CHECK_BORDER 0x127D4



IDC_SPLITROWS_CHECK 0x127D5



IDC_NEWWEB_BUTTON 0x127D6



IDC_CHECK_RESIZE 0x127D7



IDC_SPLITCOLS_CHECK 0x127D8



IDC_OPENWEB_BUTTON 0x127D9



IDC_TEMPLATE_BUTTON 0x127DA



IDC_DISPLAY_ON_STARTUP 0x127DB



IDC_STARTUP_STATIC 0x127DC



IDC_NEWTEXT_STATIC 0x127DD



IDC_OPENTEXT_STATIC 0x127DE



IDC_TEMPLATETEXT_STATIC 0x127DF



IDC_LIST1 0x127E0



IDC_NAME 0x127E1



IDC_NEWFRAME_BUTTON0x127E2



IDC_VALUE 0x127E3



IDC_NEWFRAMETEXT_STATIC 0x127E4



IDC_EDIT_EMBED_SOURCE 0x1283C



IDC_OPENFROMINTERNET_BUTTON 0x1283D



IDC_GENERIC1 0x1283E



IDC_SPIN_CUSTOM_FRAME_SIZE 0x1283E



IDC_SPIN_ROWS0x1283F



IDC_BGSOUND_SPIN 0x12840



IDC_SPIN_BGSOUND 0x12841



IDC_OPENINTERNETTEXT_STATIC 0x12842



IDC_SPIN_COLSPAN 0x12843



IDC_SPLITROWS_SPIN 0x12844



IDC_GENERIC2 0x12845



IDC_INC_ROWS 0x12846



IDC_SPIN_COLS 0x12847



IDC_SPLITCOLS_SPIN 0x12848



IDC_GENERIC3 0x12849



IDC_INC_CELLS 0x1284A



IDC_SPIN_BORDER 0x1284B



IDC_SPIN_ROWSPAN 0x1284C



IDC_GENERIC5 0x1284D



IDC_GENERIC6 0x1284E



IDC_SPIN_PADD 0x1284F



IDC_GENERIC7 0x12850



IDC_SPIN_SPACE0x12851



IDC_HEADER 0x12852



IDC_DATA 0x12853



IDC_VALIGNMENT 0x128AC



IDC_EDIT_BROWSER_PATH 0x128AD



IDC_ABOVE_SELECTION 0x128AE



IDC_DISPLAY_APP_LAUNCH 0x128AF



IDC_BELOW_SELECTION 0x128B0



IDC_NROWS 0x128B1



IDC_COMBO_URL_STANDARD 0x128B2



IDC_EDIT_CS_IMAGE_MAP 0x128B3



IDC_LEFT_SELECTION 0x12918



IDC_COMBO_TARGET 0x12919



IDC_RIGHT_SELECTION 0x1291A



IDC_NCELLS 0x1291B



IDC_FRAME_PREVIEW 0x1291C



IDC_BACK 0x1291D



IDC_FRAMESTYLE_LIST 0x1291E



IDC_EDIT_ROWS0x1291F



IDC_HEIGHT 0x12920



IDC_EDIT_COLUMNS 0x12921



IDC_SPIN_COLUMNS 0x12986



IDC_PAGE_URL_EDIT 0x12987



IDC_BROWSE_FILE_SYSTEM 0x12988



IDC_PAGE_NAME_EDIT 0x12989



IDC_CUSTOM_HEIGHT_RADIO 0x1298A



IDC_DEFAULT_HEIGHT_RADIO 0x1298B



IDC_CUSTOM_WIDTH_RADIO 0x1298C



IDC_DEFAULT_WIDTH_RADIO 0x1298D



IDC_NOSCROLL_RADIO 0x129F3



IDC_SCROLL_RADIO 0x129F4



IDC_AUTOSCROLL_RADIO0x129F5



IDC_BORDER_CHECKBOX 0x129F6



IDC_NOTSIZABLE_CHECKBOX 0x129F7



IDC_SPIN_HEIGHT 0x129F8



IDC_SPIN_WIDTH 0x129F9



IDC_FINISH 0x129FA



IDC_SPIN_MARGIN_WIDTH 0x129FB



IDC_BGSOUND_NONSTOP 0x129FC



IDC_RADIO_BGSOUND_NONSTOP 0x129FD



IDC_BGSOUND_COUNT 0x129FE



IDC_RADIO_BGSOUND_LOOP 0x129FF



IDC_BGSOUND_LOOP 0x12A58



IDC_EDIT_BGSOUND_LOOP 0x12A59



IDC_RADIO1 0x12A5A



IDC_MARQUEE_HEIGHT_DEFAULT 0x12A5B



IDC_RADIO_HORIZONTAL_DEFAULT 0x12A5C



IDC_RADIO_NEXT 0x12A5D



IDC_RADIO_AUTO_FRAME_SIZE 0x12A5E



IDC_CUSTOM_SIZE 0x12A5F



IDC_MARQUEE_WIDTH_DEFAULT 0x12A60



IDC_RADIO_VERTICAL_DEFAULT 0x12A61



IDC_RADIO_FINISH 0x12A62



IDC_RADIO_CUSTOM_FRAME_SIZE 0x12A63



IDC_BROWSER_DEFAULT 0x12A64



IDC_PREVIEW 0x12A65



IDC_WELCOME_BMP 0x12A6C



IDC_SCROLL_YES 0x12A6D



IDC_STATIC_HEIGHT_PERCENT 0x12A70



IDC_COMBO1 0x12A71



IDC_COMBO_CGI_SCRIPT 0x12A72



IDC_SCROLL_NO0x12A73



IDC_COMBO2 0x12A74



IDC_SCROLL_AUTO 0x12A75



IDC_EDIT_ABS_HEIGHT 0x12AD0



IDC_COMBO3 0x12AD1



IDC_COMBO_DIM_TYPES 0x12AD2



IDC_EDIT_REL_HEIGHT 0x12AD3



IDC_EDIT_ABS_WIDTH 0x12AD4



IDC_EDIT_REL_WIDTH 0x12AD6



IDC_STATIC_REL_HEIGHT 0x12AD8



IDC_COMBO_URL 0x12AD9



IDC_SPLITROWS_TEXT 0x12ADA



IDC_STATIC_REL_WIDTH 0x12ADB



IDC_SPLITCOLS_TEXT 0x12ADC



IDC_COMBO_HEIGHT 0x12ADE



IDC_COMBO_WIDTH 0x12ADF



IDC_RADIO_DEF_WIDTH 0x12B3E



IDC_RADIO_ABS_WIDTH 0x12B3F



IDC_RADIO_REL_WIDTH 0x12B40



IDC_RADIO_DEF_HEIGHT 0x12B41



IDC_RADIO_ABS_HEIGHT 0x12B42



IDC_RADIO_REL_HEIGHT 0x12B43



IDC_CHECK_ASPECT_RATIO 0x12B44



IDC_STATIC_WIDTH_PERCENT 0x12B45



IDC_EDIT1 0x12BAA



IDC_MARQUEE_PERCENT_HEIGHT 0x12BAB



IDC_EDIT_PROJ_NAME 0x12BAC



IDC_MARQUEE_PERCENT_WIDTH 0x12BAD



IDC_COLSPAN 0x12BAE



IDC_SPLITROWS_NUM 0x12BAF



IDC_EDIT2 0x12BB0



IDC_EDIT_HORIZONTAL_CUSTOM 0x12BB1



IDC_EDIT_FRAME_NAME 0x12BB2



IDC_EDIT_VERTICAL_CUSTOM 0x12BB3



IDC_SPLITCOLS_NUM 0x12BB4



IDC_EDIT3 0x12BB5



IDC_EDIT_SIZE 0x12BB6



IDC_EDIT_LENGTH 0x12BB7



IDC_EDIT_FRAME_SIZE 0x12BB8



IDC_ROWSPAN 0x12BB9



IDC_PAGELOADPERFORMANCE 0x12BBA



IDC_PAGELOADPERFORMANCETITLE 0x12BBB



IDC_PREVIEW_TEMPLATE 0x12BBC



IDC_MARQUEE_TEXT 0x12EE0



IDC_MARQUEE_ALIGNMENT 0x12EE1



IDC_MARQUEE_PIXEL_HEIGHT 0x12EE3



IDC_MARQUEE_HEIGHT_PIXELS 0x12EE4



IDC_MARQUEE_PIXEL_WIDTH 0x12EE5



IDC_MARQUEE_HEIGHT_PERCENT 0x12EEA



IDC_MARQUEE_WIDTH_PIXELS 0x12EEB



IDC_MARQUEE_WIDTH_PERCENT 0x12EEC



IDC_MARQUEE_SCROLLAMOUNT 0x12EED



IDC_MARQUEE_SCROLLDELAY 0x12EEE



IDC_MARQUEE_LOOP 0x12EF5



IDC_MARQUEE_HSPACE 0x12EF6



IDC_MARQUEE_VSPACE 0x12EF7



IDC_LOCAL_RADIO 0x12F13



IDC_REMOTE_RADIO 0x12F14



IDC_OPENWEB_PROMPT 0x12F15



IDC_OPENWEB_COMBO 0x12F16



IDC_OPENWEB_INFO 0x12F17



IDC_OPENWEB_ICON 0x12F18



IDC_STATIC_DESCIPTION 0x12F19



IDC_OPENWEB_CONFIRM_REPLACE 0x12F1A



IDC_BUTTON_OK 0x12F1B



IDC_OPENLOCAL_PROMPT 0x12F1C



IDC_OPENLOCAL_COMBO 0x12F1D



IDC_OPENLOCAL_INFO 0x12F1E



IDC_OPENLOCAL_ICON 0x12F4E



IDC_LOCALBROWSE_BUTTON 0x12F4F



IDC_OPENINFO_ICON 0x12F50



IDC_STATIC_COMMENT 0x12F51



IDC_RADIO_HORIZONTAL_CUSTOM 0x12F52



IDC_RADIO_VERTICAL_CUSTOM 0x12F53



IDC_RADIO_IN_PIXELS 0x12F54



IDC_RADIO_IN_PERCENT 0x12F55



IDC_CHECK_MAINTAIN_ASPECT_RATIO 0x12F56



IDC_MARQUEE_RADIO_SCROLL 0x12F57



IDC_MARQUEE_RADIO_SLIDE 0x12F58



IDC_MARQUEE_RADIO_ALTERNATE 0x12F59



IDC_MARQUEE_RADIO_LEFT 0x12F5A



IDC_MARQUEE_RADIO_RIGHT 0x12F5B



IDC_BROWSER_LIST 0x12F5C



IDC_BROWSER_ADD 0x12F5D



IDC_BROWSER_EDIT 0x12F5E



IDC_BROWSER_REMOVE 0x12F5F



IDC_BROWSER_WINDOW_SIZE 0x12F60



IDC_RADIO_GENERAL 0x12F61



IDC_RADIO_640_480 0x12F62



IDC_RADIO_800_600 0x12F63



IDC_RADIO_1024_768 0x12F64



IDC_RADIO_1280_1024 0x12F65



IDC_STATIC_WIDTH 0x12F6C



IDC_STATIC_LENGTH 0x12F6D



IDC_STATIC_HORIZONAL_PIXEL_LABEL 0x12F6E



IDC_STATIC_VERTICAL_PIXEL_LABEL 0x12F6F



IDC_RADIO_GENERIC_CGI_SCRIPT 0x12F76



IDC_RADIO_IMAGE_SOURCE_SCRIPT 0x12F77



IDC_RADIO_FORM_ACTION_HANDLER 0x12F78



IDC_RADIO_PAGE_DEPOT_SCRIPT 0x12F79



IDC_RADIO_COUNTER 0x12F80



IDC_RADIO_EMAIL_FORM 0x12F81



IDC_RADIO_GUEST_BOOK0x12F82



IDC_RADIO_SITE_SEARCH0x12F83



IDC_RADIO_FRAME_SIZE_IN_PIXEL 0x12F8A



IDC_RADIO_FRAME_SIZE_IN_PERCENT 0x12F8B



IDC_RADIO_MARGIN_HEIGHT_DEFAULT 0x12F8C



IDC_RADIO_MARGIN_HEIGHT_CUSTOM 0x12F8D



IDC_STATIC_MARGIN_HEIGHT_STATIC_TEXT 0x12F8E



IDC_RADIO_MARGIN_WIDTH_DEFAULT 0x12F8F



IDC_RADIO_MARGIN_WIDTH_CUSTOM 0x12F90



IDC_STATIC_MARGIN_WIDTH_STATIC_TEXT 0x12F91



IDC_SPIN_MARGIN_HEIGHT 0x12F92



IDC_EDIT_MARGIN_HEIGHT 0x12F93



IDC_STATIC_CS_IMAGE_MAP 0x175F1



Table Properties 
Regulates the number of rows and columns that appears in your table, as well as the size, alignment, spacing, 
and layout of the table's elements. The Table Properties dialog appears when you choose Table, Insert Table or 

Table, Table Properties, or when you click .

Number of 
Rows Specifies the number of rows in the table.
Columns Specifies the number of columns in the table.

Width
Specify Width Specifies the width of the current table on your Web page.
In Pixels Specifies the width of the current table in pixels.
In Percent Specifies the width of the current table as a percentage of your Web page.

Alignment
Aligns the table to the left, right, or center of the Corel WEB.DESIGNER Application Window. The default 
alignment option is to align to the left margin.

Layout
Border Size Specifies the table's border size in pixels. If you set your border size value to zero, 

Corel WEB.DESIGNER surrounds the table with a dotted line but no border appears 
in your Web browser.

Cell Padding Specifies the size of the space between a cell wall and its contents.
Cell Spacing Specifies the size of the space between cells in a table.

 Notes
· Disable the width check box to allow cells to size according to their contents.
· The Corel WEB.DESIGNER border, cell-padding, and cell-spacing values default to zero.



About Corel WEB.DESIGNER
Opens a dialog box that displays the application version, your registration status, and informative Web contacts. 
Click the Corel WEB.DESIGNER icon in this dialog box to view a list of the members of the Corel WEB.DESIGNER 
development team.
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Document Tree 
Displays the hierarchical structure of your Web page and the HTML tags that are applied to text and other 
objects in your current Corel WEB.DESIGNER document. The text affected by the HTML code appears between 
the opening and closing HTML container tags, e.g., <P>text</P>.
You can expand or collapse the display of embedded tags on a Web page by clicking the  or 
 key next to the HTML code.

Indicates that you can expand the display to show additional text, objects, and HTML tags.
Indicates that all embedded tags are displayed.

 Notes
· The Document Tree dialog box displays a read-only view of your Corel WEB.DESIGNER document. You cannot 

edit or modify your Web pages in the Document Tree.
· Image maps are not explicitly referenced in the Document Tree dialog box. Instead, you will see an <A HREF> 

reference to the .MAP file you created, along with the image source, below the opening HTML <BODY> tag. If 
you insert an .HTML file that contains an image map, into your current document, Corel WEB.DESIGNER 
references the image-map file outside of the </HTML> tag at the bottom of the Document Tree dialog box.
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Image Properties 
Adds an image to your Web document. If the image is not located in the server root folder or in the same folder 
or a subfolder of your .HTML file, Corel WEB.DESIGNER prompts you to copy the image to the appropriate 
reference location.

Image Source
Identifies the location of the image that you want to add to your Corel WEB.DESIGNER document or click the 
Browse button to locate the image file. You can choose a .JPG, .GIF, .BMP, .TGA, or .PCX file. Corel WEB.DESIGNER
supports .GIF and .JPG file types directly and will convert .BMP, .TGA, and .PCX files to .GIF or .JPG format.

Edit button
Click the Edit button to launch Corel WEB.PhotoPaint. Corel WEB.PhotoPaint allows you to edit images using the 
bitmap-based image editing and painting tools.

Alternate Text
Specifies the text that will replace the image in cases when the graphic file cannot be displayed on a Web 
browser (because of availability problems or display restrictions).

Alignment
Specifies the alignment of an image on your Corel WEB.DESIGNER page. 

Border Thickness
Browser Default Assigns the default border thickness to your image.
Zero Border Removes the border from your image.
Custom Thickness Specifies a border width in pixels.

Horizontal Spacing
Browser Default Assigns the default horizontal spacing to your image.
Pixels Specifies a horizontal spacing value in pixels.

Vertical Spacing
Browser Default Assigns the default vertical spacing.
Custom Spacing Specifies the vertical spacing of your image in pixels.

Height Scaling
Scale Height When enabled, scales the image height.
Custom Height Specifies the scale in pixels.
Percentage of window Specifies the scale as a percentage of the window.

Width Scaling
Scale Width When enabled, scales the image width.
Custom Width Specifies the scale in pixels.
Percentage of window Specifies the scale as a percentage of the window.

Keep Scaling Aspect Ratio
Enable to maintain the current scaling image proportions. When you enter a value in the width box, the value in 
the height box will automatically be adjusted.

 Note
· To create an inline image, double-click the image and choose the Hyperlink tab in the Image Properties dialog 

box. Specify the destination URL for the image and click OK.



Horizontal Rule Properties 
Specifies the properties of a horizontal rule, including its height, width, alignment, and shading. When you have 
modified these properties, click OK to save your changes and exit, or click Cancel to exit without saving your 
modifications. The Apply button implements the changes you've made without closing the dialog box.

Height Properties
Browser Default Specifies the standard height of a rule (depends on your browser).
Pixels Specifies the height of the rule in pixels.

Width Properties
Browser Default Specifies the standard width of a rule (depends on your browser).
Pixels Specifies the width of the rule in pixels.
% of Page Width Specifies the width of a rule as a percentage of the page width.

Alignment Properties
Browser Default Specifies the standard alignment of a rule (depends on your browser).
Left | Center | Right Aligns the rule to the left, center, or right of the page.

Shading Properties
Browser Default Specifies the standard line-shading of a rule (depends on your browser).
Unshaded Specifies an unshaded horizontal rule.
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Text Field Properties 
Allows you to customize the appearance of your form's text field. After making changes, click OK to exit and save
your modifications or click Cancel to exit and restore properties to their original settings. The Apply button 
implements the changes you've made without closing the dialog box.

Name
Assigns a name to the text field. This name will be used by the CGI script that processes your form's data.

Type
Single Line Creates a single-line text field for your form.
Multi Line Creates a multiline text field for your form.
Password Field Creates a password text field for your form.

Size
Character Width Specifies the number of characters that appear in the text field.
Maximum Length Specifies the maximum number of characters that the text field stores.

Initial Value
Specifies a default value that appears in the text field when the form is displayed.



Button Properties
Allows you to customize the appearance of your form's buttons. After making changes, click OK to exit and save 
your modifications or click Cancel to exit and restore properties to their original settings. The Apply button 
implements the changes you've made without closing the dialog box.

Name
Assigns a name to the button. This name will be used by the CGI script that processes your form's data.

Type
Submit Form Contents To URL Formats the button to perform a submit operation. Sending the form's contents to 

the URL of the CGI program that you specified in the Form Action Handler dialog 
box.

Reset Form With Default Values Formats the button to perform a reset operation. Resetting the form’s field 
entries to their default values.

Button Label
Specifies the text that you want to appear on the button.



Radio Button Properties
Allows you to customize the appearance of your form's radio buttons. After making changes, click OK to exit and 
save your modifications or click Cancel to exit and restore properties to their original settings. The Apply button 
implements the changes you've made without closing the dialog box.

Name Of Radio Group
Assigns a name to the radio button. This name will be used by the CGI script that processes your form's data.

Initial State
Selected Enables the button by default.
Unselected Disables the button by default.

Value Sent When Button Selected
Specifies the value sent by the form when the radio button is enabled.



Check Box Properties
Allows you to customize the appearance of your form's check boxes. After making changes, click OK to exit and 
save your modifications or click Cancel to exit and restore properties to their original settings. The Apply button 
implements the changes you've made without closing the dialog box.

Name
Assigns a name to the check box. This name will be used by the CGI script that processes your form's data.

Initial State
Checked Enables the check box by default.
Unchecked Disables the check box by default.

Value Sent When Checked
Specifies the value sent by the form when the check box is enabled.



List Properties 
Allows you to customize the appearance of your form's selection list or menu. After making changes, click OK to 
exit and save your modifications or click Cancel to exit and restore properties to their original settings. The Apply
button implements the changes you've made without closing the dialog box.

Name
Assigns a name to the selection list or menu. This name will be used by the CGI script that processes your form's
data.

Type
Dropdown Menu Formats the form element as a drop-down menu.
List Box Formats the form element as a list box. If enabled, you can also specify the height 

of the list and indicate whether users may choose multiple items.
Height Specifies the number of items that can appear in the list box. 
Allow Multiple Selections Allows the user to select more than one item from the list box.

Contents
Item label Lists the items that will appear in your form's drop-down menu or list box.
Add Adds an item to the menu or list box.
Modify Allows you to edit an item in the drop-down menu or list box.
Remove Removes the selected item from the menu or list box.

 Note
· You can specify the text that is displayed, the value returned, and the initial state of each item in the menu or 

list.



IDD_PP_FORM_FORM 0x200DB



IDD_ADD_FORM_MENU_ITEM 0x200DC



HTML Parser Error
Detects invalid HTML statements in your Web page. Most often, error statements occur if you have incorrectly 
edited the Document Source code for your Web page or if you have merged files that use tags not supported by 
Corel WEB.DESIGNER. Record the line numbers and errors reported in the Parser Error, then click View, 
Document Source to open your Web page document and edit the invalid statements. If the Parser Error occurs in 
your Web page containing frames, click View, Frame Source to edit the HTML code.
Although some browsers may display a parser that contains incomplete coding or nonstrict coding, Corel 
WEB.DESIGNER follows strict HTML tag regulations and identifies all irregular tag forms as errors.

 Note
· The Corel WEB.DESIGNER HTML Parser Error attempts to resolve coding errors for you. For example, if opening 

tags are found within your HTML document without their closing tags, such as a <TABLE> tag without the 
</TABLE> tag, Corel WEB.DESIGNER automatically closes the tag for you.
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Applet Properties 
Allows you to customize the appearance of applets in your Corel WEB.DESIGNER page. The Applet Properties 
dialog box controls the selection and display of the Java Powered applets you import to your Web document, 
allowing you to specify properties that include applet class, alternate text for browsers that don’t support 
applets, spacing, alignment, and scaling values.

Applet
Applet Class Specifies the applet .CLASS file that you want to insert in your Web page. Pressing 

the Browse button allows you to search your local system for the file.
Codebase Identifies the folder path that contains the applet .CLASS file if the file is saved in a

folder other than your server root. The codebase entry must not contain 
the .CLASS file name.

Alternate Text Specifies the text that will appear in the applet's place if the applet cannot be 
displayed (because of browser incompatibility or availability problems).

Horizontal/Vertical Spacing Specifies pixel values for the horizontal and vertical spacing of your applet. Select 
the browser default option for automatic regulation.

Alignment Specifies an alignment option for your applet. Choose from the browser default, 
baseline, top, middle, bottom, text top, absolute middle, absolute bottom, left, or 
right alignment options.

Scaling Regulates the width and height of your applet in pixels. Scaling is most effective at
the default (200 x 200) setting.



Bookmark 
Lists the names of all the bookmarks in the your Corel WEB.DESIGNER document. After a bookmark has been set,
you can create a hyperlink to jump to the target location.

Bookmark Name
Names a formatted bookmark.

Other Bookmarks
Lists the names of all previously defined bookmarks in the your Corel WEB.DESIGNER page.
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Applet Parameters
Allows you to specify the parameters for your Applet. Only programmers who are experienced with the Java 
Programming Language should attempt to edit their applet's parameters.

Parameters
Parameter Lists the parameters that correspond to the .CLASS file specified on the Applet tab.
Name Displays the parameter name.
Value Displays the parameter value.

 Notes
· To edit or remove a parameter, double-click an entry in the main field of the Parameters tab.
· After you have specified the Applet CLASS on the Applet tag, Corel WEB.DESIGNER automatically inserts the 

appropriate parameters in the Parameters tag.



Add a Corel WEB.MOVE Animation
Enables you to launch Corel WEB.MOVE to create an animation file for use in your Corel WEB.DESIGNER Web 
page.
Display This Screen Next TimeEnable this check box to display this dialog box each time you launch Corel 

WEB.MOVE.
Open Corel WEB.MOVE Launches Corel WEB.MOVE from within the Corel WEB.DESIGNER Application 

Window.
 Note

· In Corel WEB.MOVE, click File, Publish to Corel WEB.DESIGNER to automatically insert your Corel WEB.MOVE 
animation in your Web page. 



Select HTML Browser 
Specifies the folder that contains the Web browser that you want to use to preview your Corel WEB.DESIGNER 
documents. Type the path for the HTML Browser or click the Browse button to locate the file. The first time you 
choose the Set Browser command from the Tools menu, the Select HTML Browser dialog box appears. After you 

specify a browser, choose Tools, Browser Preview or click  to launch the specified browser directly from the 
Corel WEB.DESIGNER Application Window.

Path For HTML Browser
Displays the folder that contains the executable file (.EXE) of the Web browser that you've selected to preview 
your Corel WEB.DESIGNER documents.



Insert Rows/Columns 
Defines the number and placement of the rows or columns you want to add to your table.

Insert Rows
Number Of Rows Specifies the number of rows to add to the current table.
Above Selection Places the rows above your current cursor position.
Below Selection Places the rows below your current cursor position.

Insert Columns
Number Of Columns Specifies the number of columns to add to the current table.
Left of Selection Places the columns to the left of your current cursor position.
Right of Selection Places the columns to the right of your current cursor position.



Options 
Allow you to enable or disable the Welcome On Startup message, the Application Launch messages, Corel 
WEB.DRAW’s Image transparency option, and the Lower Case Filename command. You can also select the 
modem speed to be used to estimate the download time displayed by Page Performance Indicator.

Display Welcome Screen On Startup
Enables or disables the appearance of the Welcome Screen On Startup. The welcome screen gives you the 
option to start a new Web page, start a new Web page containing frames, open an existing Web page, or choose 
a template to begin a Web page.

Enable Lower Case File Names
Allows all referenced files in your HTML documents to appear in lowercase letters when you click Browse in an 
application dialog box. By default, Corel WEB.DESIGNER disables this option.

Display Application Startup Screens
Enables or disables the appearance of the application startup screens when you launch another Corel WebMaster
Suite program from the Corel WEB.DESIGNER Application Window.

Enable Transparency When Publishing From Corel WEB.DRAW
Enables or disables the appearance of transparent .GIF images when you publish a drawing created in Corel 
WEB.DRAW. Transparency removes a .GIF image's background color from the graphics file, so that when it is 
displayed, the browser's background color shows through the image. If you publish a Corel WEB.DRAW image to 
Corel WEB.DESIGNER with the transparency command enabled, your image appears to float on your Web page. If
you publish a Corel WEB.DRAW image to Corel WEB.DESIGNER with the transparency command disabled, the 
image's original background color overrides the browser's background color. Corel WEB.DESIGNER defaults to the
transparent setting.

Page Load Performance
Indicates the speed of modem that visitors to your Web page will be using to access your page. The modem 
speed that you select in this dialog box will affect the Page Performance Indicator that appears on the Status Bar 
in the Corel WEB.DESIGNER Application Window. 

 Notes
· The Enable Transparency When Publishing From Corel WEB.DRAW command applies exclusively to Corel 

WEB.DRAW images. Corel WEB.DESIGNER displays all other .GIF images according to their individual properties
(transparent or plain).

· If you use FTP to transfer your Corel WEB.DESIGNER documents to your UNIX server or service provider 
without enabling the Lower Case File Names option, your FTP application may transfer the files in lowercase 
regardless of the actual DOS case referenced throughout your documents. Because UNIX systems maintain 
case sensitivity, the files referenced in links and images throughout your Corel WEB.DESIGNER pages may not 
display accurately on the Web. 



Frame wizard - Layout
Allows you to specify the layout of the frames on your Web page.

Style
Choose a frame layout from the Style list box. The preview window, on the left of your screen, displays the frame
layout of the style you select. Choose Custom from the Style list box to design your own frame layout. Specify 
the number or rows or columns for the page.

Once you have selected a frame layout, click Next to continue, click Back to return to the previous step, or click 
Cancel to exit the Frame wizard.



Frame wizard - Frame Properties
Allows you to specify the properties of the frames in your Web page. In the Preview window, click a frame to 
select it and enter the URL and name for that frame. After you have defined the properties of the first frame, 
click the second frame in the Preview window to define the properties of that frame.

Frame Properties
URL Of Page Type the URL of the page you want to appear in the specified frame or click the 

Browse button to locate the file on your local system.
Name Of Frame Type the name of the frame

Once you have defined the properties, click Next to continue, click Back to return to the previous step, or click 
Cancel to exit the Frame wizard.



Frame wizard - Frame Appearance
Allows you to specify the appearance of the frames in your Web page. In the Preview window, click a frame to 
select it and enter the appearance, scrolling options, and margin sizes for that frame. After you have defined the 
appearance of the first frame, click the second frame in the Preview window to define the appearance of that 
frame.

Scrolling
No The selected frame will not scroll.
Yes Adds scroll bars to the selected frame to allow it to scroll.
Auto Adds scroll bars to the selected frame if they are needed to view the entire 

contents of the frame.
Border Allows you to add a border to the selected frame.
Resizable Allows the user to resize the selected frame when your Web document is displayed

in a Web browser.

Margin Height
Default Assigns the default Margin Height.
Pixels Specifies the margin height in pixels

Margin Width
Default Assigns the default Margin Width.
Pixels Specifies the margin width in pixels

Once you have defined the properties, click Finish to create your Web page containing frames, click Back to 
return to the previous step, or click Cancel to exit the Frame wizard.
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Frame wizard - Welcome
Displays the opening screen of the Frame wizard. The Frame wizard will allow you to quickly and easily create a 
Web page containing frames. A frames page is a Web page that contains multiple Web pages within it.

Filename Of Frames Layout Document
You must specify the filename of the document containing Frames. This file will be placed in your server root 
folder.

Once you have typed the document name, click Next to continue or click Cancel to exit the Frame wizard.
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Select A Sound File 
Specifies a sound file that will play when a sound-capable browser accesses your Corel WEB.DESIGNER 
document. The Select A Sound File dialog box allows you to choose a sound file and to preview the sound before 
you insert it as background music for your Web page.

Look In
Lists the drives and folders on your local system to allow you to search for the file that you want to open.

File Name
Identifies the name of the file that you want to open. The Select A Sound File dialog box lists files with the 
extension you specify in the List Files Of Type field.

Files Of Type
Regulates the file type that is displayed in the main area of the Select A Sound File dialog box. Corel 
WEB.DESIGNER automatically filters your system's files to display .WAV files, .AIFF files, .AU files, .MIDI files, or 
all files contained in the specified folder.

Play A Sound File
Plays a selected sound file before you insert it as the background sound for your Web page.

Stop Sound
Stops playing the sound file.

 Note
· The Corel WEB.DESIGNER background sound feature is only supported by browsers that recognize the 

<BGSOUND> HTML tag, e.g., Microsoft's Internet Explorer 3.0.



Frame wizard - Confirm
Next Allows you to continue with the next screen in the Frame wizard. If you continue, 

you can specify the properties of each of the frames in your Web document.
Finish Exits the Frame wizard and creates your Web page containing frames. If you 

choose to finish the wizard at this step, the names and properties of each frame 
will be automatically assigned. 

Once you have enabled the Next or Finish button, click Next to continue, click Finish to create a frames page, 
click Back to return to the previous step, or click Cancel to exit the Frame wizard.
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Hyperlink Properties 

Hyperlink Properties 
Specifies the Uniform Resource Locator (URL) of your hyperlink's destination or target. Hyperlinks on Web pages 
allow you to quickly navigate to interesting information or locations. By clicking a hyperlink, you can jump to a 
different Web page to access entirely new information. Corel WEB.DESIGNER can easily create hyperlinks from 
text blocks or images displayed on your Web page.

Hyperlink
URL of Hyperlink Specifies the destination URL of the hyperlinked text.

Target
Specify the type of frame or window where the output HTML will be placed. You can choose to display the output 
in one of the following types of target windows:
_blank Loads the output into a new blank window. This window is not named.
_parent Loads the output into an immediate parent of the document.
_self Loads the output into the same window.
_top Loads the output into the full body of the window.
_none The default for Corel WEB.DESIGNER is no target window.

 Notes
· To link to a World Wide Web site, type the page's URL in the URL Of Hyperlink text box. To link to a file on your 

local server, click the Browse button and locate the file.
· To link to a bookmark, click the Bookmark tab and choose a bookmark from the Bookmarks list box.
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Spell Check 
Checks the spelling of all text on your Corel WEB.DESIGNER document. If Corel WEB.DESIGNER finds a word that 
is not in its dictionary, it generates a list of substitute terms. You can pick one of the suggestions and click 
Change or Change All to replace the error or click Ignore or Ignore All to bypass all occurrences of the suspect 
word.

Word Not In Dictionaries
Displays the suspect word or term.

Change To
Displays the replacement word or term.

Suggestions
Displays a list of suggested replacements for the suspect term. This list is generated from the Corel 
WEB.DESIGNER dictionary and your personal dictionaries.

Ignore
Ignores the current occurrence of a suspect word.

Ignore All
Ignores all occurrences of the suspect word on your Web page.

Change
Replaces the suspect word with one of Corel WEB.DESIGNER's suggested terms or a customized replacement.

Change All
Replaces all occurrences of the word on your Web page with one of the suggested terms or a customized 
replacement.

Add to Personal
Adds a suspect word to your personal dictionary for use in subsequent spell checks. 

Close
Ends the spell check and displays the results.
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Image Map Properties 
Identifies an existing image map file or creates a new image map file to allow you to project multiple hyperlinks 
onto defined regions of an image. 

Use Image Map
Enable to specify an image map file to associate with the image on your current Corel WEB.DESIGNER page.

Server Side Image Map URL
Specifies an existing image map file. Type the .MAP file's URL or click the Browse button to locate the file on your
system.

Client-Side Image Map URL
Indicates that the image map can be processed as a client-side image map. Client-side image maps work by 
placing a complete representation of the image's active areas (including their shape, size, and destination URL) 
into an SGML-compliant textual form. When you save your image map as server-side, Corel WEB.DESIGNER 
automatically gives the image a client-side name in the Client-Side Image Map URL field.

Edit Map
Opens the specified image map file for editing.

Create Map
Opens the selected image in the Image Map Editor window to allow you to create a new image map file.



Image Map Editor 
Defines the hyperlink areas for an image map file. To create an image map file, define a region of the image and 
specify the URL for the hyperlink that you want to create.

Element
Indicates the shape of a hyperlinked area within an image. Default (background) is displayed for areas of an 
image where no hyperlink is defined. 
Target URL
Specifies the destination URL for a hyperlinked area. To link to a file that resides on your local system, click 
Browse and navigate to the appropriate folder.

Target
Specify the type of frame or window where any output HTML will be placed. You can choose to display the output
in one of the following types of target windows:
_blank Loads the output into a new blank window. This window is not named.
_parent Loads the output into an immediate parent of the document.
_self Loads the output into the same window .
_top Loads the output into the full body of the window.
_none The default for Corel WEB.DESIGNER is no target window.

Comment
Allows you to label a particular hyperlinked area and its corresponding URL.

Browse 
Allows you to navigate to a file that you want to associate with a hyperlinked area or region of an image.

Tool Shapes
Specifies the boundaries of a hyperlinked area.

Save
Displays the Save As dialog box to prompt you to specify where you want to save your new image-map file 
(NCSA compliant). A client-side image map is also created.



Server Root 
Specifies a folder that will store your .HTML files and provides the base location from which Corel WEB.DESIGNER
resolves relative URLs to image files and other hyperlinked documents. 

Server Root
Specifies the folder that stores all of the .HTML files and referenced objects used in your Corel WEB.DESIGNER 
documents. Type a precise folder path or click the Browse button to search your local system for the appropriate 
folder.

 Note
After changing your server root folder, restart Corel WEB.DESIGNER to apply the setting.
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Page Properties 
Specifies an image (.JPG or .GIF) to use as the background for your Web page or specifies a default background 
color. You can also specify the document title, background sound, and text colors in the Page Properties dialog 
box.

Document Title
Specifies a document title, which is displayed in the browser's Title Bar on the Web.

Customize Background
Background Image Source Specifies the location of the image that you want to use as your background, 

relative to your server root folder. Click the Browse button to navigate directly to 
the location of your background image.

Background Color Changes the background color. Choose a color from the Background Color list box. 
To return to the default color setting, click the Default option. To specify a Custom 
color, click the Custom option. Corel WEB.DESIGNER specifies white as the default 
background color.

Background Sound
Specifies a sound file that plays when a visitor accesses your Web page. Click the Browser button to navigate 
directly to the location of your sound file. 
Loop Value Determines the number of times that the file plays when a visitor accesses your 

Web page.
Infinite Enable the Infinite check box to play the sound file continuously while your Web 

page is active. 
Customize Text Colors
Specifies the color of Regular Text, Normal Links, Visited Links, Active Links, and Bookmarks on your Web page. 
To change the color of a text item, click the  button next to the current (or default) color setting. Corel 
WEB.DESIGNER allows you to choose ten standard colors, to reset the default color setting by clicking the 
Default option), and to specify a Custom color (by clicking the Custom option).

 Notes
· If you choose Custom when specifying background or text colors, Corel WEB.DESIGNER opens the Color dialog 

box to allow you to choose a custom color setting for the text or item that you have selected.
· Background sound can only be played by browsers that have sound capability.



Link To Bookmark
Allows you to choose a bookmark as the destination or target of a hyperlink in the same Corel WEB.DESIGNER 
document. Bookmarks in Web Pages allow you to quickly navigate to specific information. By clicking a bookmark
link, you can jump to a different location on the current Web page. Corel WEB.DESIGNER can easily create 
standard hyperlinks from text blocks or images to a bookmark that lies in a different area of your Web page.

Bookmarks
Lists the bookmarks that you have formatted in your Corel WEB.DESIGNER document.

 Note
· To link to a bookmark, click the Bookmark tab and choose a bookmark from the Bookmarks list box.
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Add a Corel WEB.DRAW Image
Enables you to launch Corel WEB.DRAW to create an image file for use in your Corel WEB.DESIGNER Web page.
Display This Screen Next TimeEnable this check box to display this dialog box each time you launch Corel 

WEB.DRAW.
Open Corel WEB.DRAW Launches Corel WEB.DRAW from within the Corel WEB.DESIGNER Application 

Window.
 Note

· In Corel WEB.DRAW, click File, Publish to Corel WEB.DESIGNER to automatically insert your Corel WEB.DRAW 
image in your Web page. 



Add a Corel WEB.WORLD VRML
Enables you to launch Corel WEB.WROLD to create a VRML file for use in your Corel WEB.DESIGNER Web page.
Display This Screen Next TimeEnable this check box to display this dialog box each time you launch Corel 

WEB.WORLD.
Open Corel WEB.WORLD Launches Corel WEB.WORLD from within the Corel WEB.DESIGNER Application 

Window.
 Note

· In Corel WEB.WORLD, click File, Publish to Corel WEB.DESIGNER to automatically insert your Corel WEB.WORLD
three-dimensional world into your Web page. 



Embedded File Properties
Displays the properties of any file that is embedded in your Corel WEB.DESIGNER document. Embedded files can 
include .MPG files, Sun Audio (.AU), and MIDI files or any other file type that you can view in your Web browser or
with accompanying plug-in applications. Double-click an embedded file or select the file and choose Edit, 
Properties to display the Embedded File Properties dialog box.

Embedded File
Specifies the name and location of the file that you want to embed in your current Corel WEB.DESIGNER 
document.

Horizontal Spacing
Browser Default Applies the default horizontal spacing to the embedded file.
Pixels Allows you to specify a horizontal spacing value in pixels.

Vertical Spacing
Browser Default Applies the default vertical spacing to the embedded file.
Pixels Allows you to specify a vertical spacing value in pixels.

Alignment
Controls the placement of the embedded file on your Corel WEB.DESIGNER page.

Scaling
Width Specifies the width of the embedded file. The default value is 200.
Height Specifies the height of the embedded file. The default value is 200.

 Note
· A feature's properties can be altered limitlessly; therefore, don't be afraid to substitute values and preview 

results. In fact, this type of experimentation often provides the best understanding of an element or property 
value.



Cell Properties 
Use the Cell Properties dialog box to define the properties of the individual cells in your Corel WEB.DESIGNER 
tables.

Minimum Width
Specify Width Allows you to specify the width of a selected cell in pixels or as a percentage.
In Pixel Displays the cell width in pixels.
In Percent Displays the cell width as a percentage of the table width.

Alignment
Horizontal Specifies the horizontal alignment of a cell's contents.
Vertical Specifies the vertical alignment of a cell's contents.

Cell Type
Data Enable to displays cell contents in normal font.
Header Enable to displays cell contents in bold font. Create header cells in the top row of 

your table to give a label or title to each corresponding column.

Cell Span
Number of Spanned Rows Changes the height of the selected cell to be equal to the height of the    number 

of spanned rows specified.
Number of Spanned Columns Changes the width of the cell to be equal to the width of the number of spanned 

columns specified.
 Notes

· The Cell Properties command is only available when you have selected an individual cell in the table. 
· Disable the width check box to allow the cell to size according to its contents.
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Form Action Handler
Specifies the URL for the CGI script that will process input submitted by your form. Type the file location relative 
to your server root folder or click the Browse button to navigate directly to the file location of the CGI Script.

URL of CGI Script
Type the URL of the CGI script that controls your form's functionality or click the Browse button to navigate to the
folder that contains the CGI script. The CGI script that you specify in the URL Of CGI Script field is responsible for 
serving up documents and creating new documents on request. You may leave the URL Of CGI Script field blank 
and identify the script at a later time by clicking the top or bottom of your form's border.

Target
Specify the type of frame or window where the output HTML will be placed. You can choose to display the output 
in one of the following types of target windows:
_blank Loads the output into a new blank window. This window is not named.
_parent Loads the output into an immediate parent of the document in which the CGI 

script is in.
_self Loads the output into the same window as the CGI script.
_top Loads the output into the full body of the window.
_none The default for Corel WEB.DESIGNER is no target window.

 Note
· When a visitor to your Web page submits a form, the information is sent to your server. How the information is 

handled by the server is determined by CGI scripts. Consult your Webmaster about the setup and use of CGI 
scripts.
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Insert CGI Script

Script Format
Generic CGI Script Allows you to add a Generic CGI script to your Web page.
Image Source Script Allows you to add an Image Source CGI script to your Web page. The most 

common example of an Image Source CGI script is a page hit counter.
Form Action Handler Allows you to add a CGI script to control a form on your Web page. 
PageDepot Script Allows you to add a PageDepot CGI script to your Web page. These CGI scripts will 

only function if you published your Web pages to the PageDepot site provided by 
Microcrafts Inc. 

URL Of CGI Script
Type the URL of the CGI script that controls your form's functionality or click the Browse button to navigate to the
folder that contains the CGI script. The CGI script that you specify in the URL Of CGI Script field is responsible for 
serving up documents and creating new documents on request. You must specify the URL of CGI script for 
Generic, Image Source, and Form Action Handler CGI scripts.

Target
Specify the type of frame or window where the output HTML will be placed. You may specific a target window for 
Generic and Form Action Handler CGI scripts. The target windows in which you can choose to display the output 
are:
_blank Loads the output into a new blank window. This window is not named.
_parent Loads the output into an immediate parent of the document in which the CGI 

script is in.
_self Loads the output into the same window as the CGI script.
_top Loads the output into the full body of the window.
_none The default for Corel WEB.DESIGNER is no target window.
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PageDepot Scripts

Scripts
Counter Allows you to add a page hit counter to your Web page to count the number of 

visitors that have accessed your page. You can only place one page hit counter on 
each Web page. Click the Properties button to edit the counter properties.

Email Form Allows you to add a simple mechanism for a user to process form information and 
generate return email. After you placed the email form on your Web page, you can
modify the layout, labels, and values of the form elements.

Guest Book Allows you to add a guest book to your Web page to enable visitors to comment 
on your site and read comments from other users. After you placed the guest book
on your Web page, you can modify the layout, labels, and values of the form 
elements.

Site Search Allows you to add a site search to your Web page to enable visitors to search the 
site for strings or components. After you placed the site search on your Web page, 
you can modify the layout, labels, and values of the form elements.

 Notes
· These CGI scripts will only function if you published your Web pages to the PageDepot site provided by 

Microcrafts Inc.
· When you place the CGI script object on your Corel WEB.DESIGNER Web page, you should not remove or 

rename any of the elements, unless you intend to remove the entire object. 



Add a Corel WEB.PhotoPaint Image
Enables you to launch Corel WEB.PhotoPaint to create an image file for use in your Corel WEB.DESIGNER Web 
page.
Display This Screen Next TimeEnable this check box to display this dialog box each time you launch Corel 

WEB.PhotoPaint.
Open Corel WEB.PhotoPaint Launches Corel WEB.PhotoPaint from within the Corel WEB.DESIGNER Application 

Window.
 Note

· In Corel WEB.PhotoPaint, click File, Publish to Corel WEB.DESIGNER to automatically insert your Corel 
WEB.PhotoPaint image into your Web page. 



Counter Script Properties 
Enables you to define the properties for the counter object.

Alternative Text
Specifies the text that will replace the counter in cases when the counter cannot be displayed on a Web browser 
(because of availability problems or display restrictions).

Alignment
Specifies the alignment for your counter. Choose from the browser default, baseline, top, middle, bottom, text 
top, absolute middle, absolute bottom, left, or right alignment options.

Horizontal Spacing
Default Assigns the default Margin Height.
Pixels Specifies the margin height in pixels

Vertical Spacing
Default Assigns the default Margin Height.
Pixels Specifies the margin height in pixels

Size
Use Image Defaults Enable this check box to use the default size for the counter object.
Specify Width Specifies the width of the counter object on your Web page. You can specify the 

counter width in pixels or as a percentage.
Specify Height Specifies the height of the counter object on your Web page. You can specify the 

counter width in pixels or as a percentage.
Maintain Aspect Ratio Enable this checkbox to maintain the current scaling proportions of the object. 

When you enter a value in the width box, the value in the height box will 
automatically be adjusted.
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Frame Properties
Specifies the Properties of the frames in your Web page. Use the Frame Properties dialog box to specify the 
name, size, scrolling, and border properties of the frames in your Corel WEB.DESIGNER Web page.

URL Of Page
Specifies the URL of the selected frame.

Name Of Frame
Specifies the Name of the selected frame

Border 
Enable to display the selected frame with a border.

Resizable
Enable to make the current frame resizable when you display your Web page in a Web browser.

Scrolling
Enable the appropriate button to make the frame scrollable, not scrollable, or to scroll automatically when the 
Web page is scrolled.

Margin Height
Default Assigns the default Margin Height.
Pixels Specifies the margin height in pixels

Margin Width
Default Assigns the default Margin Width.
Pixels Specifies the margin width in pixels

Frame Size
Auto Assigns the default frame size.
Custom Specifies a custom frame size. You can choose to set the custom size as a 

percentage or in pixels.
 Note

· A frame will only be resizable if the surrounding frames allow the frame to be moved. For example, if you have 
chosen the Magazine frame layout and make only the left and bottom frames resizable, the top frame will hold
the other two frames in position so they cannot be resized. 
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Select Browser 
Specifies the Web browser that you want to use to preview your Corel WEB.DESIGNER documents. Choose the 
Set Browser command from the Tools menu, the Select Browser dialog box appears to enable you to select a 

browser. After you specify a browser, choose Tools, Browser Preview or click  to launch the specified browser 
directly from the Corel WEB.DESIGNER Application Window.

Browsers
Add Opens the Select HTML browser dialog box to enable you to add another Web 

browser to the Browser list.
Edit Opens the Select HTML browser dialog box to enable you to change the path to 

the specified Web browser.
Remove Removes the selected Web browser from the Browser list.

Window Size
Enable the button next to the screen resolution you would like to use to preview your Web page. It is important 
to test your Web page using different screen resolutions to ensure that visitors to your Web site will be able to 
view your Web page as it was designed to look. Enable the Browser Default button to view your Web document 
at the default screen resolution. 



Add a Corel WEB.DATA Database
Enables you to launch Corel WEB.DATA to convert a database to HTML for use in your Corel WEB.DESIGNER Web 
page.
Display This Screen Next TimeEnable this check box to display this dialog box each time you launch Corel 

WEB.DATA.
Open Corel WEB.DATA Launches Corel WEB.DATA from within the Corel WEB.DESIGNER Application 

Window.
 Note

· In Corel WEB.DATA, click File, Publish to Corel WEB.DESIGNER to automatically insert your Corel WEB.DATA 
database into your Web page. 



Split Cell 
Splits the selected cell in the current table. 

Horizontally
Enable the Horizontally button to split the selected horizontally into rows. In the Split Into box, type the number 
of rows into which you want to split the cell.

Vertically
Enable the Vertically button to split the selected vertically into columns. In the Split Into box, type the number of 
columns into which you want to split the cell.

 Note
· The Split Cell command is only available for single cells in a table.



Marquee Properties 
Specifies the text and properties of marquees in your Corel WEB.DESIGNER documents. You can use the Marquee
Properties dialog box to adjust the background color, alignment, behavior, speed, direction, repetition, and size 
of a marquee on your Web page.

Text
Specifies the text that will appear in the rectangular band that defines the marquee.

Background
Allows you to define the background color of the marquee. You can choose a color from the Background list box 
or choose Custom to define your own shade using the Color dialog box.

Text Alignment
Aligns your marquee text to the bottom, top, center, left, or right of normal text that appears on the same line.

Behavior
Specifies the marquee's action on your Web page. You can create a scrolling, sliding, or alternating marquee.
Scroll Causes the marquee text to scroll across your Web page.
Slide Causes the marquee text to slide across your Web page, from the starting 

direction to the opposite side of the page. When the slide is complete, the 
marquee remains on screen.

Alternate Causes the marquee text to alternate back and forth, from the starting direction to
the opposite side of the page.

Movement Speed
Determines the speed of the marquee text on your Web page.
Amount Specifies the amount, in pixels, that the marquee moves.
Delay Specifies the time, in milliseconds, before the marquee is initiated.

Spacing
Specifies the space around the marquee.
Horizontal Specifies a horizontal spacing value.
Vertical Specifies a vertical spacing value.

Direction
Specifies the direction in which the marquee moves across your Web page.
Left Causes the marquee to move from the left side of your page to the right.
Right Causes the marquee to move from the right side of your page to the left.

Height
Determines the precise height of the marquee on your page.
Specify Height Specifies the height of the marquee's rectangular region on your Web page. You 

can specify the marquee width in pixels or as a percentage.
Pixels Allows you to specify the precise height of the marquee's rectangular region.
Percentage Of Window Allows you to specify the height of the marquee's rectangular region according to 

the size of the user's window and screen resolution.

Width
Determines the precise width of the marquee on your page.
Specify Width Specifies the width of the marquee's rectangular region on your Web page. You 

can specify the marquee width in pixels or as a percentage.
Pixels Allows you to specify the precise width of the marquee's rectangular region.
Percentage Of Window Allows you to specify the width of the marquee's rectangular region according to 

the size of the user's window and screen resolution.



Repeat
Repeats the scrolling, sliding, or alternating action continuously or allows you to specify the number of times that
the action will repeat.
Continuously Enable to repeats the marquee's scrolling, sliding, or alternating action 

continuously.
Times Allows you to specify the number of times that the marquee's scrolling, sliding, or 

alternating action repeats. Disable the Continuously check box to access the Times
text box.



Progress
Displays a progress bar to visually illustrate that the Internet Web page is being opened. 
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Open Template
Creates a new Web document from a predesigned template. The template's structure provides a sample on 
which to base your new Web page. The preview window in the Template dialog box will show you a bitmap image
of the selected template.

Look In
Lists the drives and folders on your local system to allow you to search for the file that you want to open.

File Name
Identifies the name of the file that you want to open. The dialog box lists files with the extension you specify in 
the Files Of Type field.

Files of Type
Determines the file format that is displayed in the main area of the dialog box. Corel WEB.DESIGNER 
automatically filters your system's files, displaying only .HTM and .HTML file types.
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Open
Opens files that have been saved on your local system and opens Web pages from the Internet. 

Open Source
Open A Local Web Page Enable this button to open a Web page from your local system
Open A Web Page From The Internet Enable this button to open a Web page from the Internet

Path
Enter the full path to the local Web page or click the Browse button to locate the folder containing the Web page.

URL
Enter the Internet address of the Web page that you want to open. Web pages from the Internet are opened 
using the HTTP protocol.

Confirm Replace
Enable the Confirm Replace check box to have Corel WEB.DESIGNER prompt you before overwriting an existing 
file. 
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FTP Site Properties

Description
Type a name that identifies the remote computer.

New
Clears all the fields in the FTP Site Properties dialog box.

Delete
Removes the remote site from the FTP Site list box in the FTP dialog box.

FTP Site
Identifies the FTP address of the remote system

Port #
Identifies the port number on the remote computer. If you do not enter a port number, your computer will detect 
the default port number.

Login
User Name Specifies the login name for your remote account
Password Specifies the password for your remote account
Working Folder Specifies the folder on the remote system that you want to access.



FTP 
Allows you to exchange files with external or remote computers. Once you have identified the remote destination
or FTP site in the FTP Site dialog box, you can log into the remote computer and upload or download files and 
folders. The FTP dialog box allows you to transfer the Web documents that you have designed using Corel 
WEB.DESIGNER directly to your service provider for publication on the World Wide Web.

Local Source
Contains the commands required for navigating your local system. You can browse through folders, specify files, 
and modify the display of files and folders in the Local Source window.
Command Description
Look In Displays an indented list of all the drives and directories on your local system. 

When you select an entry from the Look In list box, the local file list is 
automatically updated.

Name Displays the name of the file or folder that you have selected in the local file list 
window. If you have selected multiple files or folders, the last entry in the selection
is displayed in the Name box.

Remote Source
Contains the commands required for navigating the remote system. You can browse through folders, specify files,
and modify the display of files and folders in the Remote Destination window.
Command Description
FTP Site Displays the description of the remote destination that you connected to in your 

last FTP session. The FTP Site list box displays all of the remote FTP sites that 
you've set up in the FTP Site Properties dialog box.

Setup Opens the FTP Site Properties dialog box, allowing you to identify the name, 
address, and login information for a remote FTP system.

Info Displays detailed information about selected files and folders in the Remote 
Destination window. If you select a directory, the name, type, date, and time of 
creation will be displayed in the Info box. If you select a file, the name, size, date, 
and time of creation will be displayed in the Info box.

Status Box
Records the status of operations that you perform in the FTP Upload dialog box. The Status list box contains the 
last 64 status messages produced by your FTP operations

Upload
Transfers the files or folders that you've selected in the Local Source window to the destination that you've 
specified in the Remote Destination window.

Download
Transfers the files and folders that you've selected in the Remote Destination window to the destination that 
you've specified in the Local Source window.

 Notes
· You can also drag and drop files or folders between the Local Source and Remote Destination windows.
· If you do not have a service provider or if you want to display your documents on the Web immediately, you 

can publish your completed Corel WEB.DESIGNER documents to PageDepot using Microcraft's Instant 
Publishing Wizard. To access the Instant Publishing Wizard, click File, Publish To Internet in Corel 
WEB.DESIGNER.
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Properties
Displays the properties of the current file or folder. The Properties dialog box displays the file type, location, size, 
and the attributes of the selected file or folder.
You can modify the properties of a file or folder that appears in the Local Source Window of the FTP dialog box. 
The properties of the files and folders that appear in the Remote Destination Window can be viewed but not 
modified.
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Color 
Customizes the coloring of text and background elements in your Web page. You can access the Color dialog box 

by clicking , Custom Color or by clicking File, Page Properties, and opening the list boxes. Select a predefined
color from the Basic Colors section of the dialog box or customize colors by specifying a color on the color 
palette. When you have defined an appropriate color, click Add To Custom Colors to add the shade to your 
custom-color specifications.

Basic Colors
Lists the most common color options. Choose a color and click OK to apply the selected color to your work.

Custom Colors
Stores 16 custom-color specifications for future applications.

Add To Custom Colors
Copies the specified color to the Custom Colors list box.

Color/Solid
Previews a color that you specify on the color palette.

 Notes
· If you choose a color from the Basic Colors chart, the color palette indicator moves to the corresponding shade

on the palette and a preview of your choice appears in the Color/Solid window.
· You can adjust the Hue, Saturation, and Luminosity qualities of a color by typing values in the appropriate 

fields.



Print 
Formats the appearance of your printed pages and provides access to Print Range, Print To File, and Collation 
Properties.

Printer
Name Lists the printers that you can access from your system.
Status Identifies the current operating status of the selected printer.
Type Identifies the printer by name and type.
Where Identifies the port that connects the printer to your local system.
Properties Opens the Printer Properties dialog box to allow you to set advanced printing 

options for your current document.

Print Range
All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To fields.

Print To File
Prints your document or documents to a PostScript file instead of routing it directly to a printer. You will be 
prompted to specify the filename and location

Copies
Specifies the number of copies to print for a specific page range.

Collate
Prints multiple copies in page-number order.



Print Setup
Identifies a printer and its connection.

Printer
Name Lists the printers that you can access from your system.
Status Identifies the current operating status of the selected printer.
Type Identifies the printer by name and type.
Where Identifies the port that connects the printer to your computer.
Properties Opens the Printer Properties dialog box to allow you to set advanced printing 

options for your current document.

Orientation
Portrait Prints the current document using a portrait layout (with the top along the shorter 

edge of the paper).
Landscape Prints the current document using a landscape layout (with the top along the 

bottom edge of the paper).

Paper 
Size Determines the paper size that the printer will use to print your documents.
Source Specifies the paper source. Some printers offer multiple trays for different paper 

sources.



Find
Locates a specified word or object in the current Corel WEB.DESIGNER document.

Find What
Displays the text or object that you want to locate.

Match Case 
Restricts the search to only those occurrences of the specified word or object that match the Find What field 
exactly (including case).

Find Next
Searches the current Corel WEB.DESIGNER document for the term specified in the Find What field.



Replace 
Specifies the text or object to search for and its replacement. After locating the word or object, choose Replace 
to insert the replacement text, Replace All to replace all occurrences of the word in your document, or Find Next 
to locate the next occurrence of the text or object. 

Find what
Displays the text or object that you want to locate.

Replace with
Displays the text or object’s replacement text.

Match case 
Locates only those occurrences of the specified search string that match the Find What field exactly (including 
case).

Find Next
Searches the Corel WEB.DESIGNER document for the term specified in the Find What field.

Replace
Replaces the current instance of the search string with the term specified in the Replace With field.

Replace All
Replaces all occurrences of the search string with the term specified in the Replace With field.
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ActiveX Control tags
Enables you to add an ActiveX control to your Corel WEB.DESIGNER Web page.

Control
Specifies the ActiveX control that you want to insert in your Web page. Click the Browse button to search your 
local system for the file.

Name
Specifies the name of the ActiveX control.

Alternative Text
Specifies the text that will appear in the ActiveX control’s place if the control cannot be displayed (because of 
browser incompatibility or availability problems).

Network Location
Data Source Identifies the folder path that contains the ActiveX file if the file is saved in a folder

other than your server root. The Data Source entry must not contain the file name 
of the control. Click the Browse button to search your local system for the file.

Code Source Identifies the folder path that contains the code used to run the ActiveX control. 
The Data Source entry must not contain the file name of the control.

Border Thickness
Specifies the thickness in pixels of a border surrounding the ActiveX control

Alignment
Specifies an alignment option for your ActiveX control. Choose from the browser default, baseline, top, middle, 
bottom, text top, absolute middle, absolute bottom, left, or right alignment options.

Horizontal Spacing
Browser Default Applies the default horizontal spacing to the ActiveX control.
Pixels Allows you to specify a horizontal spacing value in pixels.

Vertical Spacing
Browser Default Applies the default vertical spacing to the ActiveX control.
Pixels Allows you to specify a vertical spacing value in pixels.

Height
Browser default Sets the height of the ActiveX control to the browser default.
Pixels Allows you to specify the precise height of ActiveX control in pixels.
Percentage Of Window Allows you to specify the height of the ActiveX control according to the size of the 

user's window and screen resolution.

Width
Browser default Sets the width of the ActiveX control to the browser default.
Pixels Allows you to specify the precise width of ActiveX control in pixels.
Percentage Of Window Allows you to specify the width of the ActiveX control according to the size of the 

user's window and screen resolution.

Maintain Aspect Ratio
Enable this checkbox to maintain the current scaling proportions of the object. When you enter a value in the 
width box, the value in the height box will automatically be adjusted.

 Notes
· ActiveX controls can be viewed without a plug-in using Microsoft Internet Explorer.
To view an ActiveX control using Netscape Navigator, you must download a plug-in. You can download the 
ActiveX plug-in from http://www.ncompasslabs.com/.



ActiveX Control Properties
Enables you to define the properties for the ActiveX control.
Preview Window Displays the ActiveX control. You can resize the control in this window.
Edit Properties Allows you to modify the parameters that appear in the document source. In the 

Edit Parameters dialog box, the parameters appear in a list. The Property 
represents the parameter name and the Value is the attributes of the ActiveX 
control that can be modified. 

Property Page Allows you to modify the properties of the ActiveX control. These properties are 
determined by the creator of the ActiveX control.

 Note
· The Edit Properties and Property page options are not available for every ActiveX control. The creator of the 

ActiveX control determines whether or not the properties and parameters can be modified.
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Transfer Options

Default Mode
Binary Specifies a binary file transfer. Binary is the Corel WEB.DESIGNER default transfer 

mode. Use this mode if transferring a file containing graphics.
ASCII Specifies a ASCII file transfer. Use this mode if transferring HTTP.

Default Rate
Receive Bytes When transferring a file using FTP, the file is sent as a series of smaller pieces of 

information. The value in the Receive Bytes box specifies the size the pieces that 
are received.

Send Bytes When transferring a file using FTP, the file is sent as a series of smaller pieces of 
information. The value in the Send Bytes box specifies the size the pieces that are 
sent.
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Properties
Displays the properties of the current file or folder. The Properties dialog box displays the file type, location, size, 
and the attributes of the selected file or folder.
You can modify the properties of a file or folder that appears in the Local Source Window of the FTP dialog box. 
The properties of the files and folders that appear in the Remote Destination Window can be viewed but not 
modified.



Properties
Displays the properties of the current file or folder. The Properties dialog box displays the file type, location, size, 
and the attributes of the selected file or folder.
You can modify the properties of a file or folder that appears in the Local Source Window of the FTP dialog box. 
The properties of the files and folders that appear in the Remote Destination Window can be viewed but not 
modified.



Properties
Displays the properties of the current file or folder. The Properties dialog box displays the file type, location, size, 
and the attributes of the selected file or folder.
You can modify the properties of a file or folder that appears in the Local Source Window of the FTP dialog box. 
The properties of the files and folders that appear in the Remote Destination Window can be viewed but not 
modified.



No related topics were found.



No topics were found.
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Editing and previewing Web pages
Corel WEB.DESIGNER's advanced HTML-authoring tools allow Web artists to add sophisticated features such as 
frames, tables, animations, and applets to their Web documents. But before you publish your pages on the World
Wide Web, you must fine tune these advanced features and preview your modifications with a Web browser. 
Editing and previewing allows you to modify your document's more subtle properties, such as the alignment, 
color, or spacing of attributes, and to create more polished, professional Web pages.
Whether you're adding simple elements such as horizontal rules, images, or hyperlinks to your Corel 
WEB.DESIGNER documents or enhancing your pages with more sophisticated features such as applets, sound, 
and video clips, you can edit the element's properties to suit your individual Web page's structure and style. But 
to view an accurate representation of your page, as it will appear to your visitors on the World Wide Web, you 
must preview your work in a Web browser.

 Notes
· You can edit the properties of almost any Corel WEB.DESIGNER element by double-clicking the element and 

modifying it’s specifications in the appropriate dialog box or by selecting the element and clicking Edit, 
Properties.

· Before you can preview your Corel WEB.DESIGNER documents on the Web, you must select a default Web 
browser by using the Set Browser command in the Tools menu. To preview your page, click Tools, Browser 
Preview.

For more information see the following:
{button ,JI(`',`Editing Web page elements')} Editing Web page elements
{button ,JI(`',`Viewing Web pages')} Viewing Web pages
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Editing Web page elements
To create a page for display on the World Wide Web, you must insert a variety of Web page elements. These can 
include images, horizontal rules, hyperlinks, forms, or tables.
You can edit the properties or change the characteristics of most HTML elements by double-clicking the element 
or by selecting it and clicking Edit, Properties. Corel WEB.DESIGNER updates the changes you make to a selected
element when you click OK or Apply in the appropriate dialog box. Click View, Refresh Window if any distortion 
occurs when you update your document or if your changes do not immediately take effect.
Refer to each Web page element for more information on editing options.

 Notes
· Many Web elements have their own properties dialog box that you can use to change the feature's appearance

and characteristics. For example, you can edit a table in your Web document by clicking Table, Table Properties
and modifying the values specified in the Table Properties dialog box.

· To view your page as it will appear on the World Wide Web, click Tools, Set Browser, and specify the folder that 
contains the executable file (.EXE) of your preferred Web browser. For all subsequent previews, click Tools, 
Browser Preview or . Corel WEB.DESIGNER automatically loads your current page in the specified browser.
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Spell checking Web pages
With Corel WEB.DESIGNER, you can spell-check Web pages to correct any spelling errors. You can also add new 
words, terms, or other items to a personal dictionary that supplements the standard Corel WEB.DESIGNER 
dictionary.

To perform a spelling check
1. Position your cursor at the top of your Web page.
2. Click Tools, Spelling Check. 

Corel WEB.DESIGNER begins to spell-check your Web page. If no errors are found, Corel WEB.DESIGNER 
displays the message "Spell Check completed. No errors found." Otherwise, it displays a dialog box that 
prompts you to specify how to resolve the spelling of suspect or misspelled words.

To correct misspelled words
1. Type a replacement term in the Replace With field.
2. Click Change or Change All.

Clicking Change replaces the current occurrence of the suspect word. Clicking Change All replaces all 
occurrences of the term on your page.

3. Continue to review suspect words. 
4. Click Close to end spell checking and return to your active Web page.

Corel WEB.DESIGNER displays a message box that indicates the results and the number of corrections made to
your work.

 Tip

· You can also can also begin to check the spelling of your Web document by clicking .
 Notes

· When Corel WEB.DESIGNER locates a word that is not in the standard or personal dictionaries, it selects the 
suspect word and generates a list of suggestions or alternative terms. You can replace a suspect word with one
of the suggested words, type a unique replacement, or ignore the error.

· If the suspect word is spelled correctly, you can click Ignore or Ignore All, or you can click Add To Personal to 
add the new word to your personal dictionary. Press ENTER to proceed without making any changes.

{button ,AL(`PRC Editing Web page elements;',0,"Defaultoverview",)} Related Topics



Viewing HTML source code
Although you usually don't view HTML tags when you use Corel WEB.DESIGNER to create your Web pages, each 
time you perform an operation you are actually creating HTML statements that can be interpreted and displayed 
by Web browsers. In fact, you can view and edit the HTML source code generated by Corel WEB.DESIGNER in the 
same way that you create and edit pages without a WYSIWYG editor. 

To view or edit the HTML code directly
1. Click View, Document Source. 

Corel WEB.DESIGNER opens the HTML Source Code window and displays the HTML statements that correspond
to the WYSIWYG view of your current Corel WEB.DESIGNER document.

2. Click Keep Changes to save your modifications and close the Edit HTML Source Code window or click Discard 
Changes to close the Edit HTML Source Code window without saving your changes.
If you choose Keep Changes, Corel WEB.DESIGNER verifies the accuracy of your code, updates your screen, 
and implements your modifications.

 Tips

· You can also view the HTML source code by clicking .
· To view the latest changes you’ve made to your HTML source code, you may need to click View, Refresh 
Window.
· If you view the document source for a Web page containing frames, the View, Document Source command 
will reference the structure of the frame layout. To view the HTML Source Code for the individual frames, click View, 
Frame Source.
· You can also click the Print Source button in the HTML Source Code window to print the source code for you
Web document.

{button ,AL(`PRC Editing Web page elements;',0,"Defaultoverview",)} Related Topics



Viewing the HTML source code for a frame
Although you usually don't view HTML tags when you create a Web page containing frames, each time you 
perform an operation you are actually creating HTML statements that can be interpreted and displayed by Web 
browsers. In fact, you can view and edit the HTML source code generated for each frame in your Corel 
WEB.DESIGNER document. 

To view or edit the HTML code for frames
1. Click to select a frame.
2. Click View, Frame Source. 

Corel WEB.DESIGNER opens the HTML Source Code window and displays the HTML statements that correspond
to the selected frame in your current Corel WEB.DESIGNER document.

2. Click Keep Changes to save your modifications and close the Edit HTML Source Code window or click Discard 
Changes to close the Edit HTML Source Code window without saving your changes.
If you choose Keep Changes, Corel WEB.DESIGNER verifies the accuracy of your code, updates your screen, 
and implements your modifications.

 Tips

· You can also view the HTML source code for the entire Corel WEB.DESIGNER document by clicking .
· To view the latest changes you’ve made to your HTML source code, you may need to click View, Refresh 
Window.
· To view the source code for the entire Web document, click View, Document Source. If you view the 
document source for a Web page containing frames, the HTML Source Code will reference only the structure of the 
frame layout. 
· You can also click the Print Source button in the HTML Source Code window to print the source code for you
Web document.
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Editing your favorite published pages
With the Corel WebMaster Suite, it's relatively easy to construct complex HTML elements and produce attractive 
Web sites. However, Corel WebMaster Suite also allows you to import and edit most pages that currently appear 
on the World Wide Web.

To open a published page in Corel WEB.DESIGNER
1. Click File, Open.
2. Enable the Open A Local Web Page button..
3. In the Path box, type the full path to the file you want to open or click the Browse button to locate the file on 

your local system.
As Corel WEB.DESIGNER loads the document into the Application window, it scans the underlying HTML Source
code for the page and presents an HTML Parser Error dialog box that lists and corrects all of the HTML coding 
errors in the file.

To open a Web page from the Internet
1. Click File, Open.
2. Enable the Open A Web Page From The Internet button.
3. Type the URL of the Web page that you want to open in the URL box. You must use the HTTP Protocol when 

opening a Web page from the Internet.
As Corel WEB.DESIGNER loads the document into the Application window, it scans the underlying HTML Source
code for the page and presents an HTML Parser Error dialog box that lists and corrects all of the HTML coding 
errors in the file.

 Notes
· To open a page from the World Wide Web, you must first save the Web page in .HTM or .HTML format. Click 

File, Save As in your browser and locate your server root folder.
· Saving files in .HTM or .HTML format from your browser window doesn’t save the images that are reference in 

those files. Instead, you must individually save each image by right-clicking the graphic in your browser 
window and choosing the Save As command from the pop-up menu. This allows you to include images from a 
variety of Web site in your final Web page.

· Although copyright policy on the Web remains vague, remember that a Web page or archive represent your 
personal presence on the Web and it should never completely replicate another Web artist’s work
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Reversing the most recent action
Like most word-processors, Corel WEB.DESIGNER allows you to undo or reverse your most recent action.

To undo your last action
· Click Edit, Undo.

 Note
· You can also press CTRL + Z to undo your most recent action.
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Redoing the most recent action
Like most word-processors, Corel WEB.DESIGNER allows you to redo your most recent action.

To redo your last action
· Click Edit, Redo.

 Note
· You can also press CTRL + SHIFT + Z to redo your most recent action.
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Viewing Web pages
Throughout the creation and publication of your Web pages, Corel WEB.DESIGNER offers you two very different 
views of your document. As you design your pages using Corel WEB.DESIGNER's menu commands and toolbars, 
you view your document in a working Application window. In the Corel WEB.DESIGNER WYSIWYG, your page 
closely resembles the published representation of your page on the World Wide Web. 
Once you have finished designing your Web page in Corel WEB.DESIGNER's Application window, you should 
preview your document in a Web browser window. Using Corel WEB.DESIGNER's Set Browser command, you can 
specify a Web browser to use as the default viewing device. 
You can also view the Document tree for your Web document to see the hierarchical structure of your Web page 
and the HTML tags that are applied to text and other objects in your current Corel WEB.DESIGNER document

 Note
· Because browsers vary in their display capabilities and functionality, you must choose a previewing device 

that will display all of the elements that you have added to your Corel WEB.DESIGNER documents. For 
example, to preview a Web page containing Java Powered applets, you should choose Netscape Navigator 3.0 
or Microsoft's Internet Explorer 3.0. To view applets using previous versions of these browsers, you must install
application plug-ins or add-ons that can translate the applet structure for display on the Web.
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Setting up a browser
Before you preview your Corel WEB.DESIGNER pages for the first time, you must specify a browser by using the 
Set Browser command in the Corel WEB.DESIGNER Tools menu. Corel WEB.DESIGNER sets your selection as the 
default for all subsequent previews. You can use the browser to preview your Web pages as you create them or 
to view pages already published on the World Wide Web.

To set up a browser
1. Click Tools, Set Browser.
2. In the Select HTML Browser dialog box, type the path leading to the folder that contains your browser's .EXE 

file or click the Browse button to locate the file on your system.
 Notes

· To launch the specified browser directly from the Corel WEB.DESIGNER Application Window, click Tools, 
Browser Preview or click .

· To change your default specification, click Tools, Set Browser and type the path to the folder that contains a
new browser.
· To view Web pages that contain embedded files such as applets or VRML, you must view your pages in 
Netscape Navigator 3.0 or Microsoft Internet Explorer 3.0. You can also download the appropriate plug-in 
applications for your browser. Netscape plug-ins are available at 
http://home.netscape.com/comprod/mirror/navcomponents_download.html. You can also go to the Netscape home 
page at http://home.netscape.com and follow the links to the plug-in page. Microsoft plug-ins are available at 
http://www.microsoft.com/ie/addons/default.htm or by following links from the Microsoft home page at 
http://www.microsoft.com.
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Testing your Web page using different browsers and screen resolutions
One of the most important steps in the Web-creation process, is to preview your Web document. Although you 
can view your Web page in the Corel WEB.DESIGNER window as you are creating it, viewing the document as it 
appears on the World Wide Web reveals exactly what your visitors will encounter when they enter your site. 
Because there are many different Web browsers and each browser supports different HTML tags, it is important 
to see how your Web page will appear to visitors who use different Web browsers. The screen resolution that 
visitors to your Web site are using to view your page can also affect the look of your Web page. To ensure that 
your page looks that best that it can on different screen resolutions and browsers, it is important to thoroughly 
test your Web page. The Select Browser dialog box allows you to test your Web page using many different Web 
browsers and screen resolutions. 

To test your Web document using different browsers and screen sizes
1. Click Tools, Set Browser
2. Choose the browser you want to use from the Browser list.
3. In the Window size section of the Select browser dialog box, enable the button next to the Screen size you 

want to use.
The selected browser launches and displays your Corel WEB.DESIGNER document in the specified screen 
resolution.

 Notes
· The Browsers list will contain all of the browsers that are located on your hard drive. 
· The browser selected in the Select Browser dialog box will now be used as the default browser. The next time 

you click the Browser Preview button, the browser defined in the Select Browser dialog box will be launched.
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Adding a new Web browser
One of the most important steps in the Web-creation process, is to preview your Web document. Because there 
are many different Web browsers and each browser supports different HTML tags, it is important to see how your
Web page will appear to visitors who use different Web browsers. The screen resolution that visitors to your Web 
site are using to view your page can also affect the look of your Web page. 
Because it is important to view your Web document on many different Web browsers, Corel WEB.DESIGNER 
makes it easily for you to add another Web browser to the Browser list in the Select Browser dialog box. 

To add a new Web browser
1. Click Tools, Set Browser.
2. In the Select Browser dialog box, click the Add button.
3. Type the path for the new Web browser in the Path For HTML Browser box or click the Browse button to locate 

the file on your system.
The Browser list will be updated to include the new Web browser.

 Notes
· The browser selected in the Select Browser dialog box will be used as the default Web browser. The next time 

you click the Browser Preview button, the browser defined in the Select Browser dialog box will be launched.
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Viewing your Web pages in a Web browser
Previewing your Web page is an essential step in the creation of a document for publication on the World Wide 
Web. Corel WEB.DESIGNER is a WYSIWYG web-authoring tool that allows you to view your document as you 
create it. However, when you view your Web page in a browser you see your page exactly as it will be seen by 
the visitors to your site. Viewing your Web page in a Web browser will allow you to discover any changes that 
may appear when your document is published on the Web.

To view your Corel WEB.DESIGNER page from a browser window

· Click Tools, Browser Preview or click  to open your current document in a browser window.
 Notes

· The first time you select the Browser Preview command, you must specify the location of your browser's .EXE 
file in the Select Browser dialog box. To access the Select Browser dialog box, click Tools, Set Browser.

· You can change the default browser setting by clicking the Browse button on the Select HTML Browser dialog 
box and locating the executable file (.EXE) of another Web browser.

· Avoid running multiple copies of your Web browser by closing the application each time you preview your Web 
page. If you choose to leave your browser open, simply save your file in Corel WEB.DESIGNER and press the 
Reload button on your browser's toolbar to display the most recent version of your Web page.



Estimating the download time for your Web page
Corel WEB.DESIGNER contains a Page Performance Indicator that will estimate the amount of time that a user 
will require to download your Web page. The Page Performance Indicator can be found on the Status Bar. This 
indicator is a dynamic feature that will change immediately as changes are made to your Web document. For 
example, if you add a graphic to your Web page, the Page Performance indicator will update automatically to 
account for the longer download time. In order for the Page Performance Indicator to work properly, you must 
indicate the speed of modem for which you want to know the download time.

To indicate the speed of modem for the Page Performance Indicator
1. Click Tools, Options.
2. In the Page Load Performance section of the Options dialog box, select the speed of modem for which you 

want to find the download time. 
 Notes

· The Status Bar command must be enabled in the View menu for the Page Performance Indicator to appear.
· You may want to test your Web page using different modem speeds to make sure that your page doesn’t take 

too long for people with slower modems to download. You may want to remove graphics or animations if your 
page will be very slow.
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Opening a new document window
The Corel WEB.DESIGNER New Window command makes working with Web pages easy. The New Window option 
creates and opens multiple windows to allow you to edit numerous Web pages simultaneously. This feature is 
useful if you are editing or updating long Web pages or it you want to copy and paste test and images between 
Web pages.

To open a new document window
1. Click View, New Window.

Corel WEB.DESIGNER opens a new, untitled window. 
2. Click File, Open to open an exiting HTML document or open a Web page from the Internet.
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Viewing the Document Tree
The Document Tree displays the hierarchical structure of your Web page and the HTML tags that are applied to 
text and other objects in your current Corel WEB.DESIGNER document. The text affected by the HTML code 
appears between the opening and closing HTML container tags, e.g., <P>text</P>.
You can expand or collapse the display of embedded tags on a Web page by clicking the  or 
 key next to the HTML code.

Indicates that you can expand the display to show additional text, objects, and HTML tags.
Indicates that all embedded tags are displayed.

To view the Document Tree
· Click View, Document Tree.

 Notes

· You can also view the Document tree by clicking 
· The Document Tree dialog box displays a read-only view of your Corel WEB.DESIGNER document. You 
cannot edit or modify your Web pages in the Document Tree.
· Image maps are not explicitly referenced in the Document Tree dialog box. Instead, you will see an <A 
HREF> reference to the .MAP file you created, along with the image source, below the opening HTML <BODY> tag. 
If you insert an .HTML file that contains an image map, into your current document, Corel WEB.DESIGNER 
references the image-map file outside of the </HTML> tag at the bottom of the Document Tree dialog box.
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Designing forms
Corel WEB.DESIGNER allows you to create online forms for a variety of purposes. You can create forms to allow 
visitors to comment on your Web page, purchase a product online, or answer a questionnaire. 
To construct a working form, you need two basic elements, the form and CGI scripts. The form itself is 
constructed using HTML tags and can consist of several different elements such as text fields, radio buttons, 
check boxes, list buttons, and regular buttons. The second necessary element when creating a form is the script 
or program. This program must be constructed in accordance with the common gateway interface (CGI) 
specification if it is to communicate properly with your server and your user's Web client. The CGI script is the 
engine behind the interface that actually acts on the data that the user types into the form. 

 Note
· When visitors to your Web site submit a form, the data is sent to your server. From there, CGI scripts 

determine how the data is handled. For more information on creating and using CGI scripts, consult your 
Webmaster.

For more information see the following:
{button ,JI(`',`Getting started with forms')} Getting started with forms



Getting started with forms



Getting started with forms
Corel WEB.DESIGNER contains simple and easy to use form features that will enable you to design feedback 
forms, questionnaires, surveys, or purchase orders you can publish on the Web. Corel WEB.DESIGNER allows you 
to create and customize virtually any form style by using text fields, radio buttons, check boxes, and other 
advanced form elements. The Forms toolbar in Corel WEB.DESIGNER contains all of the items necessary to help 
you quickly build forms for your Web pages. 

 Note
· When visitors to your Web site submit a form, the data is sent to your server. From there, CGI scripts 

determine how the data is handled. For more information on creating and using CGI scripts, consult your 
Webmaster.



Creating a new form
Corel WEB.DESIGNER allows you to design feedback forms, questionnaires, surveys, or purchase orders you can 
publish on the Web. However, for your form to work properly you must specify the URL of a CGI script that will 
process your form's data and provide the appropriate responses.

To create a new form
1. Position your cursor at the point in your Web page where you want to insert a form.
2. Click Insert, Form. 

Corel WEB.DESIGNER displays the Form Action Handler dialog box.
3. Type the URL of a CGI script or click Browse to specify the CGI Script that will process the form's input. 

Corel WEB.DESIGNER displays a rectangular region that is defined by a red dashed line. In this rectangle, you 
can add form elements and structure the layout of your form.

 Tip

· You can also create a form by clicking .
 Note

· Even if you do not know the location of the CGI script or do not have a CGI script, you can still design forms 
using Corel WEB.DESIGNER. Simply click OK in the Form Action Handler dialog box and consult your 
Webmaster prior to placing your pages on a server. The form will not function until you specify an appropriate 
CGI script.
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Adding elements to a form
With Corel WEB.DESIGNER’s Form menu commands and toolbar options, you can easily add new elements to 
your online forms. The form menu and toolbar contains commands to enable you to add text fields, buttons, 
check boxes, radio buttons, and list/menu boxes to your Corel WEB.DESIGNER form.

To add form elements
1. Position your cursor inside the form border.

2. Click a form-element button on the Forms toolbar. For example, click  to add a text field to your form.
3. Type introductory text beside each form element to prompt your visitors to fill in the appropriate 
information.
4. Double-click the form element.

Corel WEB.DESIGNER opens the corresponding Properties dialog box.
5. Set the element's attributes.

 Notes
· If you double-click the form border, Corel WEB.DESIGNER displays the Form Properties dialog box which allows 

you to specify a CGI script in the Form Action Handler dialog box.
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Editing form elements
After you have added the necessary buttons, list boxes, and check boxes to your form, you will need to edit the 
properties of each of these items. The properties dialog box enables you to change the label, name, initial state, 
type, contents, and size of the form element. 

To edit the form elements
1. Double-click the form element in the form border.
2. In the corresponding Properties dialog box, change the settings for that element. 

 Notes
· To configure the labels on the Submit and Reset buttons, double-click the button, specify a Button Label and 

enable the appropriate button in the Type section to submit the form contents to URL or to reset the form with 
default values.

· If you double-click the form border, Corel WEB.DESIGNER displays the Form Properties dialog box which allows 
you to specify a CGI script in the Form Action Handler dialog box.
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CGI Scripting
The Common Gateway Interface (CGI) is responsible for most of the more complex movements and interactions 
that occur in World Wide Web forms. The CGI communicates with programs on other computers. CGI scripts allow
Web browsers to run programs without the help of external applications. With CGI scripts, you can scan 
databases, sort names, send mail, or perform almost any other interactive function.
With standard HTML pages, you access a link to a URL and instruct your browser to read, interpret, and display 
information contained on another Web site. With hyperlinks, clients direct their browsers to a specific screen of 
information. But with CGI scripts, an information provider serves up different documents depending on the 
client's request. More importantly, the CGI allows the program or script to create new documents when the 
clients make their requests.
Forms are one of the most popular uses for CGI on the Web because they allow advanced interaction and 
information exchanges in an active environment. Like most other Web editors, Corel WEB.DESIGNER supports 
HTML form tags but does not generate CGI scripts. This means that you can use Corel WEB.DESIGNER to 
construct forms for your Web pages but until you specify a CGI script in the Form Action Handler dialog box, your
forms will remain static. Before you can publish pages that return requested data, respond to user input, or log 
access, you must specify the CGI program that will control your form's operations. For more information on CGI 
scripting, contact your Webmaster or service provider.
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Transferring files using FTP
File Transfer Protocol (FTP) is one of the most efficient ways to exchange files between two computing systems. 
With the development of the World Wide Web, external FTP applications provided Web artists with a way to 
transfer completed .HTML files to a server for publication to global audiences. Now, you can design interactive 
Web documents and transfer them directly to your server or your service provider's remote system using Corel 
WEB.DESIGNER's sophisticated FTP feature.
Essentially, FTP allows you to exchange files and folders with remote computers. With Corel WEB.DESIGNER's FTP
feature you can upload files from your local hard drive to a remote system or you can download files from the 
remote system to your local hard drive. To navigate freely between the drives and directories on both the local 
and remote systems, you must have accounts on both computers. You can gain limited access to files and folders
on remote systems with anonymous FTP.

For more information see the following:
{button ,JI(`',`Introduction to FTP')} Introduction to FTP
{button ,JI(`',`Uploading and downloading files')} Uploading and downloading files
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Introduction to FTP
There are two ways to use File Transfer Protocol (FTP) to transfer files: standard FTP and anonymous FTP. With 
standard FTP, you must have accounts on both the local and the remote systems you want to access. After you 
log in to the remote computer using the appropriate login name and password, you have access to the files and 
folders on that system. With anonymous FTP, you do not require an account on the remote system. Instead, you 
can log in to the external machine using "anonymous" as your login name and your email address as the 
password. Anonymous FTP restricts your access to the public directory (PUB) on the remote computer.
Standard FTP is popular among large networked corporations where different members or teams must have 
access to the same files or projects. In this case, FTP allows individuals to access files from a common server. 
Anonymous FTP is a popular way to exchange information with mass audiences and often acts as an information 
resource for newsgroups, mailing lists, and gopher sites.
With Corel WEB.DESIGNER, FTP is often the most efficient way to transfer the .HTML files that you create using 
WEB.DESIGNER's advanced authoring tools to your server or service provider for publication on the World Wide 
Web.

 Note
· You can publish your Corel WEB.DESIGNER documents on the Web immediately by using Corel 

WEB.DESIGNER's Instant Publishing wizard.
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What is File Transfer Protocol (FTP)?
File Transfer Protocol, better known as FTP, is one of the most basic operations on the Internet. Essentially, FTP 
allows you to exchange files with another remote computer. To use FTP in its fullest capacity, you need access to 
both the local and remote machines. Then, you simply launch your FTP application and choose the source files 
and destination folders.
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Uploading and downloading files
File Transfer Protocol (FTP) is a file-transfer system that allows you to upload your local files to a remote 
computer or to download remote files to your local system. In either case, you must set up the remote 
destination and log in to the external system before you exchange files.
To have full access to the files and folders on both a local and a remote computer, you must have accounts on 
each system. After you have logged in to your local system, you can access the Corel WEB.DESIGNER FTP 
feature and log in to the remote destination for your FTP operations. If you use anonymous FTP to access a 
remote system, your access will be restricted to the public (PUB) directory on that system.
Uploading files is especially useful for transferring the .HTML files that you create in Corel WEB.DESIGNER to your
service provider. Using Corel WEB.DESIGNER's FTP feature, you can move your completed Web documents to the
appropriate directories on your server or on your service provider's system to make them available to a global 
audience on the World Wide Web.
Downloading files using FTP is one of the most popular ways to collect information on the Internet. Using Corel 
WEB.DESIGNER's FTP feature, you can download the .HTML files that you've transferred to your service provider 
and update them on your local server. 
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Logging on to a server
Before you can upload or download files using Corel WEB.DESIGNER's FTP feature, you must identify, in the FTP 
Site Properties dialog box, the remote server with which that you want to exchange files. The next time you 
launch the FTP application from Corel WEB.DESIGNER's File menu, you can choose the remote server from the 
FTP Site list box in the Remote Destination section of the FTP Upload dialog box. You can edit a remote server's 
properties by clicking Setup and modifying the specifications listed in the FTP Site Properties dialog box.

To connect to a remote computer
1. Click File, FTP.

Corel WEB.DESIGNER opens the FTP Upload dialog box and loads your system files and folders in the Local 
Source window.

2. Click the Setup button in the Remote Destination window.
3. In the FTP Site Properties dialog box, type a name that identifies the remote computer in the Description list 

box.
4. Type the FTP address of the remote system in the FTP Site box.
5. Type the login name for your remote account in the User Name box.
6. Type the password for your remote account in the Password box.

 Notes
· If you do not have an account on the remote computer that you want to exchange files with, you can log in 

using anonymous FTP.
· You can edit the properties of an FTP site by choosing the remote computer's name from the Description list 

box in the FTP Site Properties dialog box and modifying the properties in the FTP Site, User Name, and 
Password boxes.
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Uploading local files
You can upload files and folders stored on your local system to a remote computer using Corel WEB.DESIGNER's 
FTP feature. However, before you can transfer files using FTP, you must save the files locally and set up their 
remote destination in the FTP Site Properties dialog box. You can verify your FTP status during the uploading 
process by consulting the FTP Status list box.

To upload local files
1. Click File, FTP.

Corel WEB.DESIGNER opens the FTP Upload dialog box and loads your system files and folders in the Local 
Source window.

2. Choose a remote destination from the FTP Site list box in the Remote Destination window.
3. Browse through the drives and folders on your local system and select the files or folders that you want to 

upload.
4. Browse through the drives and folders on the remote system and locate a destination folder for your selected 

files.
5. Click Upload.

 Notes
· You can also drag and drop files or folders between the Local Source Window and the Remote Destination 

window or right-click the file or folder in the Local Source Window and choose Upload from the menu.
· If you do not have a Web site service provider or you do not want to set up your own server, you can publish 

your completed Corel WEB.DESIGNER documents to PageDepot using Microcraft's Instant Publishing Wizard. To
access the Instant Publishing Wizard, click File, Publish To Internet in Corel WEB.DESIGNER.

· Click  to refresh the listings in the Local Source and Remote Destination windows.
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Downloading files from a remote location
You can download files and folders from a remote computer to your local system using Corel WEB.DESIGNER's 
FTP feature. However, before you can transfer files using FTP you must set up the remote location in the FTP Site
Properties dialog box. You can verify your FTP status during the downloading process by consulting the FTP 
Status list box.

To download files from a remote location
1. Click File, FTP.

WEB.DESIGNER opens the FTP Upload dialog box and loads your system files and folders in the Local Source 
window.

2. Choose a remote destination from the FTP Site list box in the Remote Destination window.
3. Browse through the drives and folders on the remote system and select the files or folders that you want to 

download.
4. Browse through the drives and folders on your local system and locate a destination folder for your selected 

files or folders.
5.  Click Download.

 Notes
· You can also drag and drop files or folders between the Local Source Window and the Remote Destination 

window right-click the file or folder in the Remote Destination Window and choose Download from the menu.
· If you do not have a service provider or if you want to display your documents on the Web immediately, you 

can publish your completed Corel WEB.DESIGNER documents to PageDepot using Microcraft's Instant 
Publishing Wizard. To access the Instant Publishing Wizard, click File, Publish To Internet in Corel 
WEB.DESIGNER.

· Click  to refresh the listings in the Local Source and Remote Destination windows.
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To change the file properties in the FTP dialog box
Before transferring files and folders using FTP, you may want to change the properties of the files you are 
sending. It is possible to change the file properties inside the FTP dialog box. The Properties dialog box displays 
the properties of the current file or folder including the file type, location, size, and attributes.

To change the file properties
1. Right-click a file or folder in the Local Source Window of the FTP dialog box . 
2. Choose Properties from the menu.
3. In the Attributes section of the Properties dialog box, set the Properties of the file or folder to Read-only, 

Hidden, or Archive. 
 Note

· You can modify the properties of a file or folder that appears in the Local window of the FTP dialog box. The 
properties of the files and folders that appear in the Remote Destination Window can be viewed but not 
modified.

{button ,AL(`PRC Uploading and downloading files;',0,"Defaultoverview",)} Related Topics





Managing images and image 
attributes



Managing images and image attributes
Web authors use images extensively in their published Web pages to provide both information and decoration. 
Web page images must be in either .GIF (Graphics Interchange Format) or .JPG (Joint Photographic Expert Group) 
format. Corel WEB.DESIGNER automatically converts three other file formats (.TGA, .BMP, and .PCX) to .GIF 
or .JPG file format when you add them to your Web pages. 
Corel WEB.DESIGNER contains many tools to enable you to add images to your Web pages. You can easily import
images, insert images into your Web page, and create and edit image maps for those images. Image Maps are 
images that contain one or more hyperlink areas called hotspots. A well-designed image map gives your users 
visual cues about where each image map will take them. For example, an image map for a bookstore could 
include pictures of Bestsellers. When a visitor to this site clicks on a particular book, the user could follow a 
hyperlink to an overview of that book and reviews by other readers.

For more information see the following:
{button ,JI(`',`Adding images')} Adding images
{button ,JI(`',`Designing image maps')} Designing image maps
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Adding images
When you design and create a Web page, it is important that you make your page informative and visually 
appealing. By using Corel WEB.DESIGNER, you can easily combine visual elements and text to form a dynamic 
Web page. Adding graphics to your Web document is an easy way to make your page more interesting for your 
users. Corel WEB.DESIGNER handles two graphic file formats directly: .JPG and .GIF. Three other file formats 
(.TGA, .BMP, and .PCX) are automatically converted to .GIF or .JPG file format when you add them to your Web 
pages.

 Tips
Here are a few points that you should keep in mind when you add images to your Web page. 
· Graphics are much more meaningful when they relate to the text contained in your Web page.
· Keep your images files a reasonably small size so that a person with a slower modem connection doesn't have 

a long wait to see your Web page. The status bar at the bottom of the Application Window in Corel 
WEB.DESIGNER contains a Page Performance Indicator that will allow you to keep track of how long it will take 
a visitor to download your Web page. 
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Inserting graphics
One way to make your site more attractive and functional is to include graphic images. Corel WEB.DESIGNER 
handles two graphic file formats directly: JPG and .GIF. Three other file formats (.TGA, .BMP, and .PCX) are 
automatically converted to .GIF or .JPG file format when you add them to your Web pages.

To insert images in a Web page
1. Position your cursor at the point on your Web page where you want to insert an image.
2. Click Insert, Image.
3. In the Image Properties dialog box, click the Browse button beside the Image Source field.

WEB.DESIGNER opens your server root folder in the Select Image Source dialog box.
4. Select an image file and click Open.

Corel WEB.DESIGNER updates your Web page and displays the new image file.
 Tip

· You can also insert an image by clicking .
 Notes

· You can also insert animated .GIFs by using the Insert, Images command.
· Double-clicking an image gives you access to Corel WEB.DESIGNER's image map feature.
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Creating hyperlinked images
After you add an image to your Corel WEB.DESIGNER document, you can add a URL to that image to allow a user
can click the image and jump to another Web page. These hyperlinked images are called inline images.

To add a hyperlinked image
1. Click the image in the Corel WEB.DESIGNER Application Window to highlight the image.
2. Click Format, Hyperlink.

Corel WEB.DESIGNER opens the Hyperlink Properties dialog box.
3. In the Link To URL tab, type the URL of the hyperlink or click the Browse button to make a hyperlink to a file on

your local system. You must specify the HTTP protocol for the hyperlink to work.

To remove the hyperlink from an image
1. Click the inline image in your Corel WEB.DESIGNER Application Window to highlight the image.
2. Click Format, Hyperlink.
3. Click Yes to remove the hyperlink properties from the current selection.

 Notes
· It is recommended that you launch your Web browser and test that your hyperlinked image works correctly.
· When you launch your Web browser to preview your Web page, the hyperlinked image will appear exactly as it

did in the original document. When you move your cursor over the image, the cursor will change to a hand. 
Click the image to jump to the page specified in the URL box.
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Adding animated GIFs to your Web pages
The tight integration of the applications in the Corel WebMaster Suite allows you to quickly and easily add 
animated .GIFs created in Corel WEB.MOVE to your Corel WEB.DESIGNER documents. Simply launch Corel 
WEB.MOVE from within Corel WEB.DESIGNER and create the animated .GIF file. Then use Corel WEB.DESIGNER's 
Insert, Image command to add the animated GIF to your Web page.

To add animated .GIFs to your Web pages
1. Click the point in your Corel WEB.DESIGNER document where you want to add an animated .GIF.
2. Click Tools, Corel WEB.MOVE.
3. Create the animated .GIF file using Corel WEB.MOVE's menu commands and toolbar options. Refer to the Corel

WEB.MOVE online Help system for assistance when creating your animated .GIF.
4. Save the animated .GIF and close Corel WEB.MOVE.
5. In Corel WEB.DESIGNER, click Insert, Image.
6. Click Browse in the Image Properties dialog box to locate the animated .GIF that you just created.

 Note
· You can also add animated .GIFs found in Corel WEB.GALLEY to your Corel WEB.DESIGNER Web page by 

dragging and dropping the image from the Corel WEB.GALLERY album directly into Corel WEB.DESIGNER.
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Designing image maps
An image map is an image that is divided into regions that are each associated with a URL. When you click a 
region in the image, you access the file referred to by its associated URL. An image map is also called a clickable 
image map. Corel WEB.DESIGNER handles image maps in two ways: server-side and client-side. Server-side 
image maps require an external image map file that defines the regions in the image and assigns them to URLs. 
Client-side image maps accomplish the same thing by using special elements that are embedded in the 
document itself.
A well-designed image map gives your users visual cues about where each image map will take them. For 
example, an image map for a company could include pictures of their products. When a visitor to the site clicks 
on a particular product, the user could follow a hyperlink to a detailed description of the product and to a list of 
the stores that sell the product.

 Note
· Server-side image maps are NCSAcompliant.
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Creating image maps
Using Corel WEB.DESIGNER, you can create an image-map file that projects multiple hyperlinks on different 
regions of an image. When you click on a mapped region of an image in a browser window, you jump to the 
hyperlinked Web page that has been specified for that area. Corel WEB.DESIGNER handles image maps in two 
ways:
· the image map is embedded in your Web document, to allow client-side image mapping.
· an image map file is created for the server, to allow server-side image mapping.

To create an image map file
1. Double-click the image in the Corel WEB.DESIGNER Application window.
2. In the Image Properties dialog box, click the Image Map tab.
3. Enable the Use Image Map check box. 
4. Click Create Map.

Corel WEB.DESIGNER displays the Image Map Editor window, which allows you to specify regions of your 
image, define hyperlinks, and type a corresponding Target URL for each hyperlinked area.

To edit an existing image map
1. Double-click the image in the Corel WEB.DESIGNER Application window.
2. In the Image Properties dialog box, click the Image Map tab.
3. Click Edit Map. 

Corel WEB.DESIGNER displays the Image Map Editor window, which allows you to edit regions of your image, 
redefine hyperlinks, and type corresponding Target URLs for each hyperlinked area.

 Notes

· You can also select an image and click  to go directly to the Image Map Editor to edit or create a new 
image map file.

· Server-side image maps are NCSAcompliant.
· Image maps are not explicitly referenced in the document-tree structure. Instead, you will see an <A 
HREF> reference to the map file you created, along with the image source beneath the opening <BODY> tag. If you
insert an .HTML file that contains an image map into your current Web document, Corel WEB.DESIGNER references 
the image map file outside of the </HTML> tag at the bottom of the document-tree structure.
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Adding image map hyperlinks
After you have loaded an image in the image map editor, you must define hyperlinked regions on the image and 
specify destination URLs for the links. For more information about hyperlinks and URLs, see the Creating 
hyperlinks section of the Corel WEB.DESIGNER online Help system.

To define a new hyperlink area for your image-map file

1. Click .
2. In the Image Map Editor, click the map tool that corresponds to the shape of the hyperlinked region that 
you want to define.
2. Define a hyperlinked region.
3. Type the destination URL in the Target URL field or click Browse and navigate to the target file.
4. Repeat steps 1 to 3 to specify hyperlink Target URLs for all the regions of your image file.
5. Click Save.
6. In the Save Image Map dialog box, type a name for the image map in the File Name box and specify a 
folder in which to save the image-map file.

Corel WEB.DESIGNER saves the hyperlink target URL information in a .MAP file for server-side image maps. 
Client-side image maps are created at the same time.

 Notes
· To remove a rectangle, circle, or polygon from your image map file, select the element and press DELETE.
· To see your latest changes, you may need to click View, Refresh Window.
· Image maps are not explicitly referenced in the document-tree structure. Instead, you will see an <A HREF> 

reference to the map file you created, along with the image source beneath the opening <BODY> tag. If you 
insert an .HTML file that contains an image map into your current Web document, Corel WEB.DESIGNER 
references the image map file outside of the </HTML> tag at the bottom of the document-tree.
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Defining the shape of an image map
Corel WEB.DESIGNER provides you with three different tools to define image map regions of different shapes. You
can draw circular, rectangular, or polygonal image maps. 

To draw a circular image map

1. Click .
2. In the Image Map Editor, click the Circle tool.
3. Click and drag to draw the circle.

To draw a rectangular image map

1. Click .
2. In the Image Map Editor, click the Rectangle tool.
3. Click and drag to draw the rectangle.

To draw a polygonal image map

1. Click .
2. In the Image Map Editor, click the Polygon tool.
3. Click and drag to draw the polygon.
4. Double-click to close the polygon.
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Integrating advanced elements
The popularity of the World Wide Web is primarily due to the wealth of information that can be displayed in HTML
format. Whether you are an amateur Web page designer or a professional Web artist, you can add external HTML
pages, audio files, video clips, Java Powered applets, animations, VRML, CGI scripts, and even ActiveX objects to 
your documents and display them to global audiences. The Corel WebMaster Suite of applications promotes the 
flexibility of the World Wide Web by allowing you to integrate advanced elements created in Corel WEB.MOVE, 
Corel WEB.DRAW, Corel WEB.WORLD, Corel WEB.GALLERY, Corel WEB.DATA, and Corel WEB.PhotoPaint.
The tight integration of the applications included in the Corel WebMaster Suite allows you to launch any of the 
programs in the suite from within Corel WEB.DESIGNER. After you have opened the program, you have access to 
all of its menu commands and features. When you have completed your operations, you can publish your file 
back to Corel WEB.DESIGNER for display in your Web page.

For more information see the following:
{button ,JI(`',`Combining elements in Corel WEBDESIGNER')} Combining elements in Corel WEB.DESIGNER
{button ,JI(`',`Adding sound')} Adding sound
{button ,JI(`',`Adding ActiveX controls')} Adding ActiveX controls
{button ,JI(`',`Adding CGI scripts')} Adding CGI scripts
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Combining elements in Corel WEB.DESIGNER
Corel WEB.DESIGNER's advanced integration commands allow you to combine multiple file types in your Web 
pages. With Corel WEB.DESIGNER's Insert menu, you can add other .HTML files, ActiveX components, Java 
Powered applets, CGI scripts, or even HTML files that contain applets to your current Web document. Corel 
WEB.DESIGNER's Embedded File command allows you to insert multimedia objects, such as audio, video, VRML, 
or any other file type, that can be viewed directly in your browser or with the help of a plug-in application.
Although Corel WEB.DESIGNER gives you the capability to enhance your pages with multiple advanced elements,
it's important to consider your audience's viewing capabilities when you integrate elements. Many high-end 
features, including ActiveX objects and Java Powered applets can only be accessed with advanced Web browsers 
or with the help of plug-in applications. 

 Note
· The Netscape Navigator 3.0 Web browser is included in the Corel WebMaster Suite of applications. Netscape 

Navigator 3.0 allows you to view Java Powered applets, VRML, and other advanced elements without the help 
of add-ons or plug-ins.
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Merging HTML files
Using Corel WEB.DESIGNER's Insert, HTML File command, you can merge existing .HTML files with your current 
Web pages. The Insert, HTML File command also merges .HTML files that contain Java Powered applets. This 
provides an alternative to the Insert, Applet command. When you merge a file, Corel WEB.DESIGNER inserts the 
content at your current cursor position.

To merge HTML files
1. Click Insert, HTML File.
2. In the Select File dialog box, locate the .HTML file that you want to add to your Corel WEB.DESIGNER page.
3. Click Open.
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Inserting Java Powered applets
Corel WEB.DESIGNER allows you to add Java Powered applets to your Web pages by using the Insert, Applet 
command. You can also add Java Powered applets that are contained in .HTML files to your Corel WEB.DESIGNER 
pages by clicking Insert, HTML File. The entire .HTML file and its contents are merged with your current Corel 
WEB.DESIGNER document.

To insert Java Powered applets
1. Click Insert, Applet.
2. In the Applet Properties dialog box, click the Browse button.
3. In the Select Class File dialog box, select the applet's .CLASS file.
4. Click Open.
5. Specify values for each of the properties listed in the Applet Properties dialog box to control the appearance of 

the applet on your Corel WEB.DESIGNER page.

{button ,AL(`PRC Combining elements in Corel WEBDESIGNER;',0,"Defaultoverview",)} Related 
Topics



Embedding files
Embedding allows you to insert files of all types into your Web documents. These files can include audio, video, 
VRML, and any other objects that can be viewed directly in your Web browser or with the help of a plug-in 
application. The Embedding File command can be used to insert external files that you have stored on your local 
system, but should not be used to insert standard HTML elements such as .GIF and .JPG files, which should be 
added to Corel WEB.DESIGNER documents with the Insert Image command, or to insert .HTML files, which are 
best integrated using the Insert, HTML File command.

To embed files
1. Position your cursor at the point in your Corel WEB.DESIGNER page where you want to embed a file.
2. Click Insert, Embedded File.
3. Type the name of the folder Embedded File text box or click Browse to locate the file on your local system.
4. Set the embedded file's spacing, alignment, and scaling values in the Embedded File Properties dialog box.
When you embed files in your HTML document, Corel WEB.DESIGNER inserts a system icon that represents the 
type of file that you embedded. To see how your browser will display the embedded file, preview your Web page 
using the Tools, Browser Preview command. The appearance of embedded files on the Web varies according to 
the type of browser that you use to access the file.

 Note
· Publishing a file to Corel WEB.DESIGNER from one of the other Corel WebMaster Suite applications 

automatically embeds the file in your current Corel WEB.DESIGNER document. For example, if you have 
created a .WRL file using Corel WEB.WORLD, clicking File, Publish To Corel WEB.DESIGNER embeds the .WRL 
file directly into your current Web page. 
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Adding sound
With Corel WEB.DESIGNER, you can enhance your Web pages with background sounds that play automatically 
when your site is accessed by a Web browser. You can also add sound files to your Web pages by embedding or 
linking to external audio files.
Although you can embed and link to sound files using Corel WEB.DESIGNER's advanced integration features, 
playing the sound files on the Web depends on the individual system components of the visitors that access your
page. Web browsers vary in functionality and although some visitors to your site may be able to play background
sound automatically, others may have to access the page using an alternate Web browser to play the audio clip.
Sound files that have been added using Corel WEB.DESIGNER's background sound feature can only be played 
using Microsoft's Internet Explorer on systems that support the specified file type. The <BGSOUND> tag 
supports Wave (.WAV), Aiff (.AIF, .AIFC, .AIFF), Au (.AU), and Midi (.MID) files. 
Embedded sound can be played by both Internet Explorer 3.0 and Netscape Navigator 3.0 users.
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Adding background sound
With Corel WEB.DESIGNER you can create musical Web pages by adding a sound file to the Background Sound 
section of the Page Properties dialog box. Sound files that have been added using Corel WEB.DESIGNER's 
background sound feature can only be played using Microsoft's Internet Explorer on systems that support the 
specified file type. The <BGSOUND> tag supports Wave (.WAV), Aiff (.AIF, .AIFC, .AIFF), Au (.AU), and Midi (.MID) 
files. 
If you want to include background sound to your Netscape Navigator Web page, you can embed a sound file that 
will play in the background.

To add background sound to your Microsoft Internet Explorer Web page
1. Save the sound file that you've chosen for your Web page in your server root directory with your .HTML file.
2. Click File, Page Properties.
3. Click the Browse button next to the Background Sound text box in the Page Properties dialog box.
4. In the Select A Sound File dialog box, locate the sound file in your server root folder and click Open.

Corel WEB.DESIGNER inserts the file in the Background Sound text field of the Page Properties dialog box.
5. Type a value in the Loop box or enable the Infinite check box.

The Loop value determines the number of times that the sound file plays when a visitor accesses your Web 
page. If you enable the Infinite check box, the sound file plays continuously while your Web page is active.

To add background sound to your Netscape Navigator Web page
1. Click Insert, Embedded File.
3. In the Embedded File Properties dialog box, click the Browse button to locate the sound file (.AU, .WAV, .MIDI, 

etc.) that you want to play in the background.
4. Click OK to accept the file and close the dialog box.
5. Click View, Document Source and locate the line in the HTML source code that corresponds to the embedded 

sound file. The source code for the embedded sound file will look something like this:
<EMBED SRC="Myfile.wav" WIDTH="145" HEIGHT "60">

6. Edit the line in the HTML source code corresponding to the embedded sound follow as follows:
<EMBED SRC="Myfile.wav" HIDDEN="true" AUTOSTART="true" LOOP="n" WIDTH="145" HEIGHT "60">
The HIDDEN attribute will hide the control when your Web page is displayed in Netscape and the AUTOSTART 
attribute will play the sound when your Web page is loaded. The LOOP attribute specifies the number of times 
to play the embedded sound file "n" number of times (set "n" to the desired number. A value of -1 will play 
loop the sound continuously)

7. Click Keep Changes to save the changes and exit the HTML Source Code window.
 Notes

· You embedded sound file control will be displayed in your Corel WEB.DESIGNER document to enable you to 
edit the control.

· A plug-in may be required to play the embedded sound file in Netscape Navigator.
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Embedding sound files
With Corel WEB.DESIGNER, you can embed any file, including sound files, in your Web pages using the 
Embedded File command. Corel WEB.DESIGNER adds an audio playing device to your document that you can 
resize and adjust to suit your page's structure and content. You can embed any type of sound file in your Corel 
WEB.DESIGNER documents, but playing sound files depends on individual system components. Embedded sound
can be played by both Internet Explorer 3.0 and Netscape Navigator 3.0 users.

To embed sound files in your Corel WEB.DESIGNER document
1. Save the sound file that you've chosen for your Web page in your server root folder that contains your .HTML 

file.
2. Click Insert, Embedded File.
3. In the Embedded File dialog box, click the Browse button.

Corel WEB.DESIGNER opens your server root folder in the Select File dialog box.
4. Select the sound file and click Open.

Corel WEB.DESIGNER returns to the Embedded File dialog box.
5. Adjust the spacing, alignment, or scaling of your embedded file.

Corel WEB.DESIGNER inserts the sound file in your Web page.
 Tip

· To play a sound file, you must have an audio player. If a visitor to your site clicks a hyperlink to a sound file but
does not have the appropriate audio player installed on their system, they can save the sound file until they 
obtain the appropriate playing device.
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Linking to sound files
With Corel WEB.DESIGNER, you can create standard hyperlinks that lead to sound files in your Web pages. 
Simply format text or objects as hyperlinks and specify the location of the sound file in the Hyperlink Properties 
dialog box. You can link to any type of sound file, but playing sound files depends on individual system 
components.

To create a link to a sound file
1. Save the sound file that you've chosen for your Web page in your server root folder that contains your .HTML 

file.
2. Select the text or image that your visitors will click to play the sound file.
3. Click Format, Hyperlink. 
4. Click the Browse button in the Hyperlink Properties dialog box.
5. Select the sound file in your server root folder.

 Tips

· You can also create a hyperlink by clicking .
· To play sound file, you must have an audio player. If a visitor to your site clicks a hyperlink to a sound file 
but does not have the appropriate audio player installed on their system, the can save the sound file unit they 
obtain the appropriate playing device.
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Adding ActiveX controls
ActiveX is a set of technologies, designed by Microsoft Inc., that allow Web designers to add interactive 
components to their Web pages. ActiveX controls are the objects that you can add to your Web pages to create 
these interactive, user-controlled components. ActiveX controls can be inserted into a Web page to provide 
functionality that is not directly available in HTML, such as credit-card transactions and spreadsheet calculations.

 Note
· A plug-in is needed to view ActiveX controls in Netscape Navigator. You can download an ActiveX plug-in from 

http:/www.ncompasslabs.com.
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To insert an ActiveX control
ActiveX controls can be used to provide functionality to your Web page that is not directly available in HTML. Use
ActiveX controls to add items such as credit-card calculations and spreadsheet calculations.

To insert an ActiveX control
1. Click Insert, ActiveX.
2. Choose a control from the Control list box.
3. Enter the Name, Alternative Text, Data Source, and Code Source for the ActiveX control in the ActiveX Control 

Tags dialog box.
4. Click the Properties button to define the properties of the ActiveX control.

 Note
· A plug-in is needed to view ActiveX controls in Netscape Navigator. You can download an ActiveX plug-in from 

http:/www.ncompasslabs.com.
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Adding CGI scripts
The Common Gateway Interface (CGI) is responsible for most complex movements and interactions that occur on
the World Wide Web. The CGI communicates with programs on other computers. CGI scripts allow Web browsers 
to run programs without the help of external applications. With CGI scripts, you can scan databases, sort names, 
send mail, or perform almost any other interactive function.
With standard HTML pages, you access a link to a URL, instructing your browser to read, interpret, and display 
information contained on another Web site. With hyperlinks, clients direct their browsers to a specific screen of 
information. But with CGI scripts, an information provider serves up different documents depending on the 
client's request. More importantly, the CGI allows the program or script to create new documents when the 
clients make their requests.
Use the Insert, CGI Script command to easily add CGI scripts to your Corel WEB.DESIGNER pages. If you choose 
to take advantage of the 30 day free basic Web Site hosting on the PageDepot site, Microcrafts will provide you 
with four common CGI scripts that you can use in your Web pages at no extra charge. 
You can also insert your own generic, image source, and form action handler CGI scripts even if you don’t publish
your Web page to the PageDepot site.

For more information see the following:
{button ,JI(`',`Adding a CGI script to your Web page published on Page Depot')} Adding a CGI script to your Web 
page published on Page Depot
{button ,JI(`',`Adding a CGI script to your Corel WEBDESIGNER Web page')} Adding a CGI script to your Corel 
WEB.DESIGNER Web page
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Adding a CGI script to your Web page published on Page Depot
If you chose to take advantage of the 30 day free basic Web Site hosting on the Page Depot site, Microcrafts will 
provide you with four common CGI scripts that you can use in your Web pages at no extra charge. You can 
quickly and easily add a page hit counter, an email form, a guest book, and a site search to your Web pages.

Page hit counter
A page hit counter is a CGI script that can be added to your Web page to count the number of visitors that have 
accessed your page. You can only place one page hit counter on each Web page.

Email form
The email form script provides a simple mechanism for a user to process form information and generate return 
email.

Guest book
The guest book script provides a simple guest book function which enables visitors to your Web page to 
comment on your page. Other visitors can also access your guest book to read the comments and add their own 
thoughts.

Site search
The site search script provides an interface for the use to build an HTML page that will search the site for strings 
or components. 

 Notes
· The PageDepot CGI scripts will only work in your Web page if you publish your page to the PageDepot site 

provided by Microcrafts. If you add these components to a site published by another provider, these items will 
not work. 

· The PageDepot CGI scripts are called by your Web site using a command and the actual CGI scripts are not 
provided with the Corel WebMaster Suite or inserted into. By providing the scripts in this manner, Microcrafts 
can update and substitute the CGI scripts without modifying your Web page.
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Adding a page hit counter
Add a page hit counter to your Web page published on the PageDepot site to count the number of visitors that 
you have to your Web page.

To add a page hit counter
1. Click Insert, CGI script.
2. Enable the PageDepot Script button and click OK.
3. Enable the Counter button.
4. Click the Properties button to open the Counter Script Properties dialog box.
5. Define the properties for the counter object like the Alignment, Horizontal and Vertical Spacing, Size, and 

Alternative Text.
6. Click OK to place the page hit counter on your Web page at the desired location.

 Notes
· You can only add one page hit counter to each Web page on your site.
· The PageDepot CGI scripts will only work in your Web page if you publish your page to the PageDepot site 

provided by Microcrafts. If you add these components to a site published by another provider, these items will 
not work. 

· The PageDepot CGI scripts are called by your Web site using a command and the actual CGI scripts are not 
provided with the Corel WebMaster Suite or inserted into. By providing the scripts in this manner, Microcrafts 
can update and substitute the CGI scripts without modifying your Web page.
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Adding an email form, a guest book, and a site search
Add an email form, a guest book, or a site search to your Web page published on the PageDepot site to add 
advanced functionality to your Web page. Add an email form to process form information and generate return 
email. A guest book will enable visitors to comment on your Web page and a site search enables uses to find 
information on your Web document.

To add an email form, guest book, and a site search
1. Click Insert, CGI script.
2. Enable the PageDepot Script button and click OK.
3. Enable either the Email Form, Guest Book, or Site Search button.
4. Click OK to insert the specified CGI script into your Web page.

 Notes
· You can only add one page hit counter to each Web page on your site.
· The PageDepot CGI scripts will only work in your Web page if you publish your page to the PageDepot site 

provided by Microcrafts. If you add these components to a site published by another provider, these items will 
not work. 

· The PageDepot CGI scripts are called by your Web site using a command and the actual CGI scripts are not 
provided with the Corel WebMaster Suite or inserted into. By providing the scripts in this manner, Microcrafts 
can update and substitute the CGI scripts without modifying your Web page.
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Editing a PageDepot CGI script
Once you have added a PageDepot CGI script to your Web page, you can move, add, and edit controls and 
modify the layout, values, and labels.

To edit a PageDepot CGI script.
1. Double-click an element in the CGI script that you would like to modify.

The Properties dialog box for that object is displayed.
2. Edit the Spacing, Label, Type, Size, and Alignment of the object using the settings in the Properties dialog box.

 Note
· Do not remove or rename any of the form elements in the guest book, site search, or email form or your CGI 

script will no longer work.
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Adding a CGI script to your Corel WEB.DESIGNER Web page
Whether or not you decided to take advantage of the 30 day free Web page publishing on the PageDepot site 
provided by Microcrafts, you can add CGI scripts to your Web page. You can add an image source script, a form 
action handler, or a generic CGI script to your Web document. Corel WEB.DESIGNER does not generate the CGI 
scripts for you, but it does allow you to input these scripts into your Web page

Form Action Handler
Like most other Web editors, Corel WEB.DESIGNER supports HTML form tags but does not generate CGI scripts. 
This means that you can use Corel WEB.DESIGNER to construct forms for your Web pages but until you specify a 
CGI script in the Form Action Handler, your forms will remain static. Before you can publish pages that return 
requested data, respond to user input, or log accesses, you must specify the CGI program that will control your 
form's operations. Specify the URL of the Form Action Handler in the Insert CGI dialog box or contact your 
Webmaster or service provider for more information.

Image Source script
Use the Image source script to have your server generate an image for your Web page. The most common use of
an Image Source script is to add a page hit counter to your page. Specify the URL of the Form Action Handler in 
the Insert CGI dialog box or contact your Webmaster or service provider for more information.

Generic CGI script
Corel WEB.DESIGNER makes it easy to add a CGI script to your Web page. The generic CGI script feature enables 
you to add any CGI script that is not an Image Source script or a Form Action Handler script. Specify the URL of 
the Form Action Handler in the Insert CGI dialog box or contact your Webmaster or service provider for more 
information.
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Adding a Generic CGI script, Image Source Script, or a Form Action Handler.
The CGI script command found in the Insert menu enables you to add your own Generic, Image Source, or Form 
Action Handler CGI script to your Corel WEB.DESIGNER Web page.

To insert a generic CGI script
1. Click Insert, CGI Script.
2. Enable the Generic CGI script button.
3. Type the URL of the CGI script in the box provided or click the Browser button to locate the CGI Script on your 

local system.
4. Choose a Target window from the Target list box.

To insert an Image Source Script
1. Click Insert, CGI Script.
2. Enable the Image Source Script button.
3. Type the URL of the CGI script in the box provided or click the Browser button to locate the CGI Script on your 

local system.

To insert a Form Action Handler Script
1. Click Insert, CGI Script.
2. Enable the Form Action Handler button.
3. Type the URL of the CGI script in the box provided or click the Browser button to locate the CGI Script on your 

local system.
4. Choose a Target window from the Target list box.
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Starting a new Web project
The first page that visitors see when they access a multipage Web site, and the first page that most novice Web 
authors create, is a home page. In addition to providing a "front door" to a company or organization that 
maintains a site on the Web, a home page provides jumps or hyperlinks to all other resources and points of 
interest contained within a Web archive.
When you launch Corel WEB.DESIGNER and start a new Web project, you are asked to choose one of the 
following starting points:
· start a new Web page
· start a new Web page with Frames
· open an existing Web page
· choose a template to begin your Web page
After you choose a starting point, you can begin to format your Web page. You can specify a title for your page 
and add background colors and images to make your page unique. You can also add horizontal rules, paragraph 
breaks, and line breaks to help to divide your Web document into sections. The next step is to save your file so 
that you can reopen your document and continue working on it at a later time. The final step is exiting Corel 
WEB.DESIGNER.

For more information see the following:
{button ,JI(`',`Setting up your Web page')} Setting up your Web page
{button ,JI(`',`Formatting your Web page')} Formatting your Web page
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Setting up your Web page
After you start Corel WEB.DESIGNER, you can begin to create your Web page immediately by using Corel 
WEB.DESIGNER’s simple formatting and setup tools. If you are a novice Web page designer, you may want to 
create a Web page by using one of the many predesigned templates. The templates already include background 
colors or patterns and sample images and text. All you have to do is add your own personal information to the 
page. 
As you gain experience or if you are already familiar with Web page design, you may want to create a Web 
document by modifying an existing template or to create your Web page from scratch. You can select your own 
page color, background images, text colors, and more. Corel WEB.DESIGNER provides you with many tools to 
quickly and easily create a Web page.
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Creating a new Web page
To begin building your Web page from a new Corel WEB.DESIGNER Application Window, click File, New. You can 
also click File, New With Frames to create a Web page the contains frames. After you save your page, the Title 
Bar will display the corresponding file name. To begin building your Web page with one of Corel WEB.DESIGNER 
's predesigned templates, click File, Templates. Choose a sample page from the Templates folder and modify its 
elements to create your own customized document. To simplify this introductory process, Corel WEB.DESIGNER 
offers a welcome message that lists all of the options available to you at the startup point. To enable/disable this 
message, choose Tools, Options.

To start a new blank Web document
· Click File, New.

To start a new Web page that contains frames
· Click File, New With Frames.

To start a new Web document based on a template
1. Click File, Templates. 
2. In the Choose Web Page Template dialog box, select a template from the folder where the file is stored.

The Preview window displays a bitmap image of the selected template. 
3. Click Open.

Corel WEB.DESIGNER opens the template file in the Application Window.
4. Modify the page to display the personal information you want to add to your Web page.

 Tip
· You can also start a new Web page based on a template by pressing CTRL + T.

 Note
· To simplify the introductory process, Corel WEB.DESIGNER offers a welcome message that lists all of the 

options available to you at the startup point. To enable/disable this message, click Tools, Options, and enable 
or disable the Display welcome screen on startup check box.
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Opening an existing Web page
To open an existing Web page in the Corel WEB.DESIGNER Application Window, click File, Open or click the Open 
An Existing Web page button in the welcome message. 

To open a local Web page
1. Click File, Open.
2. Enable the Open A Local Web Page button.
3. In the Path box, type the full path to the local Web page or click the Browse button to locate the drive and 

folder where the file is stored.

To open a Web page from the Internet
1. Click File, Open.
2. Enable the Open A Web Page From The Internet button.
3. In the URL box, type the URL of the Web page to open.

 Notes
· Web pages from the Internet are opened using the HTTP protocol.
· To simplify the introductory process, Corel WEB.DESIGNER offers a welcome message that lists all of the 

options available to you at the startup point. To enable/disable this message, click Tools, Options, and enable 
or disable the Display welcome screen on startup check box.
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Specifying basic Web page properties
When you design Corel WEB.DESIGNER documents, you can specify basic properties that affect the appearance 
and layout of the entire page. Setting the document title, specifying background images or color, and choosing 
text colors create more appealing, organized pages for your audience.

To change your document's title
1. Click File, Page Properties.
2. In the Page Properties dialog box, type a name in the Document Title box.

To change your page's background color
1. Click File, Page Properties.
2. In the Page Properties dialog box, choose a color from the Background Color list box or choose Custom to 

create your own customized color.

To insert a background image
1. Click File, Page Properties.
2. In the Page Properties dialog box, click the Browse button beside the Background Image Source field.

Corel WEB.DESIGNER opens the Select Image Source dialog box.
3. Locate an image file and click Open.

Corel WEB.DESIGNER returns to the Page Properties dialog box.
 Notes

· Because the document title places a title string in the HTML code and is used by World Wide Web search tools 
to locate your Web site, it is important to give your page a meaningful name.

· You can choose Custom from the Background Color list box to define a custom color.
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Saving your work and exiting
Before exiting Corel WEB.DESIGNER, you must save your work in your server root folder. If you have made 
changes to a file and attempt to exit without saving the document, Corel WEB.DESIGNER prompts you to save 
the file. Click Yes to save your changes and exit. Click No to exit without saving your modifications or click Cancel
to return to the active Corel WEB.DESIGNER window.

To save changes to your Web page file
1. Click File, Save As.

Corel WEB.DESIGNER opens the Save As dialog box.
2. Type a name in the File Name box.

To exit Corel WEB.DESIGNER 
· Click File, Exit.

 Notes
· To maintain consistency and organization among your Web files, save your pages inside your server root 

folder. If you choose to save your Web page in another folder, outside the server root, all images and files 
referenced with relative addresses will be copied with the .HTML file. If necessary, folders will be created in the
new location to mirror the original folder structure.

· When you name your Corel WEB.DESIGNER documents avoid the use of symbols. Corel WEB.DESIGNER does 
not recognize the percent or number symbols (%, #).
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Formatting your Web page
Corel WEB.DESIGNER offers many tools for you to quickly add basic formatting elements to your Web page. The 
insert horizontal rule function allows you to add ruled lines of any height and width to your page. Horizontal rules
are a simple way to divide and organize the information presented on your Web page. Paragraph and line breaks 
can also be added easily to help separate the text in your Web document.
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Adding paragraph and line breaks
Paragraph and line breaks can be added to your Web pages to separate the text in your document. According to 
their respective designs, different Web browser applications will automatically wrap (i.e. add line breaks to) lines 
of text. It is only necessary to insert a line break when you specifically want your text to resume at the beginning
of the next line.

To add a paragraph break
· Press ENTER.

To add a line break
· Click Insert, Line Break.

 Tip

· You can also add a line break by pressing SHIFT + ENTER or by clicking the  button.
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Adding horizontal rules
With Corel WEB.DESIGNER, you can add horizontal rules to your Web pages and modify their appearance by 
using the Horizontal Rule Properties dialog box.

To add a horizontal rule
1. Position your cursor on the line where you want to add a horizontal rule.
2. Click Insert, Horizontal Rule

Corel WEB.DESIGNER adds a horizontal rule to your document.
3. Double-click the horizontal rule.
4. In the Horizontal Rule Properties dialog box, modify the height, width, alignment, or shading of the horizontal 

rule.
 Tip

· You can also add a horizontal rule by clicking .
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Publishing files to Corel WEB.DESIGNER
Files created in the other applications in the Corel WebMaster Suite can be easily merged with your Corel 
WEB.DESIGNER documents to integrate their applications and features. This allows you to create unique, 
advanced World Wide Web pages. Use the other applications in the Corel WebMaster Suite to create professional 
Web pages that incorporate Java Powered applets, animations, original graphics, clipart images, virtual worlds, 
retouched photographs, database information, and more. 

For more information see the following:
{button ,JI(`',`Using Corel WEBMOVE')} Using Corel WEB.MOVE
{button ,JI(`',`Using Corel WEBDRAW')} Using Corel WEB.DRAW
{button ,JI(`',`Using Corel WEBWORLD')} Using Corel WEB.WORLD
{button ,JI(`',`Using Corel WEBGALLERY')} Using Corel WEB.GALLERY
{button ,JI(`',`Using Corels Barista technology')} Using Corel's Barista technology
{button ,JI(`',`Using Corel WEBDATA')} Using Corel WEB.DATA
{button ,JI(`',`Using Corel WEBPhotoPaint')} Using Corel WEB.PhotoPaint
{button ,JI(`',`Using Corel WEBSiteManager')} Using Corel WEB.SiteManager
{button ,JI(`',`Using the OReilly Website server')} Using the O'Reilly Website server
{button ,JI(`',`WebSite installation requirements')} WebSite installation requirements
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Using Corel WEB.MOVE
Corel WEB.MOVE allows you to create animations and save them as animated GIFs or applets written in the Java 
Programming Language. The animations that you create in Corel WEB.MOVE can be automatically published 
back to Corel WEB.DESIGNER.

Referencing Files with Windows 95
To view your Corel WEB.MOVE animation in a Web browser, click File, Publish To Corel WEB.DESIGNER and enable
the Copy Class Files check box. The appropriate files are automatically copied.

Referencing Files with Windows NT
To view your Corel WEB.MOVE animation in a Web browser, copy the class files AR.CLASS, EFFECT.CLASS, 
LOADER.CLASS, and WEBMOVE.CLASS (located in the BARISTA folder on the Corel WebMaster Suite CD-ROM) to 
the folder that contains your Corel WEB.MOVE .HTML file. If you choose File, Publish To Corel WEB.DESIGNER in 
the Corel WEB.MOVE application, simply enable the Copy Class Files check box. The appropriate files are 
automatically copied.

 Note
· The files AR.CLASS, EFFECT.CLASS, LOADER.CLASS, and WEBMOVE.CLASS must be in the same folder or a 

subfolder as your HTML page to view Java Powered animations.
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Inserting animations
In Corel WebMaster Suite, the creation and integration of animated files is performed by the Corel WEB.MOVE 
command in the Corel WEB.DESIGNER Tools menu and the Publish To command in the Corel WEB.MOVE File 
menu. To automatically publish an animation to the Corel WEB.DESIGNER page, you must launch Corel 
WEB.MOVE from within Corel WEB.DESIGNER.

To add animations to your Web page
1. Position your cursor at the point in your Corel WEB.DESIGNER document where you want to insert an 

animation.
2. Click Tools, Corel WEB.MOVE.

Corel WEB.MOVE is launched directly from the Corel WEB.DESIGNER Application Window.
3. Create an animation by using the tools and commands offered by the Corel WEB.MOVE menus and toolbars. 

Refer to the Corel WEB.MOVE online Help system for assistance when you construct your animated files.
4. Click File, Publish To Corel WEB.DESIGNER.

Corel WEB.DESIGNER closes the active Corel WEB.MOVE window and adds the animation to your Web page at 
your cursor position.

5. Click Tools, Browser Preview to test the animation.
 Notes

· When the first frame of your animation appears in the Corel WEB.DESIGNER Application Window, you can 
double-click the image or click Edit, Properties to open the Applet Properties dialog box.

· The files AR.CLASS, EFFECT.CLASS, LOADER.CLASS, and WEBMOVE.CLASS must be in the same folder or a 
subfolder of your HTML page to view the Java Powered animation.

· To insert an animated .GIF into Corel WEB.DESIGNER, publish To animated GIF in Corel WEB.MOVE and then 
click Insert, Image in Corel WEB.DESIGNER and click the Browse button to locate the file.
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Using Corel WEB.DRAW
Corel WEB.DRAW is a vector image-creation program based on award-winning CorelDRAW illustration technology.
Corel WEB.DRAW enables you to create original, unique graphic images for use in your Web pages. Corel 
WEB.DRAW can be launched from within Corel WEB.DESIGNER to provide easy integration of original artwork. 
Images can also be automatically published back to Corel WEB.DESIGNER.
The tight integration of Corel WEB.DRAW and Corel WEB.DESIGNER allows Corel WEB.DESIGNER users to enable 
or disable the appearance of transparent .GIF images when they publish Corel WEB.DRAW artwork. Transparency 
removes the background color from a .GIF image, so that the browser's background color shows through the 
image when it is displayed on the Web. If you publish a Corel WEB.DRAW image to Corel WEB.DESIGNER with the
transparency command enabled, your image appears to float on the Corel WEB.DESIGNER page. If you publish a 
Corel WEB.DRAW image to Corel WEB.DESIGNER with the transparency command disabled, the image's original 
background color overrides the browser's background color. 
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Creating and inserting your own graphics
In the Corel WebMaster Suite, the creation and integration of graphic images is performed by the Corel 
WEB.DRAW command in the Corel WEB.DESIGNER Tools menu and the Publish To command in the Corel 
WEB.DRAW File menu.

To create and insert Corel WEB.DRAW graphics
1. Position your cursor at the point in your Corel WEB.DESIGNER document where you want to insert a Corel 

WEB.DRAW image.
2. Click Tools, Corel WEB.DRAW.

Corel WEB.DRAW is launched directly from the Corel WEB.DESIGNER Application Window.
3. Create a graphic using the tools and commands offered by the Corel WEB.DRAW menus and toolbars. Refer to 

the Corel WEB.DRAW online Help system for assistance when you construct your graphic files.
4. Click File, Publish To Corel WEB.DESIGNER.

Corel WEB.DESIGNER closes the active Corel WEB.DRAW window and adds the image to your Web page.
 Notes

· You can insert existing graphics into your Web page by clicking Insert, Image in Corel WEB.DESIGNER.
· To automatically publish a Corel WEB.DRAW image to your Corel WEB.DESIGNER page, you must launch Corel 

WEB.DRAW from within Corel WEB.DESIGNER.
· When the image appears in the Corel WEB.DESIGNER Application Window, you can double-click the image or 

choose Edit, Properties to open the Image Properties dialog box. To edit any image in your Web page, double-
click the image and click the Edit button in the Image Properties dialog box.
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Using Corel WEB.WORLD
Corel WEB.WORLD allows you to create exciting VRML files that allow visitors to your Web site to enter and 
explore an exciting three-dimensional world. Use Corel WEB.WORLD to create buildings with windows, doors, and
separate rooms. Decorate the floor, ceiling, and walls of your structure with wallpaper, pictures, and movies. You 
can also allow users to jump to other sites from within your virtual world. VRML files can be automatically 
published back to Corel WEB.DESIGNER for easy integration.
To view a virtual world that you have published in your Corel WEB.DESIGNER page, visitors must access your 
Web site with an advanced browser such as Netscape Navigator 3.0 or Microsoft's Internet Explorer 3.0. You can 
also view VRML files with Netscape Navigator 2.0 or Internet Explorer 2.0 using a plug-in application. A plug-in is 
an attachment to an Internet browser that enables the browser to display file formats other than HTML.

Viewing .WRL files in your Corel WEB.DESIGNER pages
WRL files conform to the VRML 1.0 standard used by most popular viewers (such as Netscape 3.0). When they 
view .WRL files in a browser, visitors can navigate your three-dimensional world, exploring the buildings, 
wallpapers, pictures, and links to URLs. Standard VRML viewers do not support albums, attached text, sounds, 
walking shows, background MIDI music, or moving wallpaper.
If you publish the .WRL copy of your VRML file, you can direct visitors to the Netscape Web site to download 
Netscape's VRML plug-in for Netscape 2.0, Live3D. The Netscape World Wide Web site resides at 
http://home.netscape.com/comprod/mirror/navcomponents_download.html or may be located by following links 
from the Netscape home page at http://home.netscape.com. Live3D is built into Netscape 3.0. 
You can find the Internet Explorer 2.0 plug-in at http://www.microsoft.com/ie/addon/vrml.htm or by accessing the 
Software library from the Microsoft home page at http://www.microsoft.com. Microsoft's Internet Explorer 3.0 has 
built-in VRML support.

 Notes
· To integrate Corel WEB.WORLD .MUS files into your Web page, you should create a standard hypertext link in 

your Corel WEB.DESIGNER document that points to the .MUS file.
· To avoid having to direct visitors to another site to download a plug-in or viewer, you can include a copy of the 

Corel WEB.WORLD viewer, which can be distributed, with the .MUS copy of your file. Enable the Copy The 
Viewer box when you Publish To VRML in Corel WEB.WORLD. This includes a copy of the Corel WEB.WORLD 
viewer in the folder to which all of your other files are saved. Compress the folder, using a compression 
application such as WinZip, into a self-extracting archive and create a single hypertext link from your page to 
the Corel WEB.WORLD file.
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Inserting VRML
You can merge VRML with your Web pages by using Corel WEB.DESIGNER's Corel WEB.WORLD command and 
Corel WEB.WORLD's Publish To, Corel WEB.DESIGNER command.

To create and insert Corel WEB.WORLD VRML
1. Position your cursor at the point in your Corel WEB.DESIGNER document where you want to insert VRML.
2. Click Tools, Corel WEB.WORLD.

Corel WEB.WORLD is launched directly from the Corel WEB.DESIGNER Application Window.
3. Create a VRML by using the tools and commands offered by the Corel WEB.WORLD menus and toolbars. Refer 

to the Corel WEB.WORLD online Help system for assistance when you construct your VRML file.
4. Click File, Publish To Corel WEB.DESIGNER.

Corel WEB.DESIGNER closes the Corel WEB.WORLD window and adds the VRML file to your Web page.
 Notes

· To view a virtual world, your browser must have VRML viewer support. This is achieved either as a free plug-in 
(e.g., Live 3D for Netscape Navigator 2.0) or as built-in support (e.g., Netscape Navigator 3.0, Microsoft’s 
Internet Explorer 3.0).

· You can double-click the VRML or click Edit, Properties to open the Embedded File Properties dialog box and 
adjust the properties of the VRML.

· To automatically publish your VRML to Corel WEB.DESIGNER, you must launch Corel WEB.WORLD from within 
Corel WEB.DESIGNER.

· To avoid having to direct visitors to another site to download a plug-in or viewer, you can include a copy of the 
Corel WEB.WORLD viewer, which can be distributed, with the .MUS copy of your file. Enable the Copy The 
Viewer box when you Publish To VRML in Corel WEB.WORLD. This includes a copy of the Corel WEB.WORLD 
viewer in the folder to which all of your other files are saved. Compress the folder, using a compression 
application such as WinZip, into a self-extracting archive and create a single hypertext link from your page to 
the Corel WEB.WORLD file.
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Using Corel WEB.GALLERY
Almost anyone can create a Web page, but not everyone has the artistic talent or time necessary to create 
original images for use in those pages. The Corel WebMaster Suite includes Corel WEB.GALLERY to supply you 
with thousands of ready-to-use images for integration in your Corel WEB.DESIGNER documents. 
Corel WEB.GALLERY includes over 7,500 Internet-ready images in .GIF or .JPG formats such as backgrounds, 
buttons, bullets, separators, alphabets, icons, arrows, clipart, and photos. Simply drag and drop the images onto 
your Corel WEB.DESIGNER screen to add color and life to your Web documents. 

 Notes
· Corel WEB.DESIGNER handles .JPG and .GIF file formats directly. Three other file formats, (.TGA, .BMP, 

and .PCX) are automatically converted to .GIF or .JPG file formats when they are added to your Corel 
WEB.DESIGNER page.

· The Export command found in the File menu of Corel WEB.GALLERY enables you to convert graphic files into 
many different file formats.
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Adding Corel WEB.GALLERY images
You can insert Corel WEB.GALLERY images into your Web pages by using the Corel WEB.GALLERY command in 
Corel WEB.DESIGNER Tools menu.

To add a Corel WEB.GALLERY graphic
1. Position your cursor at the point on your Corel WEB.DESIGNER document where you want to insert a graphic.
2. Click Tools, Corel WEB.GALLERY.

Corel WEB.GALLERY is launched directly from the Corel WEB.DESIGNER Application Window.
3. Locate the image(s) that you want to appear in your Web page by browsing through the Corel WEB.GALLERY 

albums.
4. Drag and drop the image(s) onto the Corel WEB.DESIGNER document.

 Notes
· Any image can be inserted into your Web page by clicking Insert, Image from the Corel WEB.DESIGNER menu.
· Corel WEB.DESIGNER handles .GIF and .JPG file formats directly. Three other file formats, (.TGA, .BMP, 

and .PCX) are automatically converted to .GIF or .JPG file formats when they are added to the Corel 
WEB.DESIGNER page.

· The Export command found in the File menu of Corel WEB.GALLERY enables you to convert graphic files into 
many different file formats.
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Using Corel's Barista technology
Barista is a breakthrough publishing technology, developed by Corel Corporation, that allows you to publish Web 
pages in the Java Programming Language. Publishing with Barista removes the limitations imposed by the 
Hypertext Markup Language (HTML) by offering rich formatting options, advanced layout control, and improved 
graphic display. 

For more information see the following:
{button ,JI(`',`Publishing with Barista')} Publishing with Barista
{button ,JI(`',`Barista CLASS files')} Barista CLASS files
{button ,JI(`',`The Barista file structure')} The Barista file structure
{button ,JI(`',`Publishing in the Java Programming Language with Barista')} Publishing in the Java Programming 
Language with Barista
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Publishing with Barista



Publishing with Barista
Corel's Barista technology allows you to use your favorite Corel software to publish Web pages in the Java 
Programming Language. This means that you can apply all of the features and layout control enjoyed by Corel 
products to your Web publications without being restricted by standard HTML limitations. In addition to HTML 
features like hyperlinks, graphics, and tables, pages published with Barista also benefit from rich formatting 
options, multicolumn WYSIWYG display, and complex imagery.
When you publish your Web documents using Corel Barista, a Web page, or .HTM file, is created with the same 
folder and filename that you originally specified for your page. Next, a subfolder with the same name is 
automatically created and stored with your output file. This subfolder stores all necessary page contents.
To view an accurate representation of your page in a Web browser, you must place the Barista class files in the 
same folder as your Web page. (The Barista Class files were installed with your Corel application and placed in a 
program subfolder called BARISTA. The Class files are also available on the Corel WebMaster Suite CD ROM).

 Tip
· Keep all of your Barista output in a single folder on your Internet server or local hard disk so that you only 

need to copy the Barista classes once.
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Barista CLASS files
Like other Java Powered applets, Barista uses special program files, called class files, to provide the necessary 
publishing instructions for your Web page or document. Whenever a Barista page is viewed through a browser, 
the class files are downloaded with your page so that the browser will be able to correctly display the page and 
any pages that follow. Class files can be downloaded once and reused during the same browsing session.
To view an accurate representation of your Barista document in a Web browser, the Barista class files must be 
located in the same folder as your .HTM file. Depending on your file-storage techniques, this requires either:
· publishing your Web page to the BARISTA subfolder installed with your software, or
· copying all the files contained in the BARISTA subfolder to the location of your Web-page output file. (Be sure 

to copy the BARISTA folder, all subdirectories, and their contents.)
 Tip

· When copying Barista class files to a UNIX server be sure to maintain letter case. The UNIX system is case-
sensitive.
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The Barista file structure
The following files and folders are required to run a Barista .HTML file:

Barista.class file VDoc.class file
down.gif file VPage.class file
downd.gif file VPanel.class file
downp.gif file VPopMenu.class file
IHandler.class file VSPanel.class file
nexth.gif file VToolbar.class file
nextn.gif file VWindow.class file
prevh.gif file ZStorage.class file
prevn.gif file ar.class file
Scroller.class file effect.class file
up.gif file loader.class file
upd.gif file webmove.class file
upp.gif file corel folder

The COREL folder, located within the BARISTA folder on your Corel WebMaster Suite CD-ROM, contains four 
subdirectories that are also required to view a Barista file.
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Publishing in the Java Programming Language with Barista
For the time being, users will have difficulty viewing Barista pages over low-bandwidth access. However, 
upgrades to the Java Programming Language  are expected within the coming year to solve these problems. 
Until that time, Barista technology is recommended for Intranet environments only. Consult http://www.corel.com
for the latest information on the progress of these upgrades.
Corel's Barista Technology is based on Sun Microsystems Inc. publishing technology and allows you to use your 
favorite Corel page layout and illustration software as both a Java Powered creation and WYSIWYG authoring tool 
for the Internet. This means that you can enjoy all of the features and layout control available with Corel 
products when you publish to the Web, without being restricted by HTML limitations.
Support for the Java Programming Language is quickly becoming the de facto standard among browsers such as 
Netscape Navigator 3.0 and Microsoft Internet Explorer 3.0. As a result, JavaSoft, the creators of the Java 
Programming Language, and the browser industry are aggressively refining performance issues associated with 
the Internet. Barista was designed in anticipation of these refinements and requires improved compression, font 
support, and class downloading for optimal performance. This means that as a Corel user, you will already have 
advanced technological capabilities built into your software when these enhancements are implemented.
In the meantime, we recommend that you use Barista in an Intranet environment only, where bandwidth is not 
as sensitive. This way, you can immediately discover the benefits of Barista and use the technology to its fullest 
potential as soon as browsers and the Java Programming Language itself implement the planned performance 
improvements.

 Note
· The Java Programming Language is a platform-independent programming language being widely adapted for 

the Internet.
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Creating and merging Barista files
Combining Corel WEB.DESIGNER's Web publishing features with Corel WEB.DRAW's Barista technology allows 
you to make rich graphics available to audiences around the world.

To create images and publish to Barista in Corel WEB.DRAW
1. Launch Corel WEB.DESIGNER and click Start A New Web page in the Welcome Screen.
2. Click Tools, Corel WEB.DRAW.

The Corel WEB.DRAW application is launched from the main Corel WEB.DESIGNER Application Window.
3. Create an image using the tools offered in the Corel WEB.DRAW menus and toolbars. Refer to the Corel 

WEB.DRAW online Help files for assistance.
4. Click File, Publish To, Barista and save your file.
5. Copy the contents of the BARISTA folder (including all subfolders) to the same folder as your Corel WEB.DRAW 

file.

To merge Barista files with your Corel WEB.DESIGNER documents
1. Click Insert, HTML File in Corel WEB.DESIGNER.
2. Locate the Corel WEB.DRAW .HTML file that created when you published your image to Corel WEB.DESIGNER in

the previous procedure.
Corel WEB.DESIGNER displays a black region where the file will be displayed.

3.Click Tools, Browser Preview to view the Web page.
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Using Corel WEB.DATA
Corel WEB.DATA is a powerful database-publishing tool that allows you to adapt existing databases for display on
the World Wide Web. WEB.DATA can be used with a number of different commercially available database 
applications to produce organized and visually appealing Web documents, such as catalogs, mutual fund and 
stock reports, and inventories. Corel WEB.DATA supports Uniform Resource Locators (URLs) and the Java 
Programming Language.
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Inserting database information
The tight integration of the products featured in the Corel WebMaster Suite allows you to convert database 
material to HTML format and to add it to your Web pages without leaving Corel WEB.DESIGNER. In the Corel 
WebMaster Suite, Corel WEB.DATA is responsible for managing database information. You can launch Corel 
WEB.DATA from within Corel WEB.DESIGNER.

To convert database information to HTML
1. Position your cursor at the point in your Corel WEB.DESIGNER document where you want to add the database 

information.
2. Click Tools, Corel WEB.DATA.

Corel WEB.DATA is launched from within the Corel WEB.DESIGNER Application Window.
3. Publish your database information on the Web using the commands offered by the Corel WEB.DATA menus and

toolbars. 
4. Ensure that the Publish to Corel WEB.DESIGNER button is enabled in the Publishing Options step. 
5. Click the Process button and click Publish to Corel WEB.DESIGNER.

Refer to the Corel WEB.DATA online Help system for assistance with your database-publishing tasks.
 Note

· You can also click Insert, HTML file in Corel WEB.DESIGNER to locate the HTML file that you create using Corel 
WEB.DATA technology. 
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Using Corel WEB.PhotoPaint
Corel WEB.PhotoPaint is a powerful bitmap-editing tool that is ideal for preparing photographic images for use on
the World Wide Web. You can also use Corel WEB.PhotoPaint to retouch, crop, or edit your photos using a vast 
array of special effects.
Corel WEB.PhotoPaint provides you with a variety of tools to change or simplify colors in a photo, to add color to 
a black-and-white image, and to adjust the lighting, contrast, and focus. You can also make drastic changes such 
as removing people and things or adding text and objects. Corel WEB.PhotoPaint can also be used to edit video 
files.
Corel WEB.PhotoPaint can be launched directly from within Corel WEB.DESIGNER.

About image file formats
Different computer graphics software packages support a huge array of different file formats. The Web supports 
only two: .GIF and .JPG. Corel WEB.DESIGNER directly supports these two formats but also converts .BMP, .PCX, 
and .TGA files to .GIF or .JPG. Other file formats can be converted using Corel WEB.PhotoPaint's Import and 
Export commands.
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Moving between Corel WEB.PhotoPaint and Corel WEB.DESIGNER
There are two ways of placing images in Corel WEB.DESIGNER from Corel WEB.PhotoPaint. If you launch Corel 
WEB.PhotoPaint from within Corel WEB.DESIGNER, you can use the Publish To Corel WEB.DESIGNER command 
(found in the Corel WEB.PhotoPaint File menu) to insert the image at your cursor position. If you didn’t access 
Corel WEB.PhotoPaint from within Corel WEB.DESIGNER, you can still edit and save your image, and then place it
in your    Corel WEB.DESIGNER Web page using the Image command (found in the Corel WEB.DESIGNER Insert 
menu).

To launch Corel WEB.PhotoPaint from within Corel WEB.DESIGNER
1. Do one of the following:

· Click Tools, Corel WEB.PhotoPaint.
· Double-click an image and click the Edit Image button.
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Placing images in Corel WEB.DESIGNER
The Publish To Corel WEB.DESIGNER command (in the Corel WEB.PhotoPaint File menu) lets you place your 
image in Corel WEB.DESIGNER at your cursor position. If you didn’t access Corel WEB.PhotoPaint from within 
Corel WEB.DESIGNER, save and close your image, launch Corel WEB.DESIGNER, and place the image using the 
Image command (found in the Corel WEB.DESIGNER Insert menu).

To publish a Corel WEB.PhotoPaint image to Corel WEB.DESIGNER
· In Corel WEB.PhotoPaint, click File, Publish To WEB.DESIGNER.

To insert a Corel WEB.PhotoPaint image
1. Save the image in the Corel WEB.PhotoPaint application.
2. Launch Corel WEB.DESIGNER.
3. Position your cursor at the point in your Corel WEB.DESIGNER document where you want to insert the image.
4. Click Insert, Image.
5. In the Image Properties dialog box, click Browse and locate the image file.
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Editing images in your Web pages
Corel WEB.PhotoPaint makes it easy to edit an image that you have added to your Web document in Corel 
WEB.DESIGNER. You can also use Corel WEB.PhotoPaint to create new images for use on the World Wide Web.

To edit an image
1. In Corel WEB.DESIGNER, double-click the image that you want to edit to open the Image Properties dialog box.
2. Click the Edit Image button to launch Corel WEB.PhotoPaint.
3. Edit the image using the commands offered by the Corel WEB.PhotoPaint menus and toolbars. Refer to the 

Corel WEB.PhotoPaint online Help system for assistance with your image-editing tasks.
4. Click File, Publish To Corel WEB.DESIGNER to update the image in your Web page.

To create a new image using Corel WEB.PhotoPaint
1. Position your cursor at the point in your Corel WEB.DESIGNER document where you want to add an image.
2. Click Tools, Corel WEB.PhotoPaint.

Corel WEB.PhotoPaint is launched from within the Corel WEB.DESIGNER Application Window.
3. Create or edit the image using the commands offered by the Corel WEB.PhotoPaint menus and toolbars. Refer 

to the Corel WEB.PhotoPaint online Help system for assistance with your image editing tasks.
4. Click File, Publish To WEB.DESIGNER to automatically add the image to your Web page.
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Using Corel WEB.SiteManager
Corel WEB.SiteManager provides Web site administrators or "Webmasters" with maintenance, monitoring, 
diagnostic, and repair facilities for their Internet and Intranet sites. Corel WEB.SiteManager's intuitive drag and 
drop interface makes it easy for Web administrators to monitor the content and organization of the files stored 
on their server.
The Corel WEB.SiteManager interface resembles the standard Windows 95 Explorer interface. It displays the 
structure and organization of files in a folder tree on the left side of the screen and illustrates the relationship of 
files and folders in the editing window on the right side of the screen.
You can use Corel WEB.SiteManager to organize your local Web sites or to view the organizational structure of 
Web sites that have already been published on the World Wide Web. With Corel WEB.SiteManager, you can move
files and automatically update the associated links, perform search and replace functions, launch Corel 
WEB.DESIGNER and Corel WEB.PhotoPaint to edit HTML pages and images, view the structure of your site, repair 
broken links, and analyze your site. Corel WEB.SiteManager offers four main display options: Page View, List 
View, Source View, and Browser View.
Page View Displays the links and relationships between files in the Web site.
List View Displays the Web site's path, file, title, author, size, date last modified, and date 

created.
Source View Displays the Web site's HTML source code.
Browser View Displays the Web site as it would appear in a browser window on the World Wide 

Web.
 Note

· Corel WEB.SiteManager supports local and remote servers through the HTTP and file access protocols.
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Opening your local Web site
After launching Corel WEB.SiteManager, you can load Web sites into the WEB.SiteManager Application Window 
from your local file system. Corel WEB.SiteManager also allows you to reopen the most recently examined sites 
by choosing the appropriate folder from the list box on the Corel WEB.SiteManager toolbar. 

To open a local Web site
1. Click File, Open.
2. Enable the Open A Local Site button in the Open dialog box.
3. Type the name of the folder that contains the Web pages or click the Browse button to locate the appropriate 

files.
 Tips

· You can also open a file by clicking .

· Click  on the WEB.SiteManager toolbar to stop loading a selected site from your local system.
· You can limit the number of files or levels that are loaded in the Corel WEB.SiteManager Application 
Window by clicking the Advanced button in the Open dialog box and typing a value in the Stop After Levels box.
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Opening a published Web site
After launching Corel WEB.SiteManager, you can load Web sites into the WEB.SiteManager Application Window 
directly from the Internet. Corel WEB.SiteManager can analyze any Web site that you can view with a Web 
browser. Web sites are opened using the HTTP protocol.

To open a published Web site
1. Click File, Open. 
2. Enable the Open An Internet Site button in the Open dialog box.
3. In the URL box, type the URL or Internet address of the Web site that you want to open, you can reopen an 

external Web site by choosing the appropriate URL from the URL list box.
 Tips

· You can also open a file by clicking .

· Click  on the WEB.SiteManager toolbar to stop loading a selected site from the World Wide Web.
· You can limit the number of files or levels that are loaded in the Corel WEB.SiteManager Application 
Window by clicking the Advanced button in the Open dialog box and typing a value in the Stop After Levels box.
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Editing and updating pages
After you have launched Corel WEB.SiteManager and opened a Web site, you can edit and update the imported 
pages from Corel WEB.SiteManager. Double-clicking HTML files in File View automatically launches the Corel 
WEB.DESIGNER editor and loads the selected file in the Web editor's working window. Double-clicking image files
in File View automatically launches Corel WEB.PhotoPaint and loads the selected file in the image editor's 
working window.

To edit or update pages
1. Locate the file that you want to edit or update in the folder tree on the left side of the WEB.SiteManager 

screen.
2. Double-click the file.
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Using the O'Reilly WebSite server
After you have created your Web pages using Corel WEB.DESIGNER's advanced authoring tools and integrated 
applications, you must place your documents on an Internet server for publication on the Web. You can choose 
the Publish To Internet option under the File menu to choose Microcrafts Inc. or another Web Site hosting service 
to host your site for you. Or, you can use the O'Reilly WebSite server, included in the Corel WebMaster Suite. The
O'Reilly Web Site server allows you to publish your information directly on the World Wide Web or on an internal 
network. You can even use the O’Reilly WebSite's virtual server capability to publish your documents in both 
environments with a public Web site connected to the Internet and a private Web site running on your Local Area
Network (LAN).
The O’Reilly WebSite server handles requests from clients (Web browsers) and comes with a full range of tools to
manage the server and develop your Web. One of the most important tools in the O’Reilly WebSite package, the 
Server Admin, allows you to configure the WebSite server to meet the needs of your environment. Although the 
install program handles the basic server configuration, you can customize the Server Admin settings to enhance 
the server's operations. Additional tools allow you to run WebSite as a desktop application or as a service under 
Windows NT.

 Note
· For more information on the WebSite server software, see the WebSite Installation Guide in the WEBSITE folder

in the WEBMSTR folder.
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WebSite installation requirements
Before you install the O'Reilly WebSite server on your local computer system, it's important to ensure that you 
fulfill the server's installation requirements. 

Hardware Software
· 386 + microprocessor Windows 95 or Windows NT 3.5 +
· 12MB RAM minimum (Windows NT)
· 8 MB RAM minimum (Windows 95) Web browser
· 10 MB free hard disk space
· VGA video display adapter
· 3.5" floppy drive
· network card or modem

Connectivity Other
· TCP/IP stack installed and running System date/time set correctly
· IP Address Administrator or backup privileges for

installing WebSite as a service (NT 
only)

· Fully Qualified Domain Name (FQDN)
· Email address for server 

administrator
· Domain Name System (DNS)    

optional
· WebSite server registered with DNS    

optional
 Tip

· For more information on WebSite's installation requirements, see CHAPTER2.HTM of the WebSite Index, located
in the WEBSITE folder in the WEBMSTR folder on your hard drive.
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Installing WebSite server software
Before you begin the O’Reilly WebSite installation process, you must collect some information about your system
hardware, software, and connectivity options. Preview the WebSite installation requirements and consult the 
Installation Guide in the WEBSITE folder for further installation information.

To install the WebSite server
1. Navigate to the WEBSITE subfolder in the WEBMSTR folder of your Corel WebMaster Suite install folder.
2. Double-click SETUP.EXE.

O’Reilly WebSite prepares the InstallShield Wizard and guides you through the server-installation process.
3. Type your name in the Name box, company information in the Company box, and click Next.
4. Click the Browse button and locate the destination folder for your WebSite software.
5. In the Web Root box, type the path leading to Corel WEB.DESIGNER's server root folder.
6. Type a name for your Web site's index document in the Index Doc box and click Next.
7. Enable a server run mode option and click Next.
8. Type the Fully Qualified Domain Name (FQDN) for the server in the Host Domain Name box and click Next.
9. Type the email address of the server administrator in the Administrator's Email Address box and click Next.

 Tips
· After you have installed the WebSite server software on your local system, test the server's operation from 

your local computer and from a remote system. Run the server self-test and review the General page in Server
Admin before you activate the WebSite account for the server administrator.

· Your Fully Qualified Domain Name (FQDN) includes the server's specific name and the larger domain name, 
e.g., myserver.mycompany.com. This is the name used in URLs to locate your WebSite server. If you don't have
a FQDN, type your computer's IP address in the Host Domain Name box.

· For more detailed installation instructions, consult CHAPTER3.HTM of the WebSite Index located in the 
WEBSITE folder in your WEBMSTR folder.
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3D (three-dimensional)
An object that exists in the dimensions of width, height, and depth.



Active window
The window in which you are working. The next action you perform applies to the Active Window.



ActiveX
A component that can be inserted in a Web page to provide functionality not directly available in HTML, such as 
animation sequences, credit-card transactions, or spreadsheet calculations. ActiveX controls can be 
implemented in a variety of programming languages.



Add-ons
An external program or helper application that can be added to a Web browser. Add-ons perform functions and 
display file types that the Web browser cannot handle internally.



Address
The string of characters that identifies you, an Internet file, or an Internet site. Email addresses usually take the 
form username@host.name.type, and gopher addresses look like cwis.usc.edu. World Wide Web addresses are 
called Uniform Resource Locators or URLs.



Anchor
The source or destination of a hypertext link in a Web document. External links extend from one anchor to 
another document or from another document to that anchor. A link's source anchor or starting point is usually 
highlighted in your Web browser. Clicking your mouse on a source anchor transports you to the corresponding 
destination anchor.



Animated .GIF
A mode of displaying graphics on the Internet, GIF (Graphics Interchange Format) files simulate animation by 
showing each frame in the animation sequence in succession, in the same location. The .GIF file holds a 
“snapshot” of each frame in the animation sequence; therefore, static information, such as backgrounds, is 
stored once for each frame. The storing of this static information in every frame creates files that are very large.



Anonymous FTP
A File Transfer Protocol (FTP) service in which any user can copy files by logging on with the name anonymous.



Applet
An applet is a small program, based on the Java Programming Language, that can be included in an HTML page. 
When you use a Java-compatible browser to view a page that contains an applet, the applet's code is transferred 
to your system and executed by the browser.



Attribute
A property of an HTML element that appears in the opening tag of the element. In the HTML sequence <TABLE 
COLSPAN=6>, COLSPAN is an attribute that is defined by the <TABLE> tag.



Browser
A mechanism used to view hypertext on the World Wide Web, technically referred to as a Web client. A browser 
allows you to view pages and navigate Web archives.



Break
The interruption in the flow of text from one paragraph to the next. With Corel WEB.DESIGNER, you can insert 
page breaks and simple line breaks.



Bitmap (.BMP)
The file name extension for bitmap images. Bitmaps are images composed of a series of pixels or dots. Scanners 
and paint programs such as Corel WEB.PhotoPaint generate this type of image.



Blink
A Corel WEB.DESIGNER feature that causes text to blink on and off    when it is viewed in a Web browser. The 
blink feature is not supported by all Web browsers.



Bold
A darker, heavier version of normal type often used for headlines and text emphasis. It corresponding to the 
<B> and </B> tags in HTML.



Bookmark
A bookmark codes and identifies a specific location within a Corel WEB.DESIGNER document. After you have set 
a bookmark, you can create a hyperlink to the bookmark's location. You can create a bookmark for any text 
string or image by selecting the item and formatting your selection using the Bookmark command in the Corel 
WEB.DESIGNER Format menu. This procedure makes the new bookmark available to all hyperlinks created within
the document.



Bullet
A dot or other symbol used to differentiate items in a list or to add emphasis.



CD-ROM
Compact Disk Read Only Memory. A way to store data using optical-storage technology. A single CD-ROM disk 
can hold more than 650 megabytes of information, or half a billion characters of text. Unlike floppy disks, you 
can read from but not write to most CD-ROM disks.



Cell
The basic unit in a table in which data is stored. The intersection of a row and a column forms one cell in a table.



CERN
(Centre Europeen pour la Recherche Nuleaire) A European physics laboratory and the birthplace of the World 
Wide Web. For more information on CERN, consult the CERN home page at http://www.cern.ch/.



CGI
(Common Gateway Interface) Add-on programs that run in the browser to eliminate the need for external 
applications. When a user selects a URL that leads to a CGI script, programs launch on the server system to scan
databases, sort names, send e-mail, or perform any other functions.



Check box
A square box that is used to enable or disable an option in a dialog box. An option is enabled when an X or check
mark appears in the check box, and it is disabled when the check box is empty. Click inside a check box to 
enable or disable the option.



Click
To press and release a mouse button.



Clickable Map
An inline image that has several defined regions, each of which are linked to a different location on the World 
Wide Web.



Client-side image map
An image map that encodes the destination URL of each hotspot directly in the page. Client-side image maps do 
not require processing from your server to respond to clicks on the image map; therefore, they are more 
efficient. However, not all browsers support client-side image maps. See also Server-side image map and image 
map.



Clipart
A collection of icons, buttons, backgrounds, animations, and other graphics that can be inserted into Web pages.



Clipboard
A temporary storage area used to hold cut or copied information. You can paste the contents of the Clipboard 
into other programs that support the type of information that has been cut or copied. Information remains on the
Clipboard until another cut or copy command is executed.



Corel Barista
Technology supplied with Corel WebMaster Suite that employs the power of the Java Programming Language to 
produce Web documents.



Corel WEB.MOVE
An application in the Corel WebMaster Suite that allows you to create or edit animations. Completed animations 
can be inserted in your Corel WEB.DESIGNER documents and published on the Web.



Corel WEB.DATA
An application in the Corel WebMaster Suite that enables you to create online catalogs, stock reports, inventory 
lists, data tables, and more. Use Corel WEB.DATA to organize raw database material and publish your documents
on the World Wide Web.



Corel WEB.DRAW
An application in the Corel WebMaster Suite that allows you to create or edit your own graphic files. Completed 
image files may be inserted in your Corel WEB.DESIGNER documents for publishing on the Web.



Corel WEB.GALLERY
An application in the Corel WebMaster Suite that supplies you with thousands of ready-to-use graphic images for 
your Corel WEB.DESIGNER pages. Simply drag and drop the Corel WEB.GALLERY images onto your Corel 
WEB.DESIGNER document to give it color and life.



Corel WEB.PhotoPaint
An application in the Corel WebMaster Suite that allows you to edit images and video files, retouch photographs, 
and create original artwork with powerful, bitmap-based image editing and painting tools. You can edit and 
update images in your Corel WEB.DESIGNER pages by using Corel WEB.PhotoPaint.



Corel WEB.SiteManager
An application in the Corel WebMaster Suite that provides Web-site administrators (“Webmasters”) with 
maintenance, monitoring, diagnostic, and repair facilities for their Internet and Intranet sites.



Corel WEB.WORLD
An application in the Corel WebMaster Suite that allows you to create VRML files. Completed VRML files can be 
inserted in your Corel WEB.DESIGNER documents and published on the Web.



Cursor
Indicates the position of the mouse or equivalent pointing device on the computer screen. Use the cursor to 
select objects or text.



Default settings
Preset options that are built into a program.



Definition
The second of a pair of paragraphs formatted as composing a definition-list entry. The first paragraph is the 
term. See also Term.



Definition List
A list that includes terms and definitions. Definition lists are often used to create dictionaries or glossaries in Web
pages. See also Term and Definition.



Dialog box
A window that is displayed when additional information is needed to perform an action or command. For 
example, when you choose to Save a Corel WEB.DESIGNER document for the first time, the Save dialog box 
appears to prompt you to type a file name and select a location.



Disable
An option is disabled when there is no check mark beside it.



Document window
The window in which a document is displayed.



Double-click
To press and release the left mouse button twice in quick succession.



Download
To move data from a host computer, such as a mainframe, to a smaller client computer, usually through a 
modem or other temporary link. If you transfer any kind of an electronic file from a remote computer to your 
computer, you are downloading that file.



Drag
To select an object and move it with the mouse by holding down the left mouse button. Releasing the button 
completes the action.



Drag and drop
To drag an object to a new location using the mouse — for example, to drag an object from Corel WEB.GALLERY 
into your Corel WEB.DESIGNER document.



Email
The abbreviation for Electronic Mail, a messaging system that also incorporates file transfer. Email transmits 
messages from one person to another using computers and can also send messages to a large number of 
addresses on a mailing list.



Embedded File
A file of any type, including .MPG files, Sun Audio (.AU) and MIDI files, that you can read in your Web browser or 
with accompanying plug-in applications. Corel WEB.DESIGNER's Embedded File command quickly merges files of 
any type with your Web pages to allow you to create more advanced and efficient Web documents.



Enable
An option is enabled when there is a check mark beside it.



Folder
A named section of computer disk space that is used to store and organize your documents, programs, and other
files. For example, in Corel WEB.DESIGNER, you create a server root folder for storing your Web documents.



Font
A set of characters in a particular size and style (typeface). A font includes letters, numbers, punctuation marks, 
and other characters.



Form
An advanced way to interact on the World Wide Web that depends largely on CGI scripting. With Corel 
WEB.DESIGNER, you can create forms for a variety of purposes, such as to allow visitors to comment on your 
page or to purchase a product online. Form functions allow you to create and customize virtually any form style 
so that, within minutes, you can create text fields, radio buttons, check boxes, and other form elements.



Frame
A special element that enables you to divide the Web browser window into several scrollable sub-windows. You 
assign a different Web page to each frame when you create a hyperlink to that page.



FTP
(File Transfer Protocol) A common method used to transfer files between remote computers. The most popular 
Internet use is anonymous FTP in which you log in to a remote system using the login name anonymous and type
your full Internet address as the password. With anonymous FTP, you don't need an account on the remote 
computer to access files. Essentially, FTP is a special way to login to a remote Internet site to retrieve or send 
files.



GIF (Graphics Interchange Format)
Originally developed by CompuServe, .GIF's (pronounced "jiff") are designed to take up a minimum of disk space 
and be easily read and exchanged between systems. This format is commonly used to publish images with 256 
or fewer colors to the Internet. 



Gopher
A Client/Server program that makes menus of text-based material available over the Internet. Although Gopher 
spread rapidly across the globe in only a couple of years, it is being largely supplanted by hyperdocuments on 
the World Wide Web. You can perform many functions from Gopher, including FTP, telnet, and searches.



HotJava Browser 
A prototype of a Web browser that displays applications contained in .HTML files and is written in the Java 
Programming Language. The data viewed in standard Web browsers is limited to text, illustrations, and low-
quality sounds or videos, but with the HotJava Browser, you can add interactive science experiments, games, 
specialized shopping applications, interactive advertising, and even customized newspapers.



Hotspot
A defined hypertext region. A hotspot is the source anchor of a hyperlink and is typically highlighted or otherwise
distinguished from standard text.



HTTP
(HyperText Transport Protocol) The protocol for moving hypertext files across the Internet. Requires a HTTP client 
program on one end, and an HTTP server program on the other end. The HyperText Transfer Protocol 
abbreviation (http) appears at the beginning of all World Wide Web addresses (e.g., http://www.corel.com).



HTML
(HyperText Markup Language) The coding language used to create hypertext documents on the World Wide Web.
HTML is a tag-based language that allows you to surround text blocks with codes that control their appearance. 
More importantly, HTML allows you to create hypertext documents by linking a word or phrase to another 
Internet file. HTML files are viewed using a World Wide Web Client Program, such as Netscape Navigator or 
Microsoft's Internet Explorer.



HTML 2.0
An HTML standard that defines the conformance of HTML documents (Web pages) and certain aspects of HTML 
user agents (Web browsers).



HTML 3.0
HTML 3.0 is a set of extensions to the standard HTML coding specifications. HTML 3.0 extensions include support 
for fill-out forms, tables, mathematical equations, and floating figures.



Hyperlink
A relationship between two anchors. Internal hyperlinks connect information stored on the same database and 
external hyperlinks connect information stored on different databases.



Hypermedia
A concept that combines the principles of hypertext with graphic, sound, and video applications.



Hypertext
Any text that links directly to other Web documents. 



    Icon
A pictorial representation of a tool, object, file, or other program item. An item is selected by clicking, or 
sometimes double-clicking, on its icon.



Image map
An image map is a file that projects multiple hyperlinks on different regions of an image file. This allows users to 
click a specified region and to jump to the hyperlinked Web page defined for that area. Corel WEB.DESIGNER 
handles client-side and server-side image mapping. See also Server-side image map and Client-side image map.



Import
Import is an operation that converts a selected file into a file format recognized by the current application. The 
converted file is then opened in the current application. 



Indent
A Paragraph-text formatting option. An indent positions text a specific distance from the left and/or right frame 
borders. Indents are often used to indicate the beginning of a paragraph.



Inline image
An image that is embedded in a line of text rather than in its own window. 



Internet
The vast collection of inter-connected networks that use TCP/IP protocols and that evolved from the ARPANET of 
the late 60s and early 70s. The Internet connects thousands of remote computers to an extensive global 
network.



Internet Explorer
An advanced browsing application created by the Microsoft Corporation. Internet Explorer can be used to view 
HTML pages on the World Wide Web.



Java Programming Language
A programming language invented by Sun Microsystems. It was specifically designed for writing programs that 
can be safely downloaded from the Internet and immediately run without fear of viruses or other harm to your 
system. Small Java Powered programs are called applets.



Java Powered applet
A short program written in the Java Programming Language that is attached to a Web page and executed by the 
browser machine.



JPEG Bitmap (.JPG)
The file name extension for Joint Photographic Experts Group — a graphic format supported by Corel 
WEB.DESIGNER and most Web browsers.



Link
A relationship between two anchors. Internal hyperlinks connect information stored on the same database and 
external hyperlinks connect information stored on different databases.



List
A group of paragraphs formatted to indicate membership in a set or in a sequence of steps. In Corel 
WEB.DESIGNER you can create ordered, unordered, and definition lists.



List box
A control that allows you to select from a list of options. If the list cannot accommodate all available options, 
scroll bars are provided. List boxes are found on toolbars and in dialog boxes.



Marquee
A region on a Web page that displays a message that scrolls horizontally. 



Maximize
To enlarge an Application Window to a full-size screen.



Menu
A list of commands that appears when you click a name in the Menu Bar.



Menu Bar
The bar near the top of the Corel WEB.DESIGNER Application Window that contains the names of the program 
menus. Click a menu name to display a list of commands used to access various functions.



Merge
To combine objects into one. In Corel WEB.DESIGNER you can merge frames or cells in a table.



Minimize
To reduce an Application Window to an icon on the Docking bar.



MUS files
Standard Corel WEB.WORLD files that, in combination with the Corel WEB.WORLD view, allow visitors to 
experience all of the features of your three-dimensional world, such as attached text and sound, walking shows, 
moving wallpaper, and movies.



NCSA
The National Center for Supercomputing Applications at the University of Illinois at Champaign-Urbana, the home
of the Mosaic Web browser.



Nested list
A list that is contained within another list. Nesting is supported by most Web browsers.



Netscape Extensions
Unique HTML tags that were developed by Netscape Communications and recognized by the Netscape Navigator
Web browser.



Netscape Navigator
An advanced Web browser created by Netscape Communications Corporation. Netscape Navigator can be used 
to view HTML pages on the World Wide Web.



Net
An abbreviation used to refer to the Internet.



Newsgroups
An automated message area, usually operated through USENET in which subscribers post messages to an entire 
group on a wide variety of topics. USENET is a world-wide system of discussion groups.



Ordered list
The paragraph style that present a numbered list of items. Also called a numbered list.



Page
A single file of Hypertext Markup Language that can be viewed with a Web browser. Typically these pages 
combine text, images, and multimedia features and include hypertext links that jump to other Web pages. One 
of the most common Web pages is the home page, which acts as an entry point to a series of Web pages.



Page hit counter
A page hit counter is a CGI script that can be added to your Web page to count the number of visitors that have 
accessed your Web page. 



Page performance indicator
An indicator found on the Status bar of the Corel WEB.DESIGNER Application Window that estimates the amount 
of time required to download the current Web page. The Page Performance Indicator is a dynamic feature that 
changes immediately as new items are added to your Web document. 



Paragraph
A character, line, or block of text ended by pressing ENTER. Any time you press ENTER while typing or editing 
text, you create a new paragraph.



Paste
To place an item stored in the Windows Clipboard into the active area.



Path name
Directions to a folder or file on your system.



PCX
The filename extension for bitmap files created by paint programs such as PC Paintbrush. Corel WEB.DESIGNER 
converts .PCX files to .GIF or .JPG format for publication on the Web.



Pixel
The smallest resolvable element of a computer image. A pixel is rectangular and is either displayed on a screen 
or stored in memory.



Plug-ins
Software add-on programs that extend the capabilities of a Web browser in a specific way. Plug-in applications 
allow you to access file types that are unsupported by your browser. For example, some plug-in applications 
allow you to play audio samples or to view movie clips directly from your Web browser.



Properties
The characteristics or attributes of an HTML element. With Corel WEB.DESIGNER, you can adjust an element's 
attributes by double-clicking the element or by selecting it and choosing Edit, Properties. Many Web elements 
have their own Properties dialog boxes that can be used to change the feature's appearance or characteristics. 
For example, one way to edit a table that you have already inserted in your Web document is to choose Table, 
Table Properties.



Protocol
A method of accessing a document or service over the Internet, such as File Transfer Protocol (FTP) or HyperText 
Transfer Protocol (HTTP). 



Redo
The Redo command allows you to repeat commands that were previously undone by the Undo command.



Refresh
The Refresh command redraws the active window.



Right-click
To press and release the right mouse button.



Script
A script (macro) is a computer program that executes a series of instructions with a single command. Generally, 
scripts are used to automate repetitive tasks or simplify complicated actions, but they can also prompt for user 
input, display messages, and interact with other applications.



Scroll
To shift the view in the Document Window to see portions of a document that are outside the current viewing 
area. Scroll bars along the edges of the Document Window enable you to shift the view horizontally and 
vertically.



Select
To choose an item with your mouse. After an object is selected, you can choose a command or perform an action 
to edit the object.



Server
A computer that shares its resources, such as printers and files, with other computers on the network.



Server-side image map
An image that sends the coordinates of the cursor to a CGI handler routine on the server. Server-side image 
maps require your server to compute the target URL of the hyperlink based on the cursor coordinates. See also 
Client-side image map and image map.



Site
A file section of a computer where particular documents reside; for example, a Web site, a Gopher site, or an FTP
site. Web sites are addressed locations on the Internet that provide access to a set of HTML documents that 
correspond to a particular URL. A Web site consists of a Web server and a named collection of Web documents 
that are both accessible through a single URL.



SGML
(Standard Generalized Markup Language) A markup language used to define document structure. An open 
document-definition language used frequently in the publishing industry. Document elements such as headings, 
subheadings, and body text are defined by different tags. SGML is an international standard, and SGML 
documents are application and platform independent. HTML, a subset of SGML, is used to define documents for 
the World Wide Web.



Split
To divide into parts or portions. In Corel WEB.DESIGNER you can split frames or cells in a table.



Status Bar
An on-screen display area that shows information about such things as objects, ongoing operations, and mouse 
position. You can specify the Status Bar's contents, appearance, and location within the Corel WEB.DESIGNER 
Application Window.



Surfing
Navigating or moving (virtually) from computer to computer on the Internet and usually not staying too long in 
one place.



Tab

A set amount of space that is inserted in the current line when you press TAB. The spot where the insertion point 
stops is called a tab stop.



Tag
A collection of formatting attributes that are applied to paragraphs, selected characters, and tables. Items are 
formatted with tags to ensure that each item with the same tag looks identical. 



Table
An HTML 3.0 specification that allows you to create customized organizational charts, calendars, schedules, and 
more. Customized layout, alignment, and sizing options allow you to produce unique, structured, visually 
appealing Web pages. Your table's cells can hold most HTML elements, and although text remains the most 
popular element, online tables can also integrate images, image maps, and other tables.



Telnet
The command and program used to log in from one Internet site to another. The telnet command and program 
transport you to the login prompt of another host.



Template
A collection of sample files stored in HTML format. You can open a template and easily edit its contents to create 
customized documents.



Term
The first of a pair of paragraphs formatted as a definition list entry. The second paragraph is the definition.



TGA
A bitmap image file format that uses the extension .TGA. Corel WEB.DESIGNER converts .TGA files to .GIF or .JPG 
format for publication on the Web.



.TIF Bitmap
The file name extension for Tagged Image File Format — a bitmap graphic format.



Title Bar
The bar along the top of a Windows application that contains the name of the application and the Maximize, 
Minimize, and Close buttons.



Toolbar
A set of icons or buttons that provide quick, one-step access to commonly used menu commands and features.



Transparency (in inline Internet images)
In Web pages, all bitmap graphics are rectangular and obscure the background color of your Web page unless 
you create a transparent background. When you publish Corel WEB.DRAW artwork to Corel WEB.DESIGNER, you 
can make them transparent by clicking Tools, Options in Corel WEB.DESIGNER and enabling the Enable 
Transparency When Publishing To Corel WEB.DRAW command. Each pixel that has the background color value is 
rendered transparent, allowing the background color of the Web browser to show through. Note that 
transparency cannot be achieved with HTML tags.



Undo
The Undo command removes the effect of the most recent action.



Unordered list
A paragraph style that creates a single list element, usually indicated by a bullet character. Also called a bulleted
list.



Upload
To move data from a smaller client computer to a host computer such as a mainframe, usually through a modem
or other temporary link. If you transfer any kind of an electronic file from your computer to a remote computer 
you are uploading that file.



URL
(Uniform Resource Locator) A World Wide Web address or identifier used to locate specific information sites on 
the Web. The most common way to use a URL is to type the address into a WWW browser program, such as 
Netscape Navigator, or Microsoft Internet Explorer. URLs are preceded by the HTTP protocol (http://).



VRML
(Virtual Reality Modeling Language) A specification for three-dimensional rendering used with Web browsers.



WAIS
(Wide Area Information Servers) A commercial software package that allows indexes of huge quantities of 
information and makes the indexes searchable across networks. WAIS search results are ranked (scored) 
according to the relevance of the hits.



Web
An abbreviated term that refers to the World Wide Web.



Web browser
A browser is a computer program used to view a Web document. A browser allows you to see Web files and to 
access or load additional files as you request them by their URL addresses.



Web document
A Web document is an ASCII text file that includes Hypertext Markup Language (HTML) tags. One or more related
Web documents comprise a Web publication.



Window
A rectangular box in which applications are displayed on the screen. Most Application Windows have a Title Bar 
and Menu Bar along the top and Scroll bars along the side and/or bottom.



World Wide Web
(WWW) The World Wide Web is a hypertext-based, information-distribution system created by researchers at 
CERN in Switzerland. Web clients (browsers) can access multi-protocol and hypermedia information using an 
addressing scheme based on the HTTP protocol (http://).



WRL files
Files that conform to the VRML 1.0 standard used by the most popular Web browsers (i.e., Netscape 2.0) that 
have a three-dimensional plug-in. WRL files allow visitors to navigate through a three-dimensional world and to 
view all of the paints, wallpapers, pictures, and links to URLs. 



WYSIWYG 
(What-You-See-Is-What-You-Get) A term that describes a program's ability to provide an accurate on-screen 
representation of what an image or document will look like when it is printed.



Shortcuts

Pressing this... Does this...
F7 Performs a spell check on the current document.
F12 Launches a browser directly from the Corel WEB.DESIGNER Application Window to 

allow you to preview the current document on the World Wide Web.
F3 Activates the search specified in the Find dialog box.
BACKSPACE Removes the last character or image.
CTRL + N Opens a new Corel WEB.DESIGNER Application Window.
CTRL + O Opens the Open dialog box to allow you to open a local Web page or a Web page 

from the Internet.
CTRL + T Opens the Templates dialog box to allow you to create a new Web document from 

a predesigned template.
CTRL + S Saves the current Corel WEB.DESIGNER document.
CTRL + P Opens the Print dialog box to allow you to print the current Web document.
CTRL + Z Reverses the most recent action performed in the Corel WEB.DESIGNER 

Application Window.
CTRL + SHIFT + Z Reverses the action performed by the Undo command.
CTRL + X Removes the selected item(s) from your document and copies it to the Clipboard. 

The selected item(s) replaces any previous Clipboard contents.
CTRL + C Copies selected item(s) to the Clipboard and replaces any previous Clipboard 

contents.
CTRL + V Adds a copy of the Clipboard contents to your Web document at the current cursor

location.
Del Deletes the selected text or object without copying it to the Clipboard.
CTRL + A Selects the contents of your current Web page.
CTRL + F Opens the Find dialog box to allow you to search for text and other Web page 

elements such as fonts, styles, and special characters.
CTRL + H Opens the Replace dialog box to allow you to replace a search string with new text

or objects.
CTRL + W Opens a new Corel WEB.DESIGNER Application Window to allow you to view 

multiple HTML pages simultaneously.
CTRL + R Refreshes the Corel WEB.DESIGNER Application Window.
ENTER Inserts a blank space and moves your cursor to a new line in your Corel 

WEB.DESIGNER document (hard return).
SHIFT + ENTER Moves your cursor to a new line in your Corel WEB.DESIGNER document (soft 

return).
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HTML tag reference
Corel WEB.DESIGNER allows you to create HTML Web pages without ever having to edit a single line of HTML 
code. However, if you’re already familiar with HTML, here is a list of standard HTML tags, popular extensions, and
a description of their function in Corel WEB.DESIGNER.

HTML tag Icon Description Corel WEB.DESIGNER Operation

<A HREF=> Hyperlink Formats the selected text or object as a 
hyperlink. You can also click Format, 
Hyperlink to create a jump.

<ABBREV> Abbreviation Applies the Abbreviation attribute to 
selected text.

<ACRONYM> Acronym Applies the Acronym attribute to selected 
text.

ALIGN=CENT
ER or 
<CENTER>

Align Center Centers selected text.

<APPLET> N/A Applet Inserts a predesigned Java Powered 
applet.

<AU> Author Applies the Author attribute to selected 
ext.

<B> Bold Applies the Boldface attribute to selected 
text.

<BLOCKQUO
TE>

N/A Block 
Quotation

Applies the Block Quotation style in the 
Style selection box of the Formatting 
toolbar. You can also click Format, Block 
Quotation to specify this tag.

<BR> Line Break Inserts a Line Break.

<CITE> Citation Applies the Citation attribute to selected 
text.

<CODE> Example Code Applies the Example Code attribute to 
selected text.

<DEL> Deleted Text Applies the Deleted Text attribute to 
selected text.

<DFN> Definition Applies the term Definition attribute to 
selected text.

<EM> Emphasis Applies the Emphasis attribute to selected 
text.

<FONT 
COLOR=>

Font/Cell Color Specifies a color attribute to add to 
selected text.



<FONT 
FACE=>

N/A Font Typeface Specifies a font typeface in which to 
display selected text.

<FONT 
SIZE=>

N/A Font Size Specifies Font Size (from 1 to 7) or font 
size relative to the current text size (+/-7) 
from the Font Size list box on the 
Formatting toolbar. 

<H1>, 
<H2>, 
<H3>, 
<H4>, 
<H5>, <H6>

N/A Heading 1 
through 6

Formats selected text in heading style. 
Click Format, Heading to add heading 
styles to your document.

<HR> Horizontal 
Rule

Selects the Horizontal Rule option from the
Insert menu and inserts a horizontal rule.

<I> Italic Applies the Italics attribute to selected 
text.

<IMG> Image Selects the Image option from the Insert 
menu.

<INS> Inserted Text Applies the Inserted Text attribute to 
selected text.

<KBD> Typed Text Applies the keyboard or Typed Text 
attribute to selected text.

<OL>, <LI> Ordered List Creates an Ordered (numbered) List from 
selected paragraphs. You can also click 
Format, Ordered List to create an ordered 
list from selected paragraphs. You can 
create a new ordered list by clicking 
Insert, Ordered List.

<P> N/A Paragraph Inserts a new Paragraph.

<P 
ALIGN=RIGH
T>

Align Right Specifies right alignment of a selected 
paragraph.

<P 
ALIGN=LEFT
>

Align Left Specifies left alignment of a selected 
paragraph.

<PERSON> Surname or 
Person

Applies the Person attribute to selected 
text.

<PRE> N/A Preformatted Selects Preformatted in the Style Selection
list box of the Formatting toolbar. You can 
also click Format, Preformatted Text to 
specify this tag.

<Q> Short 
Quotation

Applies the Short quotation attribute to 
selected text.

<S> Strike-through Applies the Strike-through attribute to 
selected text.



<SAMP> Literal 
(Sample)

Applies the Sample attribute to selected 
text, corresponding to the <SAMP> tag.

<STRONG> Strong 
Emphasis

Applies the Strong Emphasis attribute to 
selected text.

<TT> Typewritten or 
Teletype

Applies the Typewritten or teletype 
attribute to selected text.

<U> Underline Applies the Underline attribute to selected 
text.

 <UL>, <LI> Unordered List Creates an Unordered (bulleted) List from 
selected paragraphs. You can also choose 
Format, Unordered List to create an 
unordered list from selected paragraphs. 
You can create a new unordered list by 
clicking Insert, Unordered List.

<VAR> Variable Applies the Variable attribute to selected 
text.

HTML 
Forms:
<FORM> Form Creates a new form. You can also create a 

new form by choosing Insert, Form.

<INPUT 
TYPE="text"
>

Text field Creates a new text field. You can also 
create a new text field on a form by 
clicking Insert, Form Field, Text Field.

 <INPUT 
TYPE="submi
t"

Button Creates a new button. You can also create 
a new button on a form by clicking Insert, 
Form Field, Button.

<INPUT 
TYPE= 
"checkbox">

Check Box Creates a new check box field. You can 
also create a new check box field on a 
form by choosing Insert, Form Field, Check
Box.

<INPUT 
TYPE= 
"radio">

Radio button Creates a new radio button. You can also 
create a new radio button on a form by 
clicking Insert, Form Field, Radio Button.

<SELECT> Selection list 
or menu

Creates a new selection list or menu. You 
can also create a new selection list or 
menu on a form by clicking Insert, Form 
Field, List/Menu.

HTML 
Tables:
<TABLE> Table Opens the Table Properties dialog box to 

insert a table. You can also create a table 
by clicking Table, Insert Table.

BORDER N/A Table Border Regulates the size of the border (in pixels) 
that outlines your table's cells. It acts as 



an HTML attribute to the <TABLE> 
command (<TABLE BORDER="x">). If you 
specify zero as the border value, Corel 
WEB.DESIGNER surrounds your table with 
a dotted line, but no border will appear in 
your Web browser window. The table 
border value defaults to zero.

CELLPADDIN
G

N/A Cell Padding Regulates the amount of space (in pixels) 
between the edge of a cell. Avoid setting a
cell padding of zero on a table that has 
borders. This prevents the edges of your 
text from touching the cell borders. 
CELLPADDING acts as a HTML attribute to 
the <TABLE> command and appears as 
<TABLE CELLPADDING="x">. The 
cellpadding attribute defaults to zero.

CELLSPACING N/A Cell Spacing Regulates the amount of space (in pixels) 
between individual cells in a table and 
between a table's cells and the border. 
The cellspacing value defaults to zero.

ALIGN N/A Table 
Alignment

Aligns your table in your Corel 
WEB.DESIGNER document and offers left, 
right, center, and default alignment 
options. The default setting aligns your 
table to the left margin.

WIDTH N/A Table Width Regulates the amount of space that your 
table occupies across the width of the 
page. WIDTH may be set in pixels or as a 
percentage. It acts as an attribute to the 
<TABLE> command in HTML and appears 
as <TABLE WIDTH="x">.

<TR></TR> N/A Table Row Adds a row to the table in your active 
document. The number of TR entries listed
in the HTML source code directly 
corresponds to the number of rows 
specified in the Table Properties dialog 
box.

<TD></TD> N/A Data Cell Specifies a standard table data cell and 
only appears within the <TR> and </TR> 
container tags in HTML. If you specify 
different numbers of cells in each row, 
Corel WEB.DESIGNER pads shorter rows 
with blank cells. A cell can contain any of 
the HTML elements that are normally 
present in the body of a Web page.

<TH></TH> N/A Header Cell Specifies a standard table header cell and 
only appears within the <TR> and </TR> 
container tags in HTML. Text contained in 
the header cell is displayed in bold.

 Note
· Some of the HTML tags you can specify with Corel WEB.DESIGNER may not be supported by all Web browsers.
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Trademarks and registered trademarks
The following list identifies all the trademark and registered trademark product, feature, and company names 
appearing in the Help file:
Corel® WebMaster Suite
Corel® WEB.DESIGNER
Corel® WEB.DATA

Corel® WEB.PhotoPaint 
Corel® WEB.WORLD
Corel® WEB.GALLERY
Corel® WEB.DRAW
Corel® WEB.MOVE
Corel® WEB.SiteManager
WebSite 1.1 - Trademark of O'Reilly & Associates, Inc.
Netscape Navigator  3.0
Microsoft® Internet Explorer
Macromedia®
PageDepot

Java     Programming Language
HotJava  Browser
Java  Powered applet
Java and other Java-based names and logos are trademarks of Sun Microsystems, Inc. and refer to Sun’s Java 
Technologies.
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More advanced Web sites
Corel WEB.DESIGNER is based on technology developed by Macromedia Inc. Macromedia's products include 
Backstage, a visual Web site development environment. Backstage consists of Backstage Server, the Backstage 
Object Library, and the Backstage Designer.
· Backstage Designer allows users to browse, edit, and create documents for the Web that include Backstage 

Objects in a WYSIWYG environment.
· Backstage Objects let users create robust database front-ends, discussion groups, forms to email, login and 

authentication, and more, in an easy to use drag and drop environment.
· Backstage Server is designed to execute the Backstage Objects, creating pages dynamically as they are 

requested by the Web browser.
For further information, check the Macromedia site at http://www.macromedia.com.
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Designing tables
Tables are an extremely powerful tool on the World Wide Web, not only for the placement of data, but also for the
placement of graphics and images on a Web page. Using Corel WEB.DESIGNER’s table functions, you can create 
organizational charts, calendars, schedules, and more for your Web document. Customized layout, alignment, 
and sizing options allow you to produce unique, structured pages. 
Whenever you use tables in your Web pages, be aware that not all browsers can understand and display tables. 
However, the latest versions of the most popular browsers recognize and display tables accurately. Always know 
your audience well and consider their needs carefully before incorporating advanced HTML features into your 
Web site.

 Note
· Table cells can hold most HTML elements, and although text elements remain the most popular, online tables 

can also integrate images, image maps, and other tables.

For more information see the following:
{button ,JI(`',`Getting started with tables')} Getting started with tables
{button ,JI(`',`Modifying table elements')} Modifying table elements
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Getting started with tables
The basic structure of your table is defined in the Table Properties dialog box in Corel WEB.DESIGNER. To get 
started, define the number of rows and columns that you want in your table. As you begin to enter text and data 
into the table cells, you may want to add or delete columns, rows, or individual cells. You may also want to 
merge and split cells in your table. Corel WEB.DESIGNER allows you to make all of these changes.
A table allows you to display text in side-by-side paragraphs or to arrange text beside graphics. Tables can also 
be used to simulate columns of text.

 Note
· The Table Properties dialog box, which is produced by clicking Table, Insert Table, displays the default options 

for each listed table property. The dialog box produced by clicking Table, Table Properties from within a current 
table, allows you to modify that table's alignment, width, and layout attributes. You can alter the number of 
rows and columns in a table by using the Insert and Select commands.
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Creating a new table
To add a table to your Corel WEB.DESIGNER page, use the Insert Table command in the Table menu or click the 
toolbar button. Corel WEB.DESIGNER makes it easy to add sophisticated HTML tables to your Web pages.

To create a new table
1. Position your cursor at the point in your Corel WEB.DESIGNER page where you want to insert a table.
2. Click Table, Insert Table.

Corel WEB.DESIGNER opens the Table Properties dialog box.
3. Type the values for the number of rows and columns you want to have in your table in the Row and Column 

boxes.
4. Specify the alignment, width, and layout of the cells in the table.

 Tip

· You can also create a new table by clicking .
 Note

· The Table Properties dialog box, which is produced by clicking Table, Insert Table, displays the default options 
for each listed table property. The dialog box produced by clicking Table, Table Properties from within a current 
table, allows you to modify that table's alignment, width, and layout attributes. You can alter the number of 
rows and columns in a table by using the Insert and Select commands.
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Adding cells, rows, and columns
If, after adding a table to your Corel WEB.DESIGNER Web page, you decide that your table should have been 
larger or smaller, you can add additional cells, rows, and columns to the table by using the Table, Insert 
commands.

To add cells to a current table
1. Position your cursor at the point within the table where you want to insert an additional cell.
2. Click Table, Insert Cell.

To add rows or columns to a current table
1. Position your cursor at the point in your table where you want to insert an additional row or column.
2. Click Table, Insert Rows/Columns.
3. In the Insert Rows/Columns dialog box, enable the Insert Rows or the Insert Columns check box.
4. Type the number of rows in the Number of Rows box or the number of columns in the Number of Columns box.
5. Enable the Above Selection or Below Selection button to specify the placement of the rows or columns that 

you want to insert.
 Notes

· The Table Properties dialog box, which is produced by clicking Table, Insert Table, displays the default options 
for each listed table property. The dialog box produced by clicking Table, Table Properties from within a current 
table, allows you to modify that table's alignment, width, and layout attributes. You can alter the number of 
rows and columns in a table by using the Insert and Select commands.

· Cells, rows, and columns can be inserted by right-clicking inside the table and choosing the appropriate 
command from the pop-up menu.
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Selecting cells, rows, or columns
The Table menu of Corel WEB.DESIGNER contains options to allow you to select a cell, row, or column. The ability
to select cells is useful for copying or modifying the cells in the table. 

To select a table
· Position your cursor inside the table, and click Table, Select Table.

Corel WEB.DESIGNER selects the entire table and its contents.

To select cells, rows, or columns
1. Position your cursor inside the cell, row, or column that you want to select.
2. Click Table, Select Cell, Table, Select Row, or Table, Select Column.

Corel WEB.DESIGNER selects the corresponding portion of the table.
3. Modify the cell, row, or column.

 Notes
· Cells, rows, and columns can be selected by right-clicking inside the table and choosing the appropriate 

command from the pop-up menu.
· You can cancel the selection by clicking any point on the Corel WEB.DESIGNER screen.
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Deleting cells, rows, or columns
The Table menu in Corel WEB.DESIGNER provides you with the commands you need to delete cells, rows, and 
columns in your table. 

To delete rows or columns
1. Position your cursor in the row or column that you want to delete.
2. Click Table, Delete Row or click Table, Delete Column.

To delete cells
1. Position your cursor inside the cell you want to delete.
2. Click Table, Delete Cell.

 Note
· Cells, rows, and columns can be deleted by right-clicking inside the table and choosing the appropriate 

command from the pop-up menu.
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Merging and splitting cells
The Table menu in Corel WEB.DESIGNER provides you with the commands you need to merge or split cells in 
your table. Use the Merge Cells command to combine the contents of the selected cells to form a single cell. Use 
the Split Cells command to divide the cells into columns or rows. You can split cells horizontally and vertically.

To merge cells
1. Highlight the cells in your table that you want to merge.
2. Click Table, Merge Cells.

The selected cells are combined into one cell.

To split cells
1. Highlight the cell in your table that you want to split.
2. Click Table, Split Cells
3. In the Split Cells dialog box, enable the Horizontally or Vertically check box.
4. Type the number of horizontal rows or vertical columns into which you want to split the cell.

The selected cell is divided into the specified number of rows or columns.
 Notes

· The Merge Cells command in only available when two or more cells are selected and the selected cells form a 
rectangle.

· The Split Cells command is only available when you have selected a single cell in a table.
· Cells can also be merged or split by right-clicking inside the table and choosing the appropriate command from

the pop-up menu.
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Modifying table elements
After you have created a table in Corel WEB.DESIGNER, you can edit or modify its properties by clicking Table, 
Table Properties. The Table menu in Corel WEB.DESIGNER contains menu items to help you make additional 
alterations to the table. Customized layout, alignment, and sizing options allow you to produce unique, 
structured pages. You can use the Cell Properties command to define the properties of the cells in the table.

 Note
· Cells, rows, and columns can be inserted or deleted by right-clicking inside the table and choosing the 

appropriate command from the pop-up menu.
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Specifying boundaries in the Table Properties dialog box
Once you have added a basic table structure to your Corel WEB.DESIGNER document, you can customize the 
table's attributes to suit the data it will display.

To specify boundaries in the Table Properties dialog box
1. Click Table, Insert table.
2. Determine the number of rows and columns that best present your table's material and type the 

corresponding numbers in the Table Properties dialog box.
3. Set the width of your table in pixels or as percentages. Disable the Width check box to allow to size the cells 

according to their contents.
4. Select an alignment for your table from the Alignment list box.

The Corel WEB.DESIGNER alignment option defaults to the left margin and controls the alignment of the 
contents of cells.

5. Modify the table's border, cell padding, and cell spacing by inserting pixel values in the appropriate fields.
 Notes

· Because the primary function of all tables is to present data in a concise, attractive manner, it's important to 
test your table's appearance by inserting alternate values and choosing the most appealing format. To choose 
the most effective values for your table's boundaries, insert values in the number boxes and preview the 
results until you achieve the best appearance.

· If you specify zero as the Table Border value in the Table Properties dialog box, Corel WEB.DESIGNER surrounds
your table with a dotted line, but no border will appear in your Web browser window. The Table Border value 
defaults to zero.

· Avoid a Cell Padding value of zero in a table that has borders. This prevents the edges of your text from 
touching the cell borders. The Corel WEB.DESIGNER Cell Padding option in the Table Properties dialog box 
defaults to zero.
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Setting your table's background color
After you have created and modified your table's structure, you can use Corel WEB.DESIGNER's advanced 
coloring features to change the background color of your table's cells and rows or of the entire table.

To adjust the background color of your online table
1. Select the cell or row you want to color or click Table, Select Table to select the entire table.
2. Click .

3. Choose a color from the Font/Cell color list box.
 Note

· To customize the color of your table's background, click  and choose Custom Color. Corel WEB.DESIGNER 
opens a Color dialog box that allows you to specify the exact shade of your table's background.
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Defining the cell properties
After you have added a table to your Corel WEB.DESIGNER Web page, you can use the Cell Properties dialog box 
to define the properties of the individual cells in the table.

To define the cell properties
1. Select a single cell for which you want to define the cell properties.
2. Click Table, Cell Properties.
3. Specify the Width and Alignment of the cell in the table.
4. Enable the Data button to display the cell contents in normal font or enable the Header button to display the 

cell contents in bold font. 
5. Change the height of the selected cell using the Number Of Spanned Rows and Number Of Spanned Columns 

boxes.
 Note

· Disable the width check box in the Cell Properties dialog box to allow the cell to size according to its contents.

{button ,AL(`PRC Modifying table elements;',0,"Defaultoverview",)} Related Topics



Inserting a table within a table
In Corel WEB.DESIGNER, it is possible to insert a table within the cell of another table. 

To add a table to a table
1. Position your cursor in the table cell where you want to insert the new table.
2. Click Table, Insert Table. 

Corel WEB.DESIGNER opens the Table Properties dialog box. The new table is defined in exactly the same way 
as you defined the original table.

 Tip

· You can also insert a table by clicking .
 Note

· Inserting a new table within an existing table may have a profound effect on the appearance of the first table. 
You might want to limit the dimensions of the new table until you see what effect it has on the layout of the 
first table.
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Formatting text
The way information is presented on your Web site will have a big impact on how useful the site is to visitors. 
After you have established the basic properties of your site, you will need to make some important decisions 
about which elements to include.
For example, you might choose to outline the contents of your site with a list of headings and to set up 
hyperlinks between those headings and locations within your site. This is a common practice used to break up 
large sites into smaller information subsets.
How effective your site is at conveying information will also depend on simple things, such as how you make use
of text. HTML supports six levels of headings as well as bold and italicized text. It also supports a number of 
different paragraph styles, such as Block Quotation and Preformatted Text. Proper use of these HTML options will
give your text a polished, professional appearance. You might want to look at some of the Corel WEB.DESIGNER 
templates to get ideas about effective text formatting.
Corel WEB.DESIGNER has all of the tools needed to quickly format text, set up lists and hyperlinks, and set up 
scrolling marquee headings. The Browser Preview option is always available so that you can see exactly what 
you are creating, as you create it!

For more information see the following:
{button ,JI(`',`Working with text')} Working with text
{button ,JI(`',`Inserting and editing marquees')} Inserting and editing marquees
{button ,JI(`',`Formatting ordered unordered and definition lists')} Formatting ordered, unordered, and definition 
lists
{button ,JI(`',`Indenting text')} Indenting text
{button ,JI(`',`Creating hyperlinks')} Creating hyperlinks
{button ,JI(`',`Working with bookmarks')} Working with bookmarks
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Working with text
The Corel WEB.DESIGNER text-editing tools are similar to those found in most word processors. You can enter, 
cut, copy, and paste text with the techniques you use in your favorite word processor. Bold, italic, and underlined
text can be created simply by selecting the text and clicking the appropriate button on the toolbar. Text and 
paragraph styles that are specific to Web page design (i.e., headings and block quotes) are all available from 
menus or toolbar buttons. Text is presented in the Corel WEB.DESIGNER editor as it would appear in most Web 
browsers. Corel WEB.DESIGNER offers you a What You See is What You Get (WYSIWYG) style of Web page design.
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Adding and formatting Web page text
With Corel WEB.DESIGNER, you can add or delete text using the same techniques that are used in a standard 
word processor. You can also copy and paste text or change the formatting of characters, words, and paragraphs 
in your Corel WEB.DESIGNER documents.
Corel WEB.DESIGNER provides the following paragraph style options:
Style Description
Normal Default text formatting.
Heading 1 - Heading 6 Corresponds to the HTML heading tags <H1> through <H6>. 
Preformatted Corresponds to the HTML <PRE> tag that displays text exactly as it is entered, in a

monospace font that retains all line breaks and spaces.
Block Quotation Corresponds to the HTML <BLOCKQUOTE> tag which includes paragraph breaks 

before and after the block quote tag and indentation for the quoted text.

To add text to a Web page
1. Position the cursor at the point in your Corel WEB.DESIGNER document where you want to add text.
2. Type the text.

Corel WEB.DESIGNER displays the text using the default Normal style and Default font.

To specify a different paragraph style 
1. Position your cursor in the line of text that you want to change.
2. Choose a paragraph style from the Text Styles list box found on the Formatting toolbar.

 Note
· Corel WEB.DESIGNER provides other HTML formatting options in the Style and Formatting toolbars and in the 

Insert, Format, and Table menus.
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Copying and pasting text from other applications
Web pages are often based on information created in other applications such as word processors. To avoid 
retyping text that is in external files, you can copy the original text and paste it into your Corel WEB.DESIGNER 
document.
The following options are available from Corel WEB.DESIGNER's Edit menu:
Option Description
Copy [CTRL + C] Copies the selected text to the Windows Clipboard, from which copied text can be 

retrieved.
Paste [CTRL + V] Pastes the copied text into your Web page at your current cursor location. This 

command is especially useful if you want to copy from an existing Web page or 
from another file. See Viewing HTML source code.

Cut [CTRL + X] Cuts the selected text and places a copy in the Clipboard. Used with the Paste 
command, the Corel WEB.DESIGNER cut feature can move text from one portion of
a document or program to another.

 Notes
· To paste HTML-tagged text from the Windows Clipboard into your Web page, you must paste into the HTML 

Source view.
· To open existing HTML pages, click File, Open.
· To merge an .HTML file with your open page, click Insert, HTML File.
· To convert word-processing files from Corel WordPerfect, Microsoft Word, or Lotus AmiPro to HTML, click File, 

Import Word Processor File.
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Adding bold, underline, and other text formats
You can use Corel WEB.DESIGNER's Formatting toolbar to enhance your Web pages with bold, italic, underline, 
color, text style, font, and other character formats. 

To format bold text
1. Select the text you want to appear in bold type.
2. Click .

Corel WEB.DESIGNER displays the text in bold type to indicate that you’ve applied the <BOLD> HTML tag 
to the selected text.

 Notes

· You can also add bold by clicking  and typing the text.
· Follow the same procedure to add italic, underline, color, font, text styles, and the other Formatting toolbar
options to your document.
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Changing the text style
The Corel WEB.DESIGNER Style toolbar provides you with many different styles to use in your Web pages. The 
available styles are: Strike-through, Teletype, Emphasis, Strong Emphasis, Inserted Text, Deleted Text, Code, 
Variable, Sample, Keyboard, Citation, Short Quotation, Author, Person, Definition, Acronym, and Abbreviation. 

To apply the Strike-Through style
1. Select the text you want to appear in the Strike-Through style.
2. Click .

Corel WEB.DESIGNER displays the text in Strike-Through style to indicate that you’ve applied the <S> 
HTML tag to the selected text.

 Note
· Follow the same procedure to add the other Style toolbar options to your document.
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Changing the font size
Corel WEB.DESIGNER uses relative font size to allow you to specify the size of the text in your document. Corel 
WEB.DESIGNER supports font size values between 1 and 7, with the default font size being 3. Use the plus or 
minus characters in the Font Size list box to change the font size relative to the document’s default font. For 
example, if you use a font size of 2 for your text and want to create larger headings, use the +1 font size. The 
new font size of the headings will correspond to 4 (3 base font +1 = 4)

To change the font size
1. Select the text for which you want to change the font size.
2. Choose a new font size from the Font Size list box (found on the Formatting Toolbar).

 Note
· The largest font size you can use is 7 and the smallest font size is 1. Therefore, if you are typing in a size 5 

font and choose the +6 option from the Font Size list box, the resulting font will be size 7 (7 is the largest font 
size possible).
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Finding and replacing text
You can use Corel WEB.DESIGNER's Find and Replace capability to locate particular words and to specify 
substitutions. This feature is particularly useful if you want to locate all occurrences of a word, term, or 
expression in a file.

To find words
1. Click Edit, Find. 
2. In the Find dialog box, type the word or phrase you want to locate in the Find What field.
3. Enable the Match Case check box to locate only those words that match the exact spelling and case of the 

specified term.
4. Click Find Next.

Corel WEB.DESIGNER searches your Web page and selects the first occurrence of the specified term.

To find and replace words
1. Click Edit, Replace.
2. Type the word or phrase you want to find in the Find What field.
3. Enable the Match Case check box to locate only those words that match the exact spelling and case of the 

specified term.
4. Type a replacement term in the Replace With text box.
5. Click Find Next.

Corel WEB.DESIGNER searches your Web page and selects the first occurrence of the specified term.
6. Click Replace to replace a single occurrence of the term or click Replace All to replace every occurrence of the 

specified term on your Web page.
 Note

· You can also open the Find dialog box by pressing CTRL + F or by clicking  on the Corel WEB.DESIGNER 
screen. You can open the Replace dialog box by pressing CTRL + H.
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Blinking text

Use the Blinking Text option in the Format menu to create text that blinks when it is displayed in a Web browser. 

To create blinking text
· Click Format, Blinking Text to enable the blinking text feature.

 Notes
· A check mark appears next to the Blinking Text option in the Format menu to indicate that the blinking feature 

is enabled. The blinking text feature can be disabled by clicking Format, Blinking Text again.
· Blinking text is not supported by all Web browsers. 
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Inserting and editing marquees
In its simplest form, a scrolling marquee is a text insert contained in a defined rectangular area that scrolls 
across your browser window. Marquees can be used to attract attention, advertise a product, announce an event,
or highlight any other important feature of your Web page. After you have designed and inserted the marquee 
feature in your Corel WEB.DESIGNER document, visitors who access your Web page using a browser that 
supports the marquee feature can view the band of text as it scrolls across their browser window. 
By using Corel WEB.DESIGNER's advanced marquee feature, you can customize marquees to suit the structure 
and style of your Web site. The Marquee Properties dialog box allows you to specify and align the in the 
marquee. You can also use the Marquee Properties dialog box to change the marquee's background color, to 
modify the marquee's behavior, to adjust the size and speed of the marquee, or to regulate the number of times 
that the marquee appears on your Web page. The best marquees use all of these advanced attributes to 
highlight or enhance pages.

 Note
· Because marquees are not included in the HTML 2.0 specification, this feature is not supported by all Web 

browsers. To view marquees, preview your documents using Microsoft's Internet Explorer 3.0.
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Inserting marquees
The Marquee command in Corel WEB.DESIGNER's Insert menu allows you to add scrolling bands of text to your 
Corel WEB.DESIGNER documents. After you have inserted a marquee, you can use the Marquee Properties dialog
box to modify its properties.

To insert marquees
1. Position your cursor at the point in your Corel WEB.DESIGNER document where you want to insert a marquee.
2. Click Insert, Marquee.
3. In the Text box, type the text that you want the marquee to display.
4. Adjust the background color, alignment, behavior, speed, direction, and size of the marquee in the Marquee 

Properties dialog box.

To preview marquees
1. Click Tools, Browser Preview.
2. Type the folder name and path that contains Microsoft Internet Explorer 3.0 executable file (.EXE) or click 

Browse to locate the file on your local system.
 Notes

· Because marquees are not included in the HTML 2.0 specification, this feature is not supported by all Web 
browsers. To view marquees, preview your documents using Microsoft's Internet Explorer 3.0.

· You can create marquees from existing text by selecting the text that you want to marquee and clicking Insert,
Marquee.
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Changing a marquee's background color
You can use the Marquee Properties dialog box to customize the background color of the marquees in your Corel 
WEB.DESIGNER documents. You can choose predefined colors from the Background list box or define your own 
shades in the Color dialog box.

To change a marquee's background color
1. Select the marquee text in your Corel WEB.DESIGNER page.
2. Click Edit, Properties.
3. Do one of the following:

· Choose a color from the Background list box.
· Choose Custom to define your own shade in the Color dialog box.

 Note
· After you have defined a custom color in the Color dialog box, you can click the Add To Custom Colors button 

to make the shade available to your other Corel WEB.DESIGNER documents.
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Aligning marquees with text
Because most marquees appear on Web pages along with normal or static text, Corel WEB.DESIGNER allows you 
to align the marquee with normal text by using the Text Alignment feature in the Marquee Properties dialog box. 

To align marquees with text
1. Select the marquee text in your Corel WEB.DESIGNER page.
2. Click Edit, Properties.
3. Choose Top, Bottom, Center, Left, or Right from the Alignment list box in the Marquee Properties dialog box.
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Changing a marquee's behavior
Although most marquees scroll text across a Web page, you can also create sliding marquees or alternate 
marquees. To modify your marquee's action on your Web page, adjust the specifications in the Behavior section 
of the Marquee Properties dialog box.

To change a marquee's behavior
1. Select the marquee text on your Corel WEB.DESIGNER page.
2. Click Edit, Properties.
3. In the Behavior section of the Marquee Properties dialog box, enable the Scroll, Slide, or Alternate button.

Scrolling marquees scroll text across your Web page, sliding marquees slide into view from the starting 
direction to the opposite window border and remain on screen at all times, and alternating marquees alternate
back and forth from the starting direction to the opposite window border. Alternating marquees also remain on 
screen at all times.
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Changing a marquee's direction
After you have specified the marquee text in the Text box of the Marquee Properties dialog box, you can change 
the direction of the scrolling band of text. With Corel WEB.DESIGNER, you can create marquees that move across
your browser window from left to right or from right to left.

To change a marquee's direction
1. Select the marquee text in your Corel WEB.DESIGNER page.
2. Click Edit, Properties.
3. In the Direction section of the Marquee Properties dialog box, enable the Left or Right button.

The Direction attribute controls the movement of the text across the browser window. Corel WEB.DESIGNER 
specifies Left as the default scrolling direction.
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Adjusting the number of times a marquee repeats
Most marquees currently displayed on the Web scroll continuously across your screen as long as the Web page 
remains active. But with Corel WEB.DESIGNER's advanced marquee options, you can specify the number of times
that the marquee repeats on your Web page.

To adjust the number of times a marquee repeats
1. Select the marquee text in your Corel WEB.DESIGNER page.
2. Click Edit, Properties.
3. Disable the Continuously check box.
4. Type a value in the Times box to specify the number of times you want the marquee to repeat.

 Note
· Corel WEB.DESIGNER enables the Continuously check box by default.
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Adjusting a marquee's speed
Whether you have created a scrolling, sliding, or alternate behavior for your marquee element, you can adjust 
the speed of the marquee in the Marquee Properties dialog box. The Delay option specifies the time in 
milliseconds, before the marquee text is activated on your screen. The Amount option specifies the amount of 
movement, in pixels, that the marquee moves.

To adjust a marquee's speed
1. Select the marquee text in your Corel WEB.DESIGNER page.
2. Click Edit, Properties.

Corel WEB.DESIGNER opens the Marquee Properties dialog box.
3. Type a value in the Delay box to adjust the time in milliseconds before the marquee begins to move on your 

page.
4. Type a value in the Amount box to adjust the amount of movement, in pixels, of the marquee.
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Sizing a marquee
After you have inserted a marquee in your Corel WEB.DESIGNER document, you can adjust its height and width 
to suit the style and layout of your page. You can specify the size of a marquee in pixels or as a percentage.

To size a marquee
1. Select the marquee text in your Corel WEB.DESIGNER page.
2. Click Edit, Properties.
3. Enable the Pixel or Percentage Of Window button in the Height section of the Marquee Properties dialog box. 

Type a value in the corresponding box.
4. Enable the Pixel or Percentage Of Window button in the Width section of the Marquee Properties dialog box. 

Type a value in the corresponding box.
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Formatting ordered, unordered, and definition lists
Many Web sites (especially larger ones) use lists to outline the information they contain. Corel WEB.DESIGNER 
automatically builds and maintains your lists as you add to them. You can choose from ordered (numbered), 
unordered (bulleted), or definition lists. Experiment with each list type to see which one suits your purposes best.
You can even create lists within lists!
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Creating ordered, and unordered lists
Corel WEB.DESIGNER's list features allow you to format entire paragraphs of text as numbered or bulleted lists 
using the Format, Ordered List and Format, Unordered List commands. You can also create numbered or bulleted 
lists by clicking Insert, Ordered List or Insert, Unordered List and adding your list items.

To create a new list
1. Position your cursor where you want to add a new list of items.
2. Click Insert, Ordered List or Insert, Unordered List depending on the type of list that you want to create.

Corel WEB.DESIGNER indents the first number or bullet on your Web page.
3. Type the first list item.
4. Press ENTER to continue your list.
5. To finish the list, press ENTER twice.

To create a list using existing text
1. Select the series of paragraphs that you want to format as a list.
2. Click  or 

 depending on the type of list that you want to create.
Corel WEB.DESIGNER displays the paragraphs you selected as items in a numbered or bulleted list.
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Creating a definition list
A definition list is useful when you want to document a list of items. Definition lists are used to display terms and
their definitions. The Web browser displays the term flush left and indents the definition of that term.

To create a definition list
1. Position your cursor on the line where you want to add a new definition list.
2. Choose Term from the Text Style list box found on the Formatting toolbar.
3. Type first term in the list and press ENTER.

Corel WEB.DESIGNER automatically changes the Text Style to Definition.
4. Type the first definition and press ENTER.

Corel WEB.DESIGNER automatically changes the Text Style back to Term.
5. To finish the list, press ENTER twice to return to the Normal Text Style.
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Creating a nested list
A nested list is a list that contains a second list. Create a nested list in essentially the same manner as you 
created the original list. The nested list will be slightly more indented than the first list.

To create a nested list
1. Place your cursor at the point in an ordered, or unordered list where you want to add a nested list.
2. Click Insert, Ordered List, or Insert, Unordered List depending on the type of list that you want to create.
3. Type the text for each item in the list and press ENTER.
4. Press ENTER twice to return to the next item in your original list.

 Tip
· When you select an insertion point for the nested list, place your cursor at the end of a line in the first list. If 

you place your cursor in the middle of a line, the line will be broken and the remaining half will appear below 
the last item on the nested list.
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Indenting text
When you create a Web page with Corel WEB.DESIGNER, it is important that the information on your page is 
easy to read and understand. A document that contains too much text can be confusing. By adding white space 
to your document, you can help make your Web page visually appealing and easy to understand. The indent 
commands in Corel WEB.DESIGNER allow you to add this necessary white space to your document.
Indenting is also useful when you are creating lists within lists. It is important that the beginning of a new list and
the end of the previous list be clearly defined. Indenting your lists to create different levels will make the lists 
easy to understand.
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Increasing the indent
Use the Increase Indent command to indent the selected paragraph or to increase the nesting level of a 
numbered or bulleted list item. 
Corel WEB.DESIGNER supports an unlimited number of indentation levels. If you indent one or more list items 
that follow a list item, the indented items become a sublist of the preceding list item. 

To increase the indentation of a paragraph

· Click Format, Increase Indent or click  on the toolbar.
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Decreasing the indent
Use the Decrease Indent command to remove the indentation of a paragraph or to decrease the nesting level of 
a numbered or bulleted list item. An indented list item becomes a member of its enclosing list when the indent is
decreased.

To decrease the indentation of a paragraph

· Click Format, Decrease Indent or click  on the toolbar.
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Creating hyperlinks
Even after years of advancement, hyperlinks remain the foundation of the World Wide Web. They provide a fast 
and efficient way to navigate to precise information points. By clicking a hyperlink, you can jump to a different 
Web page or to a new point on the same Web page.
Each time you specify a hyperlink's destination or target reference in the Hyperlink Properties dialog box, you 
must include the file type or protocol. To link to another World Wide Web site, preface the URL with the HTTP 
protocol (http://). To create an email link, preface the address with the mail protocol (mailto://). To link to a 
newsgroup, preface the USENET name with the news protocol (news:).

Additional protocols include:
file:// Internet protocol used to link to a file on a local disk.
ftp:// Internet protocol used to exchange files by linking to an FTP site.
gopher:// Internet document retrieval protocol used to link to a menu-based gopher site.
telnet Internet protocol used for sharing information across multiple networks.
WAIS Internet textual database protocol used to link to a WAIS server.
If you don't know the URL that you want to specify for a hyperlink target, try searching for it on the World Wide 
Web. Complete Internet addresses appear in the Location field at the top of your Web browser's screen. 
Specifying URLs in this manner is a great way to make use of the WEB.DESIGNER copy and paste features.

 Notes
· To create internal links (links that jump to a new point on the same Web page) you must use bookmarks. 

Bookmarks target the jump's destination by tagging a word or phrase.
· You can define hyperlinks for regions of an image by creating an image map (double-click the image and 

choose Image Map from the Image Properties dialog box).
· If you are referencing a Web site that resides on a UNIX server, you must verify the case of each of your 

hyperlink URLs because the UNIX file system is case sensitive.
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Adding, editing, and removing hyperlinks
Hyperlinks distinguish hard-copy publications from online documentation and promote a three-dimensional 
approach to information design. Corel WEB.DESIGNER simplifies the construction of hyperlinks by using toolbar 
buttons and dialog boxes to allow you to mobilize the text and images displayed throughout your document.

To add a hyperlink to a Web page
1. Select the text or image that you want to format as a hyperlink.
2. Click Format, Hyperlink. 

Corel WEB.DESIGNER opens the Hyperlink Properties dialog box.
3. Type the link's destination URL in the URL Of Hyperlink box or click Browse and navigate to the hyperlink's 

target.
Corel WEB.DESIGNER underlines your selected text or image to indicate to users that the selection provides a 
link to another Web page or URL.

To change a hyperlink
1. Double-click the hyperlinked text or object.
2. Modify the destination URL displayed in the Hyperlink Properties dialog box.

To remove a hyperlink
1. Select the hyperlinked text or object.
2. Click Format, Hyperlink.

 Tip

· You can also add or remove a hyperlink by clicking .
 Note

· To access a text and image resource, you need to preface the URL with the Hypertext Transfer Protocol (HTTP) 
reference, e.g., http://myURLaddress. To link to the Corel Home Page, type http://www.corel.com. To link to an 
email address such as myfriend@corp.com, type mailto:myfriend@corp.com. To link to a newsgroup such as 
rec.gardening, type news:rec.gardening.
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Working with bookmarks
Bookmarks are special hyperlinks that are used to navigate within Web documents. You can create several 
bookmarks within a long document and set up a list of hyperlinks at the top of the document that will take the 
reader directly to the bookmarks. Like all hyperlinks, bookmark text is in a different color than the surrounding 
text. The Corel WEB.DESIGNER Bookmark feature will maintain lists of bookmarks within a document and 
automatically sets up hyperlinks with associated text.
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Using bookmarks in a document
A bookmark codes and identifies a specific location within a Corel WEB.DESIGNER document. After you have set 
a bookmark, you can create a hyperlink to the bookmark's location. For example, you can construct a 
hyperlinked table of contents that jumps to a bookmarked section further in the same document.
You can create a bookmark for any text string or image by selecting the item and formatting your selection by 
using the Bookmark command in the Format menu. This procedure makes the new bookmark available to all 
hyperlinks created within the document.

To create a bookmark
1. Select the target text or image.
2. Click Format, Bookmark.
3. Type a name in the Bookmarks text box.

To link to a bookmark
1. Select the text or image that you will use as a hotspot for the jump.
2. Click Format, Hyperlink.
3. Click the Link To Bookmark tab.
4. Choose a bookmark from the Bookmark list box.

 Notes
· To avoid confusion and destination errors, create a bookmark name that is meaningful and that identifies the 

target location.
· If you enable the Bookmark command in the View menu, all bookmarks in your Corel WEB.DESIGNER 

document to be marked with a color that you choose from the Page Properties dialog box in the File menu. The
bookmark color will not show up in a browser window and can be toggled on or off with the Bookmarks 
command in the View menu. Corel WEB.DESIGNER's default bookmark identification color is red.
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Removing bookmarks
After you have labeled a link's target or destination with a bookmark, you can remove the specification from the 
Bookmarks list.

To remove a bookmark
1. Select the bookmarked text or image.
2. Click Format, Bookmark.

Corel WEB.DESIGNER warns you that you are about to remove the bookmark formatting from the current 
selection.

3. Click Yes.
 Notes

· To indicate that text is currently bookmarked, the Bookmark command in the Corel WEB.DESIGNER Format 
menu is displayed with a checkmark. After you remove the bookmark from the text, the checkmark 
disappears.

· When you remove a bookmark attribute, all relative links to that bookmark no longer work, but the hyperlink 
formatting is not removed from your page.
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Helpful hints
Get your Corel WEB.DESIGNER project off to a quick, easy, and problem-free start! The hints in this section will 
help you put your Web site on a fast track toward online success.
Whether you are familiar with previous versions of Corel WEB.DESIGNER or a new Corel WEB.DESIGNER user, the
tips and troubleshooting techniques explored in this section will help you to quickly add advanced HTML 
elements to your documents while avoiding errors.

For more information see the following:
{button ,JI(`',`Tips and tricks')} Tips and tricks
{button ,JI(`',`Troubleshooting errors')} Troubleshooting errors
{button ,JI(`',`HTML Parser Error')} HTML Parser Error
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Tips and tricks
Building a Web site is easier than it may seem. Corel WEB.DESIGNER takes care of tedious HTML coding work 
and lets you concentrate on the content and appearance of your site. Click the How To button in this help window
to access a short list of simple procedures. These procedures will help you to quickly establish the basics of your 
Web site and to get your project under way.

 Note
· The tips and tricks explored throughout this section also serve as excellent refresher points as you design your

Web pages.
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Using Corel WEB.DESIGNER's most popular features
Creating a Web page for the first time can be intimidating — choosing the appropriate software, manuals, 
tutorials, and procedures takes time and often leaves you wondering where to begin. But even more experienced
users can stumble the first time they open a new Web-editing program and begin to familiarize themselves with 
foreign authoring techniques and design approaches.
The following tips and tricks condense and simplify the most popular Corel WEB.DESIGNER procedures to provide
both experienced and novice Web artists with a starting point for their designs.
Opening a Corel WEB.DESIGNER template
Changing a heading size
Setting a hyperlink
Setting a bookmark
Linking to a bookmark
Creating a bulleted list
Adding frames
Adding a table
Using FTP to upload files
Publishing to the Internet
Importing a word processor file
Changing text color
Creating blinking text
Creating a scrolling marquee
Setting background color
Setting a background image
Inserting an image
Merging an .HTML file
Changing an object's properties
Setting a default browser
Previewing your Corel WEB.DESIGNER document
Launching other Corel WebMaster Suite applications
Publishing from other Corel WebMaster Suite applications
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To open a Corel WEB.DESIGNER template
1. Click File, Templates
2. Double-click an .HTM file to open the page in Corel WEB.DESIGNER.



To change a heading size
1. Select the text you want to appear in heading format.
2. Click Format, Heading and choose from Heading 1 to Heading 6.



To set a hyperlink
1. Select the text you want to make into a hyperlink.
2. Click Format, Hyperlink and type the URL of the target destination or click the Browse button to locate a target

that resides on your local system.



To set a bookmark
1. Select the target text or image.
2. Click Format, Bookmark and type an identifiable name for your selection.



To link to a bookmark
1. Select the text or image to use as a hotspot for the jump.
2. Click Format, Hyperlink and click the Link to Bookmark tab.
3. Select the name of the target bookmark from the Bookmarks list box.



To create a bulleted list
1. Click Insert, Unordered List.
2. Type the text for your list's first entry and press ENTER.
3. Repeat Step 2 until the list is complete and press ENTER twice.



To change text color

1. Select the text you want to color and click .
2. Choose a color from the Font/Cell Color list box.



To set a background color
1. Click File, Page Properties.
2. Choose a color from the Background Colors list box.



To specify a background image
1. Click File, Page Properties.
2. Type the filename for your background image or click the Browse button to locate the file.



To insert an image
1. Click Insert, Image to open the Image Properties dialog box.
2. Type the filename for the image you want to add to your Web page or click the Browse button to locate the 

file.
3. Modify the alignment, spacing, and scaling of your image in the Image Properties dialog box.



To merge an .HTML File
1. Click Insert, HTML File.
2. Type the filename for the .HTML file you want to add to your Web page.



To change an object's properties
1. Double-click the object or select the object and click Edit, Properties.

Corel WEB.DESIGNER opens the object's Properties dialog box.
2. Make the appropriate changes to properties such as alignment, spacing, scaling, or alternative text.



To set a default browser
1. Click Tools, Set Browser.

Corel WEB.DESIGNER opens the Select HTML Browser dialog box.
2. Type the directory path for the browser that you want to specify as the default or click Browse to locate the 

browser application.



To preview your Corel WEB.DESIGNER document

· Click Tools, Browser Preview or choose  from the Standard toolbar.



To launch other Corel WebMaster Suite applications from within Corel WEB.DESIGNER
· Click Tools and choose the application that you want to launch.



To publish work from other Corel WebMaster Suite applications back to Corel WEB.DESIGNER
· Click File, Publish to Corel WEB.DESIGNER from within the application.



To insert a table
1. Position your cursor at the point in your document where you want to insert a table.
2. Click Table, Insert Table.
3. In the Table Properties dialog box, define the settings for the size, alignment, width, and layout of the table.



To create a new Web page that contains frames
· Click File, New With Frames.

Corel WEB.DESIGNER opens the Frame wizard to guide you through the steps necessary to create a Web page 
that contains frames.



To publish to the Internet
· Click File, Publish To Internet.

Corel WEB.DESIGNER opens the Instant Publishing wizard to guide you through the steps necessary to publish 
your Web page to the Internet.



To import a word processor file
· Click File, Import Word Processor File.

Corel WEB.DESIGNER opens the NET Transit wizard to guide you through the steps necessary to convert your 
word-processor file to HTML and import it into your Web page.



To add blinking text
· Select the text you want to blink and click Format, Blinking Text.



To insert a marquee
1. Position your cursor at the point in your document where you want to insert a marquee.
2. Click Insert, Marquee.
3. In the Marquee Properties dialog box, define the settings for the background color, alignment, behavior, speed,

direction, and size of the marquee.



To upload a file using FTP
1. Click File, FTP.
2. Locate the file you want to upload in the Local window.
3. Select the remote destination in the Remote window.
4. Click Upload.



Adding a roll-over event to your Web page
A roll-over event is an event that occurs when you move your mouse pointer over a particular object or area in 
an application. On the World Wide Web, roll-over events are often used to show that your mouse is over a button,
icon, or text. 
To add a roll-over event that will enable you to have a different button appear when a user’s mouse is over a 
button, you will need to add the following Java script to your HTML source code. 

To add a reversing button to your Web page
1. Place the two images you want to use in your server root folder. One image will be used when the mouse 

pointer is not over the button, and the other image will display when the mouse is over the button.
2. In Corel WEB.DESIGNER, click View, Document Source.
3. Add the following Java Script to your HTML Source Code. Replace "ON.GIF" with the name of the image to be 

used when the mouse pointer is over the button. Replace "OFF.GIF" with the name of the image to be used 
when the mouse pointer is not over the button.

<SCRIPT language="JavaScript">
// Copyright 1997 Corel Corporation
<!-- //This JavaScript is for Netscape 3.0 only, hide from other browsers
//---detect Netscape version 
agent= navigator.userAgent
n30 = 3
if ( agent.indexOf("a/3",6) == -1) {n30 = 1}
else {n30 = 3}

//---detect browser version
if (n30==3) {

//image declarations/loading
a1 = new Image(); 
a1.src = "off.gif"; // when mouse is not over the image
a2 = new Image(); 
a2.src = "on.gif"; // when the mouse is over the image

}
function PicChange(ImageName,NewImage) {
//script to change the ImageName to NewImage
if (n30==3) {

document.images[ImageName].src = eval(NewImage + ".src")
}
}
// end hiding from other browser's -->
</script>

4. Add the following between the <BODY> </BODY> tags in your HTML Source Code.

<a href="http://www.corel.com/" onMouseOver="PicChange('a','a2')" onMouseOut="PicChange('a','a1')">
<img src="off.gif" border=0 name="a"></a>

5. Click the Keep Changes button to save the new source code and close the HTML Source Code window.
The OFF.GIF image is displayed in your Corel WEB.DESIGNER window. When you preview your Web page in a 
Web browser, the OFF.GIF image will appear. Roll your mouse over the image to display ON.GIF.



{button ,AL(`PRC Tips and tricks;',0,"Defaultoverview",)} Related Topics



Adding the current date to your Web page
Insert the following Java script to your Corel WEB.DESIGNER Web page to display the current date.

To add the date to your Web page
1. In Corel WEB.DESIGNER, click View, Document Source.
2. Add the following Java Script to your HTML Source Code. 

<SCRIPT>
// Copyright 1997 Corel Corporation
var now = new Date();
var yr = now.getYear();
var mName = now.getMonth() + 1;
var dName = now.getDay() + 1;
var dayNr = ((now.getDate()<10) ? "0" : "")+ now.getDate();
if(dName==1) Day = "Sunday";
if(dName==2) Day = "Monday";
if(dName==3) Day = "Tuesday";
if(dName==4) Day = "Wednesday";
if(dName==5) Day = "Thursday";
if(dName==6) Day = "Friday";
if(dName==7) Day = "Saturday";
if(mName==1) Month="January";
if(mName==2) Month="February";
if(mName==3) Month="March";
if(mName==4) Month="April";
if(mName==5) Month="May";
if(mName==6) Month="June";
if(mName==7) Month="July";
if(mName==8) Month="August";
if(mName==9) Month="September";
if(mName==10) Month="October";
if(mName==11) Month="November";
if(mName==12) Month="December";
// String to display current date.
var todaysDate =(" "
+ Day
+ " "
+ Month
+ " "
+ dayNr
+ ", "
+ "19"
+ yr
+ "<BR>");
// Write date to page.
document.open();
document.write("<STRONG><FONT FACE='Arial' SIZE=3>"+todaysDate+"</FONT></STRONG>");
</SCRIPT>



3. Click the Keep Changes button to save the new source code and close the HTML Source Code window.
4. Click Tools, Browser Preview to preview your Web page. The current date will be displayed in your Web page.
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Troubleshooting errors
Even the best-planned Corel WEB.DESIGNER project can run into problems. This section points out some 
common errors and provides working solutions for them. As we receive additional feedback from users, we will 
continue to update this section to included solutions to common errors.

Enable lower case file names
The Enable Lower Case File Names check box allows all referenced files in your HTML documents to appear in 
lowercase letters when you click Browse in an application dialog box. By default, Corel WEB.DESIGNER disables 
this option.
If you use FTP to transfer your Corel WEB.DESIGNER documents to a UNIX server or service provider without 
enabling the Enable Lower Case File Names option, your FTP application may transfer the files in lowercase 
regardless of the actual DOS case referenced throughout your documents. Because UNIX systems maintain case 
sensitivity, the files referenced in links and images throughout your Corel WEB.DESIGNER pages will not display 
accurately on the Web. 

Problem:
Your files look fine locally but when they are placed on a UNIX server, the referenced images and links are 
broken.

Solution:
Click Tools, Options and enable the Enable Lower Case File Names check box before you create your Corel 
WEB.DESIGNER documents. If the Enable Lower Case File Names option is enabled, Corel WEB.DESIGNER 
references all files in lowercase to comply with FTP standards. The source code for a referenced image will look 
something like this:
<IMG SRC="images\filename.gif">
If the Enable Lower Case File Names option is disabled, Corel WEB.DESIGNER determines the actual DOS case of 
all referenced files and the source code for the image will look like this:
<IMG SRD="images\Filename.gif">
<IMG SRC="images\FileName.gif">
<IMG SRC="images\FIlename.gif">
Although DOS systems recognize each of these files as the same image, UNIX systems recognize three 
completely different files and will not display an accurate representation of your image on the Web.
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HTML Parser Error
The HTML Parser detects invalid HTML statements in your Web page. Most often, error statements occur if you 
have incorrectly edited the Document Source code for your Web page or if you have merged files that use tags 
not supported by Corel WEB.DESIGNER. Record the line numbers and errors reported in the Parser Error, then 
click View, Document Source to open your Web page document and edit the invalid statements. If the Parser 
Error occurs in your Web page containing frames, click View, Frame Source to edit the HTML code.
Although some browsers may display a parser that contains incomplete coding or nonstrict coding, Corel 
WEB.DESIGNER follows strict HTML tag regulations and identifies all irregular tag forms as errors.

 Note
· The Corel WEB.DESIGNER HTML Parser Error attempts to resolve coding errors for you. For example, if opening 

tags are found within your HTML document without their closing tags, such as a <TABLE> tag without the 
</TABLE> tag, Corel WEB.DESIGNER automatically closes the tag for you.
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Using Corel WEB.DESIGNER wizards
Corel WEB.DESIGNER contains several wizards that will help you to automate and simplify different tasks 
necessary to create a Web page. The three wizards found in Corel WEB.DESIGNER are the NET Transit wizard, the
Frame wizard, and the Instant Publishing wizard.
Use the NET Transit wizard to automatically convert your word-processor files into HTML. It is no longer 
necessary for you to know or learn HTML tags to add text files to your Web pages    the NET Transit wizard will do 
everything for you. You can access the NET Transit wizard by choosing Import Word Processor File from the File 
menu in Corel WEB.DESIGNER.
The Frame wizard makes it possible for you to quickly and easily divide your Web page into multiple frames that 
can be scrolled independently. To use the Frame wizard to create a new Web page that contains frames, click File,
New Frame Layout.
The Instant Publishing wizard automatically publishes your Corel WEB.DESIGNER documents to PageDepot, a 
World Wide Web site maintained by Microcrafts Inc. By using the Instant Publishing wizard, you can make the 
Web documents that you have designed with Corel WEB.DESIGNER immediately available to global audiences on
the World Wide Web    without the hassles of remote FTP or service providers. To access the Instant Publishing 
wizard, choose Publish To Internet from the File menu.

For more information see the following:
{button ,JI(`',`Using the NET Transit wizard')} Using the NET Transit wizard
{button ,JI(`',`Using the Frame wizard')} Using the Frame wizard
{button ,JI(`',`Using the Instant Publishing wizard')} Using the Instant Publishing wizard
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Using the NET Transit wizard
Use the NET Transit wizard to automatically convert your word-processor files into HTML. The NET Transit wizard 
makes it easy for you to use text files in your Web pages without having to know or learn about HTML.
To use the NET Transit wizard, simply select the word-processor file to be converted, choose the conversion 
method, and view your converted document in your Web browser. You can convert your file by using one of two 
conversion methods: basic or custom. A basic conversion will simply convert your file to HTML; whereas, a 
custom conversion will enable you to customize the appearance of your Web page. Use the custom-conversion 
option to add backgrounds, separator lines, and navigation buttons to your document and to split the document 
into multiple Web pages.
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Converting word-processor files
Appealing Web pages successfully combine the visual enhancements of graphics and the clarity of text to attract
audiences. Because you create most text-based files with a word processing application, Corel WEB.DESIGNER 
allows you to translate word-processor files to HTML with the NET Transit wizard. You can then edit the page’s 
final appearance and content using Corel WEB.DESIGNER.

To insert a word-processing file in Corel WEB.DESIGNER
1. Click File, Import Word Processor File.

The NET Transit wizard is launched directly from the Corel WEB.DESIGNER Application Window.
2. Click Start.
3. Click Next to advance to the Setup page in the NET Transit wizard.
4. Choose the word-processing file you want to convert.
5. Choose the output folder in which you want to save the .HTML file.
6. Enable the Basic button to convert your document using the basic conversion method.
7. Click Finish.

Your converted word-processing file will be automatically loaded into Corel WEB.DESIGNER.
 Notes

· It is recommended that you specify your server root folder as the output folder for saving the .HTML file.
· You will be prompted to save any document that you are currently working on before the NET Transit wizard 

dialog box is displayed.
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Customizing the conversion of your word processing file
If you would like to have more control over the way your word-processor file is converted you can use the custom
conversion method. Use the custom conversion method to customize the look of the final Web page inside the 
NET Transit wizard. You can add background colors or patterns, heading styles, and separator lines to your 
document. 

To customize the conversion of your file
1. Click File, Import Word Processor File.

The NET Transit wizard is launched directly from the Corel WEB.DESIGNER Application Window.
2. Click Start.
3. Click Next to advance to the Setup page in the NET Transit wizard.
4. Choose the word-processing file you want to convert.
5. Choose the output folder in which you want to save the .HTML file.
6. Enable the Custom Conversion button to customize the conversion of your word-processor file.
7. In the Background dialog box, enable either the Pattern or Color button. Specify which patterned background 

to use in the Pattern list box or click the Color button and choose a color from the Color dialog box.
8. In the Heading 1 dialog box, specify which style represents your highest level of heading, set the alignment, 

and choose separator lines to appear above and/or below the heading.
9. In the Heading 2 dialog box, specify which style represents your second level of heading, set the alignment, 

and choose separator lines to appear above or below the heading. Click Next to continue.
 Note

· You will be prompted to save any document that you are currently working on before the NET Transit wizard 
dialog box is displayed.
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Dividing your word-processing file into multiple Web pages
In the NET Transit wizard, if you have chosen to convert your word-processor file to HTML by using the custom 
conversion method, you can automatically divide your document into multiple Web pages. If you choose to 
automatically divide your document, you can also add navigation buttons directly inside the NET Transit wizard.

To divide your file into multiple Web pages
1. Click File, Import Word Processor File.

The NET Transit wizard is launched directly from the Corel WEB.DESIGNER Application Window.
2. Click Start.
3. Click Next to advance to the Setup page in the NET Transit wizard.
4. Choose the word-processing file you want to convert and the output folder in which you want to save 

the .HTML file.
5. Enable the Custom Conversion button to customize the conversion of your word-processor file.
6. Specify the background, and heading styles, and separator lines to use in your word-processor file.
7. In the Split File dialog box, enable the Split The Word Processor File Into Multiple Pages check box.
8. Choose to split the document either on the Highest Level Heading or the Second Level Heading by enabling 

the appropriate button.
9. Choose the appearance and position of the navigation buttons and click Finish to place your converted file into

Corel WEB.DESIGNER.
 Note

· You will be prompted to save any document that you are currently working on before the NET Transit wizard 
dialog box is displayed.

· When you click the Finish button to complete the conversion of your word-processor file, the first page of your 
multiple page Web document will be displayed in the Corel WEB.DESIGNER Application Window. Any additional 
pages will be stored as .HTML files in the output folder that you specified in the NET Transit wizard.
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Using the Frame wizard
Frames make it possible to divide a Web page into multiple frames that can be scrolled independently. The Frame
wizard in Corel WEB.DESIGNER enables you to quickly and easily add customized frames to your Web page. 
Each dialog box in the Frame wizard takes you through the steps necessary to add frames to your Web page. Use
the Frame wizard to specify the layout of the frames on your Web page, assign a frame name and URL for each 
frame, and change the appearance, margin height, and margin width of each frame. 

Navigating the wizard
When you have entered the settings in a Frame wizard dialog box, click the Next button to proceed to the next 
dialog box. Click the Back button if you would like to return to a previous step. Click the Cancel button to exit the
Frame wizard. Click the Finish button to exit the wizard and place the frames in the Corel WEB.DESIGNER 
Application Window.

 Note
· After you have added frames to your Web page, you can drag and drop existing Web pages directly into the 

frames.

For more information see the following:
{button ,JI(`',`Getting started with frames')} Getting started with frames
{button ,JI(`',`Editing frames')} Editing frames
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Getting started with frames
Frames can be used to divide Web pages into multiple, scrollable regions. Frames can display information quickly
and easily and give your Web page a great deal of flexibility. Use frames to contain Web page elements that 
must be easily seen by the user. For example, control bars, copyright notices, and title graphics can be placed in 
a static frame that remains constant as the user navigates the site. The user will always be able to access the 
items contained in the static frame, even when the other frames on the Web page are updated. You can also use 
frames to create a functional table of contents. Place the table of contents in a static frame on the left of the 
screen. When a user clicks an item in the table of contents, the right frame could present the topic. 

Features of frames
It is possible to add the following features to each individual region, or frame, in a Web page: 
· assign an individual URL to each frame, so that each frame can load information independent of the other 

frames on the page.
· assign each frame a name to allow it to be targeted by other URLs.
· dynamically resize each frame if the user changes the window's size. Resizing can also be disabled to ensure a

constant size for the frame.
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Accessing the Frame wizard
Frames can be used to divide Web pages into multiple, scrollable regions that make it easier to present 
information in a flexible and useful fashion. Corel WEB.DESIGNER provides you with a wizard to make it easy to 
add frames to your Web page. 

To access the Frame wizard in Corel WEB.DESIGNER 
· Click File, New With Frames.

 Note
· You will be prompted to save any document that you are currently working on before the Frame wizard dialog 

box is displayed.
· You can also click the Start A New Web Page With Frames button on the Welcome screen to launch the Frame 

wizard. 
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Editing frames
After you have used the Frame wizard to create a Web page that contains frames, you may want to edit the 
frames. The Frame wizard is used for creating frames not for editing them. To edit a frame, use the commands in 
the Frame menu. 
Use the Frame menu commands to 
· Split a frame
· Insert a new row or column
· Delete frames
· Change the frame properties or page properties
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Splitting a frame
Splitting a frame will add another row to a selected row frame or add another column to a selected column 
frame.

To split a frame
1. Click an individual frame to select it. 
2. Click Frame, Split Frame.

 Notes
· You can also press SHIFT + F10 or right-click a frame to access the Split Frame option.
· The new row or column frame will be displayed as cross-hatched, and you will not be able to edit the frame 

until you assign a local filename to the frame in the Frame Properties dialog box.
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Inserting a row or column frame
Inserting a row frame or a column frame will cause a row or column to be added inside the current frame.

To insert a row frame
1. Click a frame to select it.
2. Click Frame, Insert Row Frame.

To insert a column frame
1. Click a frame to select it.
2. Click Frame, Insert Column Frame.

 Notes
· You can also press SHIFT + F10 or right-click a frame to access the Insert Row Frame and Insert Column Frame 

options.
· The new row or column frame will be displayed as cross-hatched and you will not be able to edit the frame 

until you assign a local filename to the frame in the Frame Properties dialog box.
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Deleting a frame
Deleting a frame will remove the selected frame from the document. The frame itself will be removed, but the 
content document associated with the frame will not be deleted. You can delete all of the frames from your Web 
page except the last frame because your page must have at least one frame. 

To delete a frame
1. Click a frame to select it.
2. Click Frame, Delete Frame.

 Note
· You can also press SHIFT + F10 or right-click a frame to access the Delete Frame option.
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Defining the frame and page properties
Use the Frame Properties dialog box to change the properties of the individual frames within your Web page. 
Specify the URL of the page, the name of the frame, the margin size, the scrolling options, and the frame size in 
the Frame Properties tab of this dialog box. You can also define the properties of the entire Web page in the 
Frame Properties dialog box. Use the Page tab to add background images, colors, and sounds and to customize 
text colors for your Web page.

To define the properties of a frame
1. Click a frame to select it.
2. Click Frame, Properties.
3. Click the Frame tab.
4. Define the settings for the selected frame. You can define the URL Of Page, the Name, Size, and Scrolling 

options for the frame 

To define the properties of a Web page
1. Click a frame to select it.
2. Click Frame, Properties.
3. Click the Page tab.
4. Define the settings for the entire Web page. You can define the Background Color, Title, and Customize the 

text colors.
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Using the Instant Publishing wizard
The Instant Publishing wizard automatically publishes your Corel WEB.DESIGNER documents to PageDepot, a 
World Wide Web site maintained by Microcrafts Inc. By using the Instant Publishing wizard, you can make the 
Web documents that you have designed with Corel WEB.DESIGNER immediately available to global audiences on
the World Wide Web — without the hassles of remote FTP or service providers.
If you publish your Web pages to PageDepot from within Corel WEB.DESIGNER, Microcrafts Inc. provides you with
free Basic Web Site hosting for 30 days. During this trial period, you can publish and update your Basic Web Site 
as often as you like without paying for the Web hosting service. However, after the 30-day free trial period has 
ended, you must republish your pages to the PageDepot site and set up an account with Microcrafts Inc. to 
maintain a Web presence in their archive.
If you choose to open an account with Microcrafts Inc., you can select a publishing package and payment 
method using the Instant Publishing wizard. You can also use the Instant Publishing wizard to update your Web 
pages, modify your account information, or close your account.

 Note
· Corel and Microcrafts Inc. reserve the right to slow or limit high-access sites published to PageDepot.

For more information see the following:
{button ,JI(`',`Selecting a publishing plan')} Selecting a publishing plan
{button ,JI(`',`Updating a Web site')} Updating a Web site
{button ,JI(`',`Updating your account')} Updating your account
{button ,JI(`',`Closing your Web site')} Closing your Web site

{button ,AL(`OVR Using Corel WEBDESIGNER wizards;',0,"Defaultoverview",)} Related Topics



Selecting a publishing plan



Selecting a publishing plan
With Corel WEB.DESIGNER's Instant Publishing wizard, you can make the Web pages that you have designed 
using Corel WEB.DESIGNER's advanced authoring tools instantly available to global audiences on the World Wide
Web. Instead of transferring your Web pages to an Internet server or a service provider, you can use the Instant 
Publishing wizard to publish your pages directly to the Web from within Corel WEB.DESIGNER.
The Instant Publishing wizard guides you step by step through the Web-publishing process and allows you to 
choose a publishing package, to transfer your files to a remote destination using FTP, or to set up and pay for 
your personal World Wide Web site. When you publish your Corel WEB.DESIGNER documents to the World Wide 
Web for the first time, Microcrafts Inc. offers you 30 days of free Web-hosting services. To maintain your Web 
presence after the 30-day free period, you must purchase a customized Web publishing package using the 
Instant Publishing wizard within Corel WEB.DESIGNER.
When you select a publishing plan from the Instant Publishing wizard's Select Plan page, you can choose 
between three publishing packages: Basic, Standard, and Deluxe. These publishing plans offer everything from 
email and FAQ support to search indexes and access control. The Instant Publishing wizard allows you to submit 
personal information and payments within a secure environment so that you can publish your documents on the 
Web without ever leaving the Corel WEB.DESIGNER application. The 30-day free Web-hosting service only applies
to the Basic Web Site publishing plan.

 Note
· You can also use the Instant Publishing wizard to transfer files by FTP files to Microcrafts Inc. or to any other 

remote FTP destination.
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Choosing a Web site plan
The Instant Publishing wizard offers three Web-site publishing plans: Basic, Standard, and Deluxe. Click the 
appropriate tabs within the Instant Publishing wizard to view the features offered by each Web-site publishing 
package, and choose the    plan that suits your personal World Wide Web needs.

To choose a Web site plan
1. Click File, Publish To Internet.

Corel WEB.DESIGNER launches the Instant Publishing wizard.
2. Ensure the Publish A New Web Site button is enabled on the PageDepot Instant Publisher wizard screen.
3. Click Next.
4. Type the location of your Web page directory or click the Browse button to locate the folder on your local 

system
5.  Click the Basic, Standard, or Deluxe Web Site Plan tab.

The wizard displays a list of features and the cost of each plan.
6. Click Next.

 Notes
· The 30-day free Web-hosting service does not apply to the standard and deluxe Web Site plans.
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Using Microcrafts FTP wizard
The FTP tab in the Instant Publishing wizard allows you to transfer .HTML files that you have created using Corel 
WEB.DESIGNER's advanced HTML authoring tools and saved from your local system to a remote Web server. You 
must identify the host name, user ID, password, and the folder that you want to access on the remote system.

To access a remote Web server
1. Choose the FTP tab in the Instant Publishing wizard.
2. Type the FTP address of the remote server or choose a previous host from the Host list box.
3. Type your login name in the User ID text box.
4. Type your password in the Password text box.
5. In the Directory text box, type the path leading to the folder into which you want to copy your files.
6. Click Next.
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Paying for your Web site
After you have specified the location and name of your Web page folder, chosen a password, and entered your 
personal information, you can choose a method of payment for your Web site. Although you must pay for 
Microcrafts Web-hosting service using a credit card, the Instant Publishing wizard allows you to submit your 
credit information by modem or fax. If you transmit your credit card information to Microcrafts Inc. by modem, 
your transmission will be encrypted for security.

To submit credit card information via modem
1. Ensure that the Credit Card Via Modem button is enabled when the Instant Publishing wizard asks you how you

would like to pay for the Web site.
2. Click the credit card that you will use to pay for your Web site.
3. Type your name, card number, expiration date, and voucher number in the appropriate text boxes.
4. Click Next.

To submit credit card information via Fax
1. Enable the Credit Card Via Fax button when the Instant Publishing wizard asks you how you would like to pay 

for the Web site.
2. Click Print Fax Form.

A credit card information form is printed by your system's default printer.
3. Complete the credit card information form and Fax it to Microcrafts Inc.
4.  Click Next.

 Notes
· If you submit your credit card information by Fax, your credit card will be billed on a monthly basis and your 

site will be activated on receipt of your valid credit card information.
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Publishing your Web pages
After you have chosen a payment method and submitted valid credit card information, you can complete the 
publishing process and display your Web pages on the PageDepot site. In the final screens of the Instant 
Publishing wizard, you must verify the address that users will use to access your site and also submit all of the 
files for you Web site.

To publish your pages on the Web
1. Verify the accuracy of the information displayed in the Publishing wizard Summary.
2. Do one of the following:

· Click Finish to begin sending your files.
· Click Back to modify the information displayed on the previous Instant Publishing wizard screens. Then click 

Finish to begin sending your files.
3. After the Instant Publishing wizard completes the file transfer, click Finish to end the Web-publishing process.
4. Click Done.

 Note
· To halt the publishing process, click the Stop button on the wizard's Publishing Site page. The Instant 

Publishing wizard stops transferring your files and waits for further instructions.
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Updating a Web site
The World Wide Web is a fast-paced, changing environment, and maintaining a prominent presence in this 
environment requires continuous flexibility and change. With the Instant Publishing wizard, you can modify or 
update the information that you have published on the Web by uploading all of the files in your server root folder
or by uploading only the files that you have modified.
To update your files, you must first make the appropriate changes using Corel WEB.DESIGNER's advanced Web-
authoring tools. After you have saved the changes you've made to your Web pages in your server root folder, 
you can launch the Instant Publishing wizard from Corel WEB.DESIGNER's File menu and upload the modified files
to the PageDepot site. 

 Note
· When you upload modified files to the PageDepot Web site, the new Web documents override the existing files 

and your changes are displayed immediately.
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Updating all files in your Web site
After you have established a World Wide Web presence using the Instant Publishing wizard, you can update and 
modify your files as often as you like. Using the Instant Publishing wizard, you can upload your entire server root 
folder or upload only the files that you have modified since the last update. If you selected the Basic Web Site 
publishing plan and your 30-day free Web-hosting service has not yet expired, you can update and publish pages
as often as you like without charge.

To update all files in your Web site
1. Click File, Publish To Internet.

Corel WEB.DESIGNER opens the Instant Publishing wizard.
2. Enable the Update Your Web Site button and click Next.
3. Choose your Web site's Internet address or URL from the Site Name list box.
4. Type the path that leads to your server root folder or click the Browse button to search your local system for 

the folder.
5. Type your password in the Password text box and click Next.
6. Enable the Upload Entire Site button and click Next.

The Instant Publishing wizard begins transferring the files from your server root folder to the PageDepot site.
7. When the wizard completes the file transfer, click Finish.
8. Click Done.

 Note
· The password that you type in the Password text box is the same password that you chose when you originally

published your Web site. This password prevents unauthorized modifications to your Web site.
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Uploading changes since your last update
If you only modify selected files in your server root folder, you can use the Instant Publishing wizard to update 
only those files in your Web site. Uploading the changes you've made to your HTML files since your last update is
a much faster way to provide your Web audiences with accurate, up-to-date information.

To upload changes since your last update
1. Click File, Publish To Internet.
2. In the Instant Publishing wizard, enable the Update Your Web Site button and click Next.
3. Choose your Web site's Internet address or URL from the Site Name list box.
4. Type the folder path that leads to your server root folder or click the Browse button to search your local system

for the folder.
5. Type your password in the Password text box and click Next.
6. Enable the Upload Changes Since Last Update button and click Next.

The Instant Publishing wizard begins transferring the modified files from your server root folder to the 
PageDepot site.

7. When the wizard completes the file transfer, click Finish.
8. Click Done.

 Note
· The password that you type in the Password text box is the same password that you chose when you originally

published your Web site. This password prevents unauthorized modifications to your Web site.
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Updating your account
Whether you change addresses, passwords, or credit cards, or whether your Web-publishing requirements 
increase or decrease, you can communicate these modifications to your host server using the Instant Publishing 
wizard. When you choose the Update Your Account option in the Instant Publishing wizard, the wizard takes you 
through the publishing process and displays the information that you submitted when you set up your account. 
To adjust any of these specifications, simply type the new information in the appropriate areas and upload the 
changes to Microcrafts Inc.
After you have updated your account, you can verify the accuracy of your changes by viewing the Publishing 
wizard Summary page in the Instant Publishing wizard. The Publishing wizard Summary page displays a compiled
list of all the information that you've entered in the Instant Publishing wizard before you submit the data to 
Microcrafts Inc.
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Updating your account information
The Instant Publishing wizard allows you to modify or update your account information and submits your 
adjustments to the host server. You can verify the accuracy of your account information in the Publishing wizard's
Summary page.

To modify specifications in the Instant Publishing wizard
1. Click File, Publish To Internet.
2. Enable the Update Your Account button.
3. Click Next.
4. Modify the information presented in the Instant Publishing wizard dialog boxes, clicking Next after each 

modification.
5. When you have finished modifying your account, click Done.
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Closing your Web site
If you decide to remove your Web pages from the PageDepot site, you can use the Instant Publishing wizard to 
cancel your account with Microcrafts Inc. After you have canceled payment on your account and indicated that 
you want to remove your Web site from the PageDepot archive, it takes approximately 10 minutes to close your 
Web site.
After you remove your Web site from the PageDepot archive, your site's URL or Internet address is reserved for 
30 days. If you decide to reopen your account and publish your pages to PageDepot within this 30-day period, 
you will be given your original URL. However, if you re-open your account with Microcrafts Inc. after the 30 day 
period has expired, you may have to choose a new name for your Web Site.
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Closing your account
The Instant Publishing wizard allows you to close your account with Microcrafts Inc. and to remove your Web site 
from the host server. Complete the Instant Publishing wizard's feedback page and close the wizard to terminate 
your account.

To close your Web site account
1. Click File, Publish to Internet.
2. In the Instant Publishing wizard, enable the Close Your Account button.
3. Choose your Web site's Internet address or URL from the Site Name list box.
4. Click Browse and locate your server root folder.
5. Type your password in the Password list box.
6. Click Next.
7. Complete the Instant Publishing wizard's feedback page and click Next.
8. Click Done.

 Notes
· Microcrafts Inc. will reserve the name of your Web Site for 30 days in case you decide to reopen your account.
· The PageDepot servers remove your Web site within 10 minutes from the time you close your account.
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Welcome to the Corel WebMaster Suite
In recent years the popularity of the Internet has grown tremendously, making the “Net” and its offspring, the 
World Wide Web, two of the fastest-growing communication media in the world. Currently, millions of people are 
developing their own Web pages to advertise businesses, to sell products, to entertain, or to communicate on a 
global basis. A Web page grants a single person the ability to reach millions of potential customers, clients, and 
friends around the world.
Until now, creating and maintaining Web pages required knowledge of the Hypertext Markup Language (HTML), 
but with the Corel WebMaster Suite, publishing pages on the Web is easy. The Corel WebMaster Suite is a series 
of powerful and easy-to-use applications that let you create Web pages without having to know HTML. These 
applications were created for average computer users, but are powerful and versatile enough for use by 
professional Web designers. Simply put, Corel WEB.DESIGNER gives you the power you want, and the flexibility 
you need, to create quality Web pages with ease.

 Tip
· For more information and other related software, visit the Corel WebMaster Suite Web page. Click Help, Corel 

WebMaster Suite Web Page and click OK to directly access this page (http://www.corel.com/webmaster).

For more information see the following:
{button ,JI(`',`Corel WebMaster Suite concepts')} Corel WebMaster Suite concepts
{button ,JI(`',`Understanding HTML and the WWW')} Understanding HTML and the WWW
{button ,JI(`',`Understanding the Hypertext Markup Language HTML')} Understanding the Hypertext Markup 
Language (HTML)
{button ,JI(`',`Understanding the World Wide Web WWW')} Understanding the World Wide Web (WWW)
{button ,JI(`',`Becoming familiar with WYSIWYG interface and integration')} Becoming familiar with WYSIWYG 
interface and integration
{button ,JI(`',`Understanding the What You See Is What You Get WYSIWYG Interface')} Understanding the What 
You See Is What You Get (WYSIWYG Interface)
{button ,JI(`',`Understanding integration')} Understanding integration
{button ,JI(`',`The Corel WebMaster Suite workplace')} The Corel WebMaster Suite workplace
{button ,JI(`',`Touring Corel WEBDESIGNER')} Touring Corel WEB.DESIGNER
{button ,JI(`',`Exploring the Corel WEBDESIGNER menus')} Exploring the Corel WEB.DESIGNER menus
{button ,JI(`',`Exploring the Corel WEBDESIGNER toolbars')} Exploring the Corel WEB.DESIGNER toolbars
{button ,JI(`',`Organizing files')} Organizing files
{button ,JI(`',`Documentation conventions')} Documentation conventions
{button ,JI(`',`Using Help')} Using Help
{button ,JI(`',`About Corel Corporation')} About Corel Corporation
{button ,JI(`',`Viewing application information')} Viewing application information
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Welcome to Corel WEB.DESIGNER
Corel WEB.DESIGNER is a Web publishing tool that allows you to develop high-quality Web pages without 
knowing Hypertext Markup Language (HTML). If you're new to Web page design, you'll find that Corel 
WEB.DESIGNER's tools and features let you create professional-quality Web pages quickly and easily. If you're 
experienced with Web page design, you'll find that Corel WEB.DESIGNER gives you the power and flexibility that 
you need to enhance your creative skills.
With Corel WEB.DESIGNER, you can create and edit Web page text the same way that you do in most word-
processing applications. The application includes word-processor style features such as formatting toolbars, a 
spell-checking feature, cut and paste tools, and find and replace commands. With Corel WEB.DESIGNER it's easy 
to edit existing Web pages or create new ones using templates, images, links, hot spots, forms, and character 
and paragraph styles like bulleted and numbered lists.

For more information see the following:
{button ,JI(`',`Corel WebMaster Suite concepts')} Corel WebMaster Suite concepts
{button ,JI(`',`Understanding HTML and the WWW')} Understanding HTML and the WWW
{button ,JI(`',`Understanding the Hypertext Markup Language HTML')} Understanding the Hypertext Markup 
Language (HTML)
{button ,JI(`',`Understanding the World Wide Web WWW')} Understanding the World Wide Web (WWW)
{button ,JI(`',`Becoming familiar with WYSIWYG interface and integration')} Becoming familiar with WYSIWYG 
interface and integration
{button ,JI(`',`Understanding the What You See Is What You Get WYSIWYG Interface')} Understanding the What 
You See Is What You Get (WYSIWYG Interface)
{button ,JI(`',`Understanding integration')} Understanding integration
{button ,JI(`',`The Corel WebMaster Suite workplace')} The Corel WebMaster Suite workplace
{button ,JI(`',`Touring Corel WEBDESIGNER')} Touring Corel WEB.DESIGNER
{button ,JI(`',`Exploring the Corel WEBDESIGNER menus')} Exploring the Corel WEB.DESIGNER menus
{button ,JI(`',`Exploring the Corel WEBDESIGNER toolbars')} Exploring the Corel WEB.DESIGNER toolbars
{button ,JI(`',`Organizing files')} Organizing files
{button ,JI(`',`Documentation conventions')} Documentation conventions
{button ,JI(`',`Using Help')} Using Help
{button ,JI(`',`About Corel Corporation')} About Corel Corporation
{button ,JI(`',`Viewing application information')} Viewing application information
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Applications in the Corel WebMaster Suite
The Corel WebMaster Suite includes the following applications and utilities to enhance your productivity and 
empower you with more Web-publishing options:
Corel WEB.DESIGNER Integrates the applications in the Corel WebMaster Suite to allow you to create 

advanced, interactive documents for publication on the World Wide Web.
Corel WEB.DATA Creates catalogs, stock reports, inventory lists, or data tables. With Corel 

WEB.DATA you can organize raw database material and publish your documents 
on the World Wide Web.

Corel WEB.PhotoPaint Allows you to edit images and video files, retouch photographs, and create original
artwork with powerful, bitmap-based image-editing and painting tools. You can 
automatically edit and update images in your Corel WEB.DESIGNER pages using 
Corel WEB.PhotoPaint.

Corel WEB.SiteManager Provides Web site administrators ("Webmasters") with maintenance, monitoring, 
diagnostic, and repair facilities for their Internet and Intranet sites.

Corel WEB.DRAW Creates and edits high-quality, professional graphics files. You can automatically 
merge completed images with your Corel WEB.DESIGNER pages for publication on 
the World Wide Web.

Corel WEB.MOVE Creates a wide range of animated sequences, from simple, one-character 
cartoons, to complex, interactive displays. You can automatically merge completed
animations with your Corel WEB.DESIGNER pages for publication on the World 
Wide Web.

Corel WEB.WORLD Builds exciting three-dimensional worlds that users can enter and explore. You can
automatically merge your completed VRML with your Corel WEB.DESIGNER pages 
for publication on the World Wide Web.

Corel WEB.GALLERY Supplies you with thousands of ready-to-use graphic images to integrate in your 
Corel WEB.DESIGNER pages. Simply drag and drop the Corel WEB.GALLERY images
onto your Corel WEB.DESIGNER screen to give color and life to your Web 
documents.

NET Transit Converts standard word-processing files to HTML format. After the file is 
converted, you can edit the HTML document using Corel WEB.DESIGNER's 
advanced Web authoring tools. You can access the NET Transit wizard by clicking 
File, Import Word-processor File in Corel WEB.DESIGNER.

Netscape Navigator 3.0 Displays your Corel WEB.DESIGNER documents as they will appear to your visitors 
on the World Wide Web. Netscape Navigator 3.0 is an advanced Web browsing 
mechanism that you can use to view Web pages, read newsgroups, send 
electronic mail, and more.

O'Reilly Website Server Converts your local computing system to a WebSite server to allow you to make 
your Corel WEB.DESIGNER documents immediately available to global audiences.

For more information see the following:
{button ,JI(`',`Corel WebMaster Suite concepts')} Corel WebMaster Suite concepts
{button ,JI(`',`Understanding HTML and the WWW')} Understanding HTML and the WWW
{button ,JI(`',`Understanding the Hypertext Markup Language HTML')} Understanding the Hypertext Markup 
Language (HTML)
{button ,JI(`',`Understanding the World Wide Web WWW')} Understanding the World Wide Web (WWW)
{button ,JI(`',`Becoming familiar with WYSIWYG interface and integration')} Becoming familiar with WYSIWYG 
interface and integration
{button ,JI(`',`Understanding the What You See Is What You Get WYSIWYG Interface')} Understanding the What 
You See Is What You Get (WYSIWYG Interface)
{button ,JI(`',`Understanding integration')} Understanding integration
{button ,JI(`',`The Corel WebMaster Suite workplace')} The Corel WebMaster Suite workplace
{button ,JI(`',`Touring Corel WEBDESIGNER')} Touring Corel WEB.DESIGNER
{button ,JI(`',`Exploring the Corel WEBDESIGNER menus')} Exploring the Corel WEB.DESIGNER menus
{button ,JI(`',`Exploring the Corel WEBDESIGNER toolbars')} Exploring the Corel WEB.DESIGNER toolbars
{button ,JI(`',`Organizing files')} Organizing files
{button ,JI(`',`Documentation conventions')} Documentation conventions



{button ,JI(`',`Using Help')} Using Help
{button ,JI(`',`About Corel Corporation')} About Corel Corporation
{button ,JI(`',`Viewing application information')} Viewing application information
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New features in Corel WEB.DESIGNER
With this version of Corel WEB.DESIGNER, you'll find the advanced Web authoring tools that have made Corel 
WEB.DESIGNER so popular among Web artists in the past. However, as the central application in the Corel 
WebMaster Suite, Corel WEB.DESIGNER also offers improved integration and flexibility to allow you to create 
professional Web pages that incorporate raw data, retouched photographs, video clips, animations, Java Powered
applets, virtual worlds, sound bytes, and more!
Now, Corel WEB.DESIGNER also simplifies the Web publishing process by providing Web artists with an 
integrated FTP application and Instant Publishing Wizard for file transfer. You can use the FTP application to 
transfer your completed Corel WEB.DESIGNER documents to your service provider for immediate publication on 
the Web. If you have not yet established an external service provider, you can use the Instant Publishing Wizard 
to publish your completed Corel WEB.DESIGNER documents to an existing World Wide Web site    free of charge!
Using Corel's predesigned CGI scripts, you can enhance your Web pages with fully functional online forms. This 
version of Corel WEB.DESIGNER also incorporates Microsoft's ActiveX technology. ActiveX is a component that 
can be inserted in a Web page to provide functionality not directly available in HTML, such as animation 
sequences, credit-card transactions, or spreadsheet calculations. Combine these advanced features with more 
subtle improvements, such as expanded table and list functions and scrolling marquees, and you will soon 
recognize the power and appeal of the Corel WebMaster Suite.

For more information see the following:
{button ,JI(`',`Corel WebMaster Suite concepts')} Corel WebMaster Suite concepts
{button ,JI(`',`Understanding HTML and the WWW')} Understanding HTML and the WWW
{button ,JI(`',`Understanding the Hypertext Markup Language HTML')} Understanding the Hypertext Markup 
Language (HTML)
{button ,JI(`',`Understanding the World Wide Web WWW')} Understanding the World Wide Web (WWW)
{button ,JI(`',`Becoming familiar with WYSIWYG interface and integration')} Becoming familiar with WYSIWYG 
interface and integration
{button ,JI(`',`Understanding the What You See Is What You Get WYSIWYG Interface')} Understanding the What 
You See Is What You Get (WYSIWYG Interface)
{button ,JI(`',`Understanding integration')} Understanding integration
{button ,JI(`',`The Corel WebMaster Suite workplace')} The Corel WebMaster Suite workplace
{button ,JI(`',`Touring Corel WEBDESIGNER')} Touring Corel WEB.DESIGNER
{button ,JI(`',`Exploring the Corel WEBDESIGNER menus')} Exploring the Corel WEB.DESIGNER menus
{button ,JI(`',`Exploring the Corel WEBDESIGNER toolbars')} Exploring the Corel WEB.DESIGNER toolbars
{button ,JI(`',`Organizing files')} Organizing files
{button ,JI(`',`Documentation conventions')} Documentation conventions
{button ,JI(`',`Using Help')} Using Help
{button ,JI(`',`About Corel Corporation')} About Corel Corporation
{button ,JI(`',`Viewing application information')} Viewing application information
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Using the Corel WebMaster Suite
Before you start using the Corel WebMaster Suite, put some thought into the Web site that you're building. 
Decide what textual and graphical components you need and how they'll fit together. You might want to draw a 
sketch of your Web pages, showing their components and locations.
When you've decided what you want to add to your Web site use the Corel WebMaster Suite to create it. Build a 
site quickly by using the Web Site creation wizard located in Corel WEB.SiteManager. Or start in Corel 
WEB.DESIGNER and launch the appropriate Suite application for creating each graphical element you want. You 
can also use any application included in the Corel WebMaster Suite on its own to create the individual 
components needed for your Web pages.

Using the Web Site Creation Wizard
You can build a Web Site quickly by using Corel WEB.SiteManager's Web Site Creation Wizard. This Wizard makes 
it easy to create attractive corporate and personal Web Sites that have a consistent style and appearance.

Starting in Corel WEB.DESIGNER
If you're starting a Web page from scratch, and you want maximum control over each of the components you'll 
include, then you might want to begin by entering text in Corel WEB.DESIGNER. To locate or create a graphic in 
any of the other Corel WebMaster Suite components, launch the product from Corel WEB.DESIGNER by clicking 
its icon in the Application toolbar. Then create the Web element you want, and load it directly into Corel 
WEB.DESIGNER.

Using each component on its own
You can use any Corel WebMaster Suite component on its own, then assemble the various textual and graphical 
components that you've created into Internet-ready Web pages in Corel WEB.DESIGNER.

Uploading to the Web
When your Web pages are complete, you can upload them to your Internet server. But first, make sure that the 
folder structure on your computer matches the structure of your Internet server. For example, if your Web pages 
will be in the folder WEBSITE on your server, then upload them from the WEBSITE folder on your computer.
If you don’t want to run your own server, you can choose the Publish To Internet option from the Corel 
WEB.DESIGNER or Corel WEB.SiteManager File menus. These options enable you to FTP your Web pages to the 
Microcrafts Inc. Web Site hosting service. A basic 2MB site can be published to Microcrafts Inc. for a 30-day free 
trial period.

Getting help
To help you use the Corel WebMaster Suite, we've provided an extensive online Help system and user assistance 
manual. 

For more information see the following:
{button ,JI(`',`Corel WebMaster Suite concepts')} Corel WebMaster Suite concepts
{button ,JI(`',`Understanding HTML and the WWW')} Understanding HTML and the WWW
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Language (HTML)
{button ,JI(`',`Understanding the World Wide Web WWW')} Understanding the World Wide Web (WWW)
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interface and integration
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You See Is What You Get (WYSIWYG Interface)
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{button ,JI(`',`Viewing application information')} Viewing application information
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Corel WebMaster Suite concepts
The Corel WebMaster Suite is a series of powerful, tightly integrated applications that simplify the creation of 
advanced, high-quality Web pages. But to use each of these applications on their own or as combined elements 
integrated by Corel WEB.DESIGNER, you must first understand the basic concepts that lie behind World Wide 
Web publishing.
Before launching Corel WEB.DESIGNER and beginning a new Web project, you should familiarize yourself with the
basic tools of World Wide Web design. You will create your Web pages in a What You See Is What You Get 
(WYSIWYG) or word processing-style environment, but behind the scenes, you are actually inserting standard 
HTML code. By developing a comprehensive understanding of HTML, the WWW, WYSIWYG interface, and 
integration can help you to distinguish your documents from the millions of others currently featured on the 
Web.
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Understanding HTML and the WWW
Essentially, the World Wide Web is a hypertext-based information system that makes data available to audiences
around the globe. The Hypertext Markup Language or HTML is the programming language that codes all 
information displayed on the World Wide Web. In the early days of Web publishing, Web pages were constructed 
entirely in HTML code using simple text editors such as Notepad or Wordpad. 
With the development of WYSIWYG Web editors such as Corel WEB.DESIGNER, the creation of Web pages no 
longer requires extensive knowledge of the Hypertext Markup Language (HTML). However, the design of Web 
pages with WYSIWYG editors is simplified with a basic understanding of HTML code, tag functions, and the role of
HTML in Web publishing. 

 Tip
· For a detailed description of HTML tags and their function in Corel WEB.DESIGNER, refer to the HTML tag 

reference chart in the Reference section of the Corel WEB.DESIGNER Help system.
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Understanding the Hypertext Markup Language (HTML)
The Hypertext Markup Language, better known as HTML, is the core programming language of the World Wide 
Web. Put simply, HTML uses a set of character tags or codes to tell your Web browser how to display information 
on the Web. 
Some companies, including Netscape and Microsoft, have enhanced their Web browsers with new display 
capabilities such as applet support, animated GIF presentation, and VRML display. As a result, these companies 
have created some unique HTML tags that are supported only by their particular browser. Because Web surfers 
use many different browsers to view World Wide Web sites, unique HTML enhancements might be displayed by 
one browser, but not by another, depending on the types of tags that were used by the author of the page. To 
address the incompatibility problems that unique HTML tags create, and to ensure that the largest possible 
audience has access to your sites, Corel WEB.DESIGNER uses HTML tags that most major browsers support.
Writing standard HTML code does not require high-powered applications    in fact, a simple text editor like 
Notepad, Wordpad, or DOS Edit will do. But this type of HTML programming requires extensive knowledge of 
HTML tags and is best suited to experienced Web page authors. Luckily, automated text editors such as Corel 
WEB.DESIGNER have removed the programming from HTML coding to allow even beginning Web artists to 
construct advanced Web pages in a word-processing style application.

{button ,AL(`OVR Welcome to the Corel WebMaster Suite;',0,"Defaultoverview",)} Related Topics



Understanding the World Wide Web (WWW)
The World Wide Web is a hypertext-based, information distribution system originally established by researchers 
at the Conseil Européen pour la Recherche Nucléaire (CERN) in Switzerland in the late 1980s. Due to recent 
expansion and high-speed advancement, the Web has become a staggering information resource. Millions of 
individuals and organizations across the globe have published pages on the Web so that anyone, anywhere can 
obtain any information they need.
When you visit a Web site, you access information stored on another computer. The contents of all Web sites are 
coded in Hypertext Markup Language (HTML), and the computer that stores the site is called a Web server. The 
viewing device that accesses information from the Web site and displays it on your computer screen is called a 
Web browser.
Each time you type a Uniform Resource Locator (URL) or Internet address in your browser, you send a signal to 
the server that holds that address to request its information. The same process takes place when you click a 
hyperlink on a Web page. Although you type a URL in the Address box at the top of your browser window, a link's
destination or target site is embedded in the hyperlink by the Web page author. In both cases, URLs can 
reference text and images, an online newsgroup, an email address, or any other information located on an 
Internet server.
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Becoming familiar with WYSIWYG interface and integration
Whether you've already established an influential World Wide Web presence or have never created a Web page, 
the Corel WebMaster Suite can help you to develop Web sites that exploit some of the Internet's most advanced 
features. The Corel WebMaster Suite is a flexible, versatile, and easy to use Web editor that is suitable for a wide 
range of users.
As the central application in the Corel WebMaster Suite, Corel WEB.DESIGNER integrates external elements and 
applications. But Corel WEB.DESIGNER's WYSIWYG interface simplifies the integration of these elements by 
presenting the structure and layout of your pages in standard word-processing style. To use Corel 
WEB.DESIGNER's tools and features in the most efficient manner and to optimize your Web designs, you should 
first understand the basics of the WYSIWYG interface and integration in the Corel WebMaster Suite.
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Understanding the What You See Is What You Get (WYSIWYG 
Interface)
WYSIWYG is a common interface among advanced Web editing tools that allows you to build Web pages without 
extensive HTML programming experience. The WYSIWYG interface provides a visual approach to Web page 
design by presenting concrete layout and formatting features in a word-processing environment.
Most WYSIWYG Web editors offer built-in syntax checks that verify the accuracy of the HTML code that 
corresponds to the WYSIWYG presentation of your page. In Corel WEB.DESIGNER, this syntax check is performed 
by the HTML Parser. The HTML Parser detects invalid HTML statements in your Web pages. Most often, error 
statements occur when you incorrectly edit the HTML source code for your Web page or you merge files that use 
HTML tags that are not supported by Corel WEB.DESIGNER.
WYSIWYG editors also reduce the need for repetitive previews because they offer Web authors an accurate visual
representation of their Web pages as they are constructed. However, even WYSIWYG editors require a browser 
preview to view the minor differences in color and style that might occur when you publish your documents on 
the Web. To preview your document, Corel WEB.DESIGNER provides the Set Browser and Browser Preview 
commands in the Tools menu.
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Understanding integration

As the central application in the Corel WebMaster Suite, Corel WEB.DESIGNER integrates and displays text and 
graphics created in Corel WEB.DRAW, Corel WEB.GALLERY, Corel WEB.MOVE, Corel WEB.PhotoPaint, and Corel 
WEB.WORLD. Corel WEB.DESIGNER's integration features allow you to create Web pages that present animations, 
professional images, and VRML that you've created in external applications. You can access Corel WEB.DESIGNER's 
integration features from the Tools menu or Applications toolbar.

The Tools menu and Applications toolbar allow you to launch Corel WEB.MOVE, Corel WEB.DRAW, Corel 
WEB.WORLD, Corel WEB.GALLERY, Corel WEB.DATA, or Corel WEB.PhotoPaint from within the Corel 
WEB.DESIGNER application. But Corel WEB.DESIGNER's true power comes with its ability to import the files you 
create in other applications in the Corel WebMaster Suite. 
Clicking File, Publish to WEB.DESIGNER in Corel WEB.DRAW, Corel WEB.MOVE, Corel WEB.WORLD, and Corel 
WEB.DATA immediately inserts the image, animation, VRML, or database that you created into your active Corel 
WEB.DESIGNER document. If you are a Windows 95 user, Corel WEB.DESIGNER even transports the necessary 
reference files to your server root folder, allowing you to view a more accurate presentation of your pages on the
World Wide Web. In Corel WEB.PhotoPaint, you can edit .GIF and .JPG images for use in your Corel 
WEB.DESIGNER documents, and in Corel WEB.GALLERY, you can add professional images to your page by 
dragging and dropping the selected files.
Corel WEB.DESIGNER improves the graphic quality of your pages by allowing you to avoid the translation and 
conversion flaws that can occur when you merge files from unrelated programs.
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The Corel WebMaster Suite workplace
Often, the best way to learn how to use a new application is to explore the program's main screen, menu 
commands, and toolbar buttons before you attempt to complete a task. Because the Corel WEB.DESIGNER 
application is the central program in the Corel WebMaster Suite, you should begin by touring the Corel 
WEB.DESIGNER desktop and taking special note of the Web editor's new features and tools for integration.
After you have explored the Corel WEB.DESIGNER desktop, examine the application's menu commands and 
toolbar buttons to clarify the function of each option. When you are comfortable with Corel WEB.DESIGNER's 
basic operations, you can begin to develop simple Web pages and to explore the additional applications in the 
Corel WebMaster Suite.

 Tip
· To explore the Corel WEB.MOVE, Corel WEB.DRAW, Corel WEB.WORLD, Corel WEB.GALLERY, Corel WEB.DATA, 

and Corel WEB.PhotoPaint menu commands or toolbar buttons, launch the appropriate application from Corel 
WEB.DESIGNER's Tools menu or Applications toolbar.
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Touring Corel WEB.DESIGNER
When you launch Corel WEB.DESIGNER for the first time, you will see the Welcome To Corel WEB.DESIGNER 
screen and the main Application Window. The Welcome To Corel WEB.DESIGNER screen provides quick access to 
different Corel WEB.DESIGNER operations. From this screen, you can start a new Web page, start a frame-based 
Web page, open a local Web page or a page currently featured on the Internet, or choose a predesigned Corel 
WEB.DESIGNER template to begin your Web page.
After you have made a selection in the Welcome To Corel WEB.DESIGNER screen, you can explore the main Corel 
WEB.DESIGNER Application Window. To display the Corel WEB.DESIGNER toolbars, enable the appropriate toolbar
name in the View menu. Browse through the application's menu commands and toolbar buttons and examine the
main window elements. This will simplify the Web page creation process and familiarize you with the 
organization of Corel WEB.DESIGNER's basic operations.

 Tips
· To suppress the display of the Welcome To Corel WEB.DESIGNER screen, click Tools, Options, and disable the 

Display Welcome Screen On Startup command.
· You can organize your Corel WEB.DESIGNER Application Window by docking the application's toolbars to the 

sides or bottom of your screen.
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Exploring the Welcome to Corel WEB.DESIGNER screen
From the Welcome to Corel WEB.DESIGNER screen, you can start a new Web page, start a new frame-based Web 
page, open an existing Web page, or choose a predesigned template to begin a Web page. For information about
the Welcome To Corel WEB.DESIGNER screen elements, click the appropriate areas of the following illustration:
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Start a new Web page
Opens a new, blank page in the Corel WEB.DESIGNER Application Window.



Start a new Web page with frames
Launches the Frame Wizard which allows you to create a new Web page that contains frames.



Open an existing Web page
Allows you to open a Web page that you have saved on your local system or to import an active Web page from 
the Internet. Web pages from the Internet are opened using the HTTP protocol.



Choose a template to begin your Web page
Opens Corel WEB.DESIGNER's Open Template dialog box which allows you to edit a predesigned Web page in the
Corel WEB.DESIGNER Application Window.



Display this screen at startup
Enables or disables the display of the Welcome To Corel WEB.DESIGNER screen when you launch the application. 
By default, Corel WEB.DESIGNER enables this command.



Exploring the Corel WEB.DESIGNER screen
Corel WEB.DESIGNER presents more than 85 menu commands with almost 60 complimentary toolbar options to 
simplify the creation of even the most complex hyperdocuments. For information about any Corel 
WEB.DESIGNER screen element, click the appropriate area of the following illustration:
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Title Bar
Repositions Corel WEB.DESIGNER's main Application Window. The Title Bar also displays the name of the active 
document, the system menu commands, and the Windows 95 control buttons.



System menu
Controls the appearance and status of the Corel WEB.DESIGNER Application Window. Click the WEB.DESIGNER 
system icon on the Title Bar to restore, move, size, minimize, maximize, or close the Corel WEB.DESIGNER 
Application Window.



Control buttons
Provides one-click access to the minimize, maximize, and close commands which allows you to collapse, expand,
or exit the Corel WEB.DESIGNER Application Window.



File menu
Provides standard menu commands for creating new files, opening existing documents, saving or printing your 
work, and exiting the application. The File menu also allows you to access the Frame wizard, publish files to the 
Internet, transfer files using FTP, import word-processing files, and set page properties.



Edit menu
Provides standard Windows menu commands for undoing and redoing actions, cutting, copying, and pasting text;
selecting, finding, and replacing objects, and editing properties.



View menu
Provides menu commands for refreshing windows, opening a new window, displaying the document tree, 
displaying the HTML source code, displaying toolbars in the Corel WEB.DESIGNER Application Window, and 
enabling and disabling the Corel WEB.DESIGNER bookmark display.



Insert menu
Provides menu commands for adding HTML elements and files to the current Web page. These commands 
include inserting forms and form fields, images, horizontal rules, paragraphs, line breaks, and scrolling text. You 
can also use the Insert menu commands to add applets written in the Java Programming Language, merge .HTML
files, insert CGI and ActiveX controls, embed Internet files, and create ordered and unordered lists.



Format menu
Provides menu commands for formatting headings; ordered and unordered lists; bookmarks; and hyperlinks in 
HTML. You can also format your Web page with blinking text and indentations.



Table menu
Provides menu commands for adding HTML tables to an active Web page. These commands allow you to insert 
and delete tables, cells, rows, or columns, merge or split cells, select table attributes, and modify standard table 
and cell properties.



Frame menu
Provides menu commands for splitting frames, inserting row or column frames, deleting frames, and modifying 
frame properties. Once you have used the Frame wizard to create a Web page containing frames, the Frame 
menu provides all of the commands necessary to edit those frames.



Tools menu
Provides menu commands to allow you to check your documents for spelling errors, access the other 
applications in the Corel WebMaster Suite, set up a server root folder, specify a browser, preview your Web 
pages, and enable the Welcome To Corel WEB.DESIGNER message.



Help menu
Provides standard Windows menu commands for accessing all online Help topics. You can search for specific Help
topics, activate the screen/menu Help or Corel WEB.DESIGNER tutorial, browse through the contents page, 
access the Corel WebMaster Suite technical support services, or launch the Corel WebMaster Suite Web Page.



Text style
Specifies formatting for headings, preformatted text, block quotations, and definition lists.



Font selection
Specifies a font to apply to selected text.



Font size
Specifies the size of selected text. You can set absolute or relative values for the font size.



Bold
Applies the boldface attribute to selected text.



Italic
Applies the italics attribute to selected text.



Underline
Applies the underline attribute to selected text.



Font/cell color
Adds color to text or to table-cell backgrounds.



Align left
Aligns the selected text or image to the left side of the page.



Center
Centers the selected text or image.



Align right
Aligns the selected text or image to the right side of the page.



Unordered list
Formats selected paragraphs in an unordered (bulleted) list.



Ordered list
Formats selected paragraphs in an ordered (numbered) list.



Definition list
Formats selected paragraphs in a definition list.



Increase indent
Increases the indentation of the selected text.



Decrease indent
Decreases the indentation of the selected text.



Line break
Inserts a line break.



Strike-through
Applies the Strike-through style to selected text.



Teletype
Applies the Typewritten or Teletype style to selected text.



Emphasis
Applies the Emphasis style to selected text.



Strong emphasis
Applies the Strong Emphasis style to selected text.



Inserted text
Applies the Inserted Text style to selected text.



Deleted text
Applies the Deleted Text style to selected text.



Code
Applies the Example Code style to selected text.



Variable
Applies the Variable style to selected text.



Literal (sample)
Applies the Sample style to selected text.



Keyboard
Applies the Keyboard or Typed Text style to selected text.



Citation
Applies the Citation style to selected text.



Short quotation
Applies the Short Quotation style to selected text.



Author
Applies the Author style to selected text.



Surname (Person)
Applies the Person style to selected text.



Term definition
Applies the Term Definition style to selected text.



Acronym
Applies the Acronym style to selected text.



Abbreviation
Applies the Abbreviation style to selected text.



New
Opens a new Corel WEB.DESIGNER Application Window.



New Frame Layout
Launches the Frame wizard to enable you to quickly and easily create a new web page containing frames.



Open
Allows you to open an existing Web page. You can open a local Web page or a Web page from the Internet.



Save
Saves the active file.



Print
Prints a Corel WEB.DESIGNER file.



Spell
Verifies the spelling in your active document.



Find
Locates a specified text string in your active document.



Cut
Removes selected data and copies it to the Windows Clipboard.



Copy
Copies selected data from your Web page into the Windows Clipboard.



Paste
Pastes data from the Windows Clipboard into the active Web page.



Edit HTML Source
Opens a new Corel WEB.DESIGNER Application Window and displays the HTML source code that corresponds to 
the active Web page.



Document tree
Displays the hierarchical structure of the HTML formatting tags within the active Web page.



Hyperlink
Allows you to format the selected text or image as a hyperlink.



Image
Allows you to add an image to your Web page.



Image map editor
Launches the Image Map Editor which allows you to edit or create an image map file.



Horizontal rule
Inserts a horizontal rule.



Insert table
Opens the Table Properties dialog box which allows you to add a table to your active Web page.



Browser preview
Launches a Web browser directly from the Corel WEB.DESIGNER Application Window.



Screen/menu help
Displays help for buttons, menu items, and window areas.



Insert form
Opens the Form Properties dialog box, which allows you to add a form to your Web page. You can also create a 
form by clicking Insert, Form.



Text field
Adds a text field to your form. You can also add a text field by clicking Insert, Form Field, Text Field.



Button
Adds a button to your form. You can also add a button by clicking Insert, Form Field, Button.



Check box
Adds a check box to your form. You can also add a check box by clicking Insert, Form Field, Check Box Field.



Radio button
Adds a radio button to your form. You can also add a radio button by clicking Insert, Form Field, Radio Button.



Selection list/menu
Adds a selection list or menu to your form. You can also add a selection list or menu by clicking Insert, Form 
Field, List/Menu.



Corel WEB.MOVE
Launches the Corel WEB.MOVE application from the Corel WEB.DESIGNER Application Window.



Corel WEB.DRAW
Launches the Corel WEB.DRAW application from the Corel WEB.DESIGNER Application Window.



Corel WEB.WORLD
Launches the Corel WEB.WORLD application from the Corel WEB.DESIGNER Application Window.



Corel WEB.GALLERY
Launches the Corel WEB.GALLERY application from the Corel WEB.DESIGNER Application Window.



Corel WEB.DATA
Launches the Corel WEB.DATA application from the Corel WEB.DESIGNER Application Window.



Corel WEB.PhotoPaint
Launches the Corel WEB.PhotoPaint application from the Corel WEB.DESIGNER window.



Text area
Displays the structure and layout of your active Web page.



Status bar
Displays command or toolbar functions at the bottom of the Corel WEB.DESIGNER Application Window. To show 
or hide the status bar, click View, Status Bar.
CAP Indicates that the Caps Lock function is enabled.
NUM Indicates that the Number Lock function is enabled.
SCRL Indicates that the Scroll Lock function is enabled.



Page Performance Indicator
Indicates the amount of time that a user will require to download your Web page.



Horizontal and vertical scroll bars
Display areas of your Corel WEB.DESIGNER document that extend beyond the boundaries of your computer 
screen. Scroll arrows sit at the end of both the horizontal and vertical scroll bars and point in the direction that 
the window moves when you press each arrow. For rapid scrolling left, right, up, or down, click and hold the 
appropriate scroll-arrows.
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Exploring the Corel WEB.DESIGNER menus
The key to operating effectively in any application is to understand the function of the menu commands. Corel 
WEB.DESIGNER offers more than 85 menu commands that allow you to open files, design advanced Web 
documents, save and preview your work, and exit the application. In fact, the Corel WEB.DESIGNER menus 
provide you with all of the commands you will need to design interactive, professional Web pages.
Before you can create logical, appealing pages that exploit the features of the Corel WebMaster Suite, you must 
further examine Corel WEB.DESIGNER's nine main menus.

 Note
· With Corel WEB.DESIGNER, you are designing advanced HTML files in a WYSIWYG environment. Each time you 

perform an operation using Corel WEB.DESIGNER's menu commands, you are combining HTML sequences 
behind the scenes.
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Corel WEB.DESIGNER menus
The Corel WEB.DESIGNER menus allow you to create and manipulate your HTML documents (also referred to as 
Web pages). In many cases, the operations you perform using menu commands are also available via toolbar 
buttons or shortcut keys.

Menu Description
File Provides menu commands for 

creating a new Web document
creating a new Web document containing frames
opening existing documents
saving, printing, and exiting
publishing to the Internet
transferring files using FTP
importing word-processing files
setting page properties such as the title, background image, and text or 
background colors

Edit Provides standard Windows menu commands for 
undoing the most recent action and redoing the action affected by the Undo 
command
cutting, copying, and pasting text
selecting, finding, and replacing text
editing the properties of selected objects

View Provides menu commands for 
refreshing windows
opening a new window or displaying the document-tree structure of the Web page
viewing and editing the HTML Source code
displaying toolbars in the Corel WEB.DESIGNER Application Window
enabling/disabling the Corel WEB.DESIGNER bookmark display

Insert Provides menu commands for adding HTML elements and files to the current Web 
page. These commands include
inserting forms and form fields
adding images, horizontal rules, paragraphs, and line breaks
adding applets written in the Java Programming Language, merging .HTML files, 
and embedding Internet files
adding scrolling text
adding ActiveX and CGI controls
creating ordered and unordered lists

Format Provides menu commands for specifying HTML formatting of text, including
creating headings, preformatted text, and block quotations
formatting ordered and unordered lists
applying hyperlink or bookmark formats
creating blinking text
increasing and decreasing indentations

Table Provides menu commands used to add HTML tables to an active Web page or to 



modify the rows, columns, and cells in an open document. The Table menu 
includes commands for
inserting tables, cells, rows, and columns
merging and splitting cells
selecting and modifying standard cell and table properties
deleting cells, rows, or columns

Frame Provides menu commands for specifying HTML frame layout. The Frame menu 
includes commands for
splitting frames
inserting row or column frames
deleting frames
modifying frame properties

Tools Provides menu commands that launch the other applications included in the Corel 
WebMaster Suite. The Tools menu includes commands for 
checking your completed documents for spelling errors
launching Corel WEB.MOVE, Corel WEB.DRAW, Corel WEB.WORLD, Corel 
WEB.GALLERY, Corel WEB.DATA, and Corel WEB.PhotoPaint
setting up a server root folder to act as the base location for all of your Web files
specifying a browser and previewing your Web pages
enabling the Welcome To Corel WEB.DESIGNER message, the Corel WebMaster 
Suite application messages, the Corel WEB.DRAW transparency option, and 
indicating your page load performance

Help Provides standard Windows menu commands for accessing all online Help topics. 
You can search for specific help topics, activate the screen/menu Help, browse 
through the contents page or the Corel WEB.DESIGNER tutorial, or access the 
Corel WebMaster Suite technical support services or the Corel WebMaster Suite 
Web Page.
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File menu commands
The File menu offers the following commands:
Command Description
New Opens a new Corel WEB.DESIGNER Application Window.
New With Frames Opens the Frame wizard which allows you to create a new Web page containing 

frames.
Open Opens an existing Web page from your local system or from the Internet.
Templates Opens a new Web page based on one of Corel WEB.DESIGNER's template files.
Save Saves the current Web page.
Save As Names and saves the current Web page.
Import Word Processor File Opens the NET Transit wizard which allows you to import your word-processor file.
Publish To Internet Opens the Instant Publishing Wizard, allowing you to publish your Web page to the

Internet.
FTP Allows you to transfer files using FTP.
Print Prints a Web page.
Print Setup Selects a printer and printer connection.
Page Properties Opens the Page Properties dialog box which allows you to display and update your 

page properties.
Exit Closes Corel WEB.DESIGNER.



Edit menu commands
The Edit menu offers the following commands:
Command Description
Undo Reverses the most recent action.
Redo Reverses the action of the Undo command.
Cut Deletes data from your Web page and copies it to the Windows Clipboard.
Copy Copies data from your Web page to the Windows Clipboard.
Paste Pastes data from the Windows Clipboard into the active Web page.
Clear Deletes data from your Web page without putting it in the Windows Clipboard.
Select All Selects the contents of the current Web page file.
Find Locates the specified text.
Find Next Locates the next instance of the specified text.
Replace Locates and replaces the specified text or item.
Properties Displays the current property settings for a selected Web page element.



View menu commands
The View menu offers the following commands:
Command Description
New Window Opens a new window which allows you to access another Web page or to create a 

new file. By using the New Window command, you can open more than one Web 
page simultaneously.

Document Tree Displays the hierarchical structure of HTML formatting tags within a Web page.
HTML Source Displays the HTML source code for the current Web page.
Frame Source Displays the HTML source code for the selected frame in your Web page.
No Frames Page Creates a page that will be displayed if your Web browser doesn’t support frames 

(corresponds to the HTML <NOFRAMES> tag).
Standard Toolbar Shows or hides the Standard toolbar.
Formatting Toolbar Shows or hides the Formatting toolbar.
Style Toolbar Shows or hides the Style toolbar.
Forms Toolbar Shows or hides the Forms toolbar.
Applications Toolbar Shows or hides the Applications toolbar.
Status Bar Shows or hides the Status Bar.
Bookmarks Shows or hides the target bookmarks in an active document.
Refresh Window Redraws the Corel WEB.DESIGNER screen.



Insert menu commands
The Insert menu offers the following commands:
Command Description
Form Adds an HTML form to your Web page (corresponds to the HTML <FORM> tag).
Form Field Adds standard HTML form-elements to a form. These include text field, text button,

check box, radio button, and list menu items.
Image Adds an image to your Web page (corresponding to the HTML <IMG> tag).
Horizontal Rule Adds a horizontal rule to your Web page (corresponding to the HTML <HR> tag)
Paragraph Inserts a blank space and moves your cursor to a new line on the Corel 

WEB.DESIGNER screen (corresponding to the HTML <P> tag)
Line Break Moves your cursor to a new line on the Corel WEB.DESIGNER screen without 

inserting a space (corresponding to the HTML <BR> tag)
Applet Opens the Applet Properties dialog box to insert Java Powered applets and specify 

Applet and Parameter values, including class, alternate text, spacing, alignment, 
and scaling properties. The Applet command corresponds to the HTML <APPLET> 
tag.

HTML File Opens the Select File dialog box to insert and merge an existing .HTML file with the
current Corel WEB.DESIGNER document. This command applies to all .HTML files, 
including those containing applets.

Embedded file Opens the Embedded File Properties dialog box to insert an external Internet file in
your current Corel WEB.DESIGNER page. Although the Embedded file command 
can be used with files of all types, most embedded objects can only be viewed 
with application specific plug-ins.

ActiveX Opens the ActiveX Control Properties dialog box to insert an ActiveX control object 
into your current Corel WEB.DESIGNER document.

Marquee Opens the Marquee Properties dialog box to insert scrolling text into your current 
Corel WEB.DESIGNER page. 

CGI Script Opens the Insert CGI Script dialog box to insert CGI scripts into your current Corel 
WEB.DESIGNER Web page. 

Ordered List Adds an ordered list to your current document (corresponding to the HTML <OL> 
tag used with the <LI> tag)

Unordered List Adds an unordered list to your current document (corresponding to the HTML 
<UL> tag used with the <LI> tag).

 Notes
· When you insert applets in Corel WEB.DESIGNER, you must copy all referenced files for the applet, including 

the corresponding images and classes.
· The Forms toolbar provides the same options for creating forms and specifying form fields as those that 

appear in the Insert menu.



Format menu commands
The Format menu offers the following commands:
Command Description
Normal Removes existing HTML tags, returning text to the normal font display.
Heading Specifies a Heading paragraph style (corresponding to HTML tags <H1> through 

<H6>).
Preformatted text Specifies a preformatted paragraph style (corresponding to the HTML <PRE> tag).
Block Quotation Specifies a Block Quotation paragraph style (corresponding to the HTML 

<BLOCKQUOTE> tag).
Blinking Text Causes the selected text to blink.
Ordered List Places selected text in an ordered (numbered) list (corresponding to the HTML 

<OL> tag used with the <LI> tag).
Unordered List Places selected text in an unordered (bulleted) list (corresponding to the HTML 

<UL> tag used with the <LI> tag).
Increase Indent Indents the selected text.
Decrease Indent Decreases the indentation of the selected text.
Hyperlink Formats the selected text or image as a hyperlink jump (corresponding to the 

HTML <A HREF> tag).
Bookmark Formats the selected text or image as bookmark (corresponding to the HTML <A 

NAME> tag).



Table menu commands
The Table menu offers the following commands:
Command Description
Insert Table Opens the Table Properties dialog box (corresponding to the HTML <TABLE> tag).
Insert Cell Adds a cell to the table (corresponding to the HTML <TD> tag).
Insert Rows/Columns Adds a row or column to the table. The Insert Rows command corresponds to the 

HTML <TR> tag. The Insert Columns command corresponds to the HTML COLSPAN
attribute with the table data tag <TD>.

Merge Cells Merges the selected cells in the current table.
Split Cells Opens the Split Cells dialog box, allowing you to split table cells into vertically into 

columns or horizontally into rows.
Delete Cell Deletes a cell from a row in the current table.
Delete Row Deletes a row from all columns in the current table.
Delete Column Deletes a column from all rows in the current table.
Select Cell Selects a table cell for modification.
Select Row Selects a table row for modification.
Select Column Selects a table column for modification.
Select Table Selects the entire table and its contents for modification.
Cell Properties Opens the Cell Properties dialog box which allows you to adjust cell size, type, and 

alignment.
Table Properties Opens the Table Properties dialog box which allows you to adjust the table width, 

alignment, spacing, and layout.
 Note

· All commands in the Table menu, except Insert Table, are only available if your cursor is positioned inside an 
active table.



Frame menu commands
The Frame menu offers the following commands:
Split Frame Splits the selected frame. If your cursor is placed in a row frame, the Split Frame 

command adds another row frame to your Web page. If your cursor is placed in a 
column frame, the Split Frame command adds another column frame to your Web 
page.

Insert Row Frame Adds a row frame to your Web page.
Insert Column Frame Adds a column frame to your Web page.
Delete Frame Removes the selected frame from your Web page.
Properties Opens the Frame Properties dialog box which allows you to modify the properties 

of the frames in your Web page. You can also use the Frame Properties dialog box 
to modify standard page properties.



Tools menu commands
The Tools menu offers the following commands:
Command Description
Spelling Check Verifies the spelling of all text in your Web page.
Corel WEB.MOVE Launches Corel WEB.MOVE from the Corel WEB.DESIGNER Application Window.
Corel WEB.DRAW Launches Corel WEB.DRAW from the Corel WEB.DESIGNER Application Window.
Corel WEB.WORLD Launches Corel WEB.WORLD from the Corel WEB.DESIGNER Application Window.
Corel WEB.GALLERY Launches Corel WEB.GALLERY from the Corel WEB.DESIGNER Application Window.
Corel WEB.DATA Launches Corel WEB.DATA from the Corel WEB.DESIGNER Application Window.
Corel WEB.PhotoPaint Launches Corel WEB.PhotoPaint from the Corel WEB.DESIGNER Application 

Window.
Browser Preview Launches an HTML browser from the Corel WEB.DESIGNER Application Window 

which allows you to preview your current document on the World Wide Web.
Set Browser Opens the Select HTML Browser dialog box which allows you to specify the 

browser that you want to use to preview your Corel WEB.DESIGNER documents.
Set Server Root Specifies a folder as your server root or base folder. The server root folder stores 

all the .HTML and graphics files that you use in your Web pages.
Options Allows you to enable or disable the Welcome To Corel WEB.DESIGNER screen, the 

Corel WebMaster Suite application-launch messages, the Enable Lower Case File 
Names option, and the Corel WEB.DRAW transparency option.



Help menu commands
The Help menu offers the following commands to provide assistance with Corel WEB.DESIGNER:
Command Description
Contents Provides an entry point to task-oriented Help topics.
Screen/Menu Help Displays context-sensitive Help for buttons, menu items, and window 

displays.
Search For Help On Provides an index to all Help topics.
Technical Support Displays technical support or customer service information.
Tutorial Opens the Corel WEB.DESIGNER tutorial    a hands-on approach to 

learning Corel WEB.DESIGNER.
WebMaster Suite Web Page Opens the Corel WebMaster Suite Web Page directly from the Corel 

WEB.DESIGNER Application Window.
About Corel WEB.DESIGNER Displays the application version number and registration information.



Exploring the Corel WEB.DESIGNER toolbars



Exploring the Corel WEB.DESIGNER toolbars
Corel WEB.DESIGNER provides Standard, Formatting, Style, Forms, Applications, and Status toolbars to 
compliment the application's menu commands and to provide quick, one-step access to the most popular design 
features. These toolbars give Web artists immediate access to Corel WEB.DESIGNER's most popular commands 
to allow you to format text; create, save, preview, and close files; design forms and tables; or access the other 
programs in the Corel WebMaster Suite.
You can dock each of the Corel WEB.DESIGNER toolbars to the sides or bottom of the Application Window, 
allowing you to optimize your work space and access Corel WEB.DESIGNER's primary operations without leaving 
the main screen.

 Note
· You can display the Corel WEB.DESIGNER toolbars by clicking View and enabling or disabling the appropriate 

toolbar name.
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Using toolbars
Corel WEB.DESIGNER's toolbars allow you quick access the application's most common authoring commands. 
You can hide or display the Corel WEB.DESIGNER toolbars by enabling or disabling the appropriate name in the 
View menu.

Toolbar Description
Standard Toolbar Provides functions to 

create a new file or open an existing document
save, find, cut, copy, and paste text
spell check and print files
edit HTML source code
view the Web document-tree structure of a Web page
insert an image, hyperlink, horizontal rule, or table
access the Image Map Editor and Screen/Menu Help
launch a Web browser

Formatting Toolbar Provides functions to
format paragraph styles
specify font type and size
apply bold, italic, and underline formats
specify font and cell color
align text to the left, center, and right
create bulleted and numbered lists
increase or decrease the indentation of text
insert line breaks

Style Toolbar Provides advanced HTML formatting tags. This toolbar is not displayed when you 
launch Corel WEB.DESIGNER.

Forms Toolbar Provides functions to
insert forms
add standard HTML form elements including text fields, radio buttons, check 
boxes, submit and reset buttons, lists, and menus.

Applications Toolbar Provides access to each program in the Corel WebMaster Suite. The Applications 
toolbar allows you to launch
Corel WEB.MOVE
Corel WEB.DRAW
Corel WEB.WORLD
Corel WEB.GALLERY
Corel WEB.DATA
Corel WEB.PhotoPaint

Status Bar Provides messages related to current operations and program status and displays 
the estimated download time of your current Web page.

To determine the function of particular toolbar buttons, slowly pass your cursor over an unfamiliar icon. Corel 
WEB.DESIGNER displays a short "tool tip" description of the item that details its function. A more extensive 
description of the button's function appears in the Corel WEB.DESIGNER Status bar at the bottom of the 
Application Window.
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Formatting Toolbar buttons
HTML formatting options provided on the Corel WEB.DESIGNER Formatting toolbar include the following:

Icon Description Function or HTML Tag
N/A Text Style 

Selection list 
box 

Specifies formatting for headings (which 
corresponds to HTML tags <H1> through 
<H6>), preformatted blocks (<PRE> tag), and 
block quotations (<BLOCKQUOTE> tag).

N/A Font Selection
list box 

Specifies a font typeface for displaying text 
which corresponds to the HTML <FONT 
FACE=> tag.

N/A Font Size list 
box

Specifies the font size of selected text which 
corresponds to the <FONT SIZE=> tag. You 
can specify absolute or relative values for the 
size.

Bold Specifies the boldface attribute which 
corresponds to the <B> tag.

Italic Specifies the italics attribute which 
corresponds to the <I> tag.

Underline Specifies the underline attribute which 
corresponds to the <U> tag.

Font/Cell Color Specifies a color attribute for text or table cell 
backgrounds.

Align Left Aligns the selected text or image to the left 
side of the page which corresponds to the <P 
ALIGN=LEFT> tag.

Align Center Centers the selected text or image which 
corresponds to the <P ALIGN=CENTER> 
attribute or <CENTER> and </CENTER> 
container tags in HTML.

Align Right Aligns the selected text or image to the right 
side of the page which corresponds to the <P 
ALIGN=RIGHT> tag.

Unordered List Creates an unordered (bulleted) list from 
selected paragraphs which corresponds to the 
use of the <UL> tag and the <LI> tag 

Ordered List Creates an ordered (numbered) list from 
selected paragraphs which corresponds to the 
use of the <OL> tag and the <LI> tag 

Increase 
Indent

Indents the selected text.

Decrease 
Indent

Removes the indent from selected text.

Line Break Inserts a line break which corresponds to the 
HTML <BR> tag.

 Note
· Some of the formatting options provided in Corel WEB.DESIGNER's Formatting toolbar are not supported by 

less sophisticated browsers and may be ignored or distorted when displayed on the Web.



Style Toolbar buttons
The Style toolbar provides the following advanced formatting options:

Icon Description Function or HTML Tag
Strike-
through

Applies the strike-through attribute to 
selected text which corresponds to the HTML
<S> tag.

Typewritten 
or Teletype

Applies the typewritten or teletype attribute 
to selected text which corresponds to the 
HTML <TT> tag.

Emphasis Applies the emphasis attribute to selected 
text which corresponds to the HTML <EM> 
tag.

Strong 
Emphasis

Applies the strong emphasis attribute to 
selected text which corresponds to the HTML
<STRONG> tag.

Inserted Text Applies the inserted text attribute to 
selected text which corresponds to the HTML
<INS> tag.

Deleted Text Applies the deleted text attribute to selected
text which corresponds to the HTML <DEL> 
tag.

Example 
Code

Applies the example code attribute to 
selected text which corresponds to the HTML
<CODE> tag.

Variable Applies the variable attribute to selected 
text which corresponds to the HTML <VAR> 
tag.

Literal 
(Sample)

Applies the sample attribute to selected text
which corresponds to the HTML <SAMP> 
tag.

Typed Text Applies the keyboard or typed text attribute 
to selected text which corresponds to the 
HTML <KBD> tag.

Citation Applies the citation attribute to selected text
which corresponds to the HTML <CITE> tag.

Short 
Quotation

Applies the short quotation attribute to 
selected text which corresponds to the HTML
<Q> tag.

Author Applies the author attribute to selected text 
which corresponds to the HTML <AU> tag.

Surname or 
Person

Applies the person attribute to selected text 
which corresponds to the HTML <PERSON> 
tag.

Term 
definition

Applies the term definition attribute to 
selected text which corresponds to the HTML
<DFN> tag.

Acronym Applies the acronym attribute to selected 
text which corresponds to the HTML 
<ACRONYM> tag.



Abbreviation Applies the abbreviation attribute to 
selected text which corresponds to the HTML
<ABBREV> tag.

Forms Toolbar buttons
The Forms toolbar provides the following options:

Toolbar 
Icon

Form 
Element

Description

Insert 
Form

Creates a new form which corresponds to the 
HTML <FORM> tag. You can also create a new 
form by clicking Insert, Form.

Text field Creates a new text field which corresponds to 
the HTML "text" <INPUT TYPE>. You can also 
create a new text field on a form by clicking 
Insert, Form Field, Text Field.

Button Creates a new button which corresponds to 
either the HTML "submit" or "reset" <INPUT 
TYPE>. You can also create a new button on a 
form by clicking Insert, Form Field, Button.

Check 
Box

Creates a new check box field which corresponds
to the HTML "checkbox" <INPUT TYPE>. You can 
also create a new check box field on a form by 
clicking Insert, Form Field, Check Box Field.

Radio 
button

Creates a new radio button which corresponds to
the HTML "radio" <INPUT TYPE>. You can also 
create a new radio button on a form by clicking 
Insert, Form Field, Radio Button.

Selection 
list or 
menu

Creates a new selection list or menu which 
correspond to the HTML <SELECT> tag. You can 
also create a new selection list or menu on a 
form by clicking Insert, Form Field, List/Menu.

Standard Toolbar buttons
The Standard toolbar provides the following options:

Icon Description Function 
New Opens a new Corel WEB.DESIGNER 

Application Window.
Open Opens an existing Web page from your local 

system or from the Internet.
Save Saves the current file.
Print Prints a Corel WEB.DESIGNER file.
Spell Verifies all spelling in your Corel 

WEB.DESIGNER document.
Find Locates a specified text string in your Corel 

WEB.DESIGNER document.
Cut Removes selected data and copies it to the 

Windows Clipboard.
Copy Copies selected data from your Web page to

the Windows Clipboard.



Paste Pastes data from the Windows Clipboard into
the active Web page.

Edit HTML 
Source

Opens a new Corel WEB.DESIGNER 
Application Window, displaying the HTML 
code that corresponds to the current Web 
page.

Document 
Tree

Displays the hierarchical structure of the 
HTML formatting tags within the Web page.

Hyperlink Formats the selected text as a hyperlink 
which corresponds to the HTML <A HREF=> 
tag.

Image Adds an image to your Web page.
Image Map 
Editor

Launches the Image Map Editor which allows
you to edit or create an image map file for a 
selected graphic.

Horizontal 
Rule

Inserts a horizontal rule to your Web page.

Insert Table Opens the Table Properties dialog box which 
allows you to add a table to your Web page.

Browser 
Preview

Launches a Web browser directly from the 
Corel WEB.DESIGNER Application Window.

Screen/Menu 
Help

Displays Help for buttons, menu items, and 
window areas.

Applications Toolbar buttons
The Applications toolbar provides the following options:

Icon Description Function
Corel 
WEB.MOVE

Launches Corel WEB.MOVE from 
the Corel WEB.DESIGNER 
Application window.

Corel 
WEB.DRAW

Launches Corel WEB.DRAW from 
the Corel WEB.DESIGNER 
Application window.

Corel 
WEB.WORLD

Launches Corel WEB. WORLD from
the Corel WEB.DESIGNER 
Application window.

Corel 
WEB.GALLERY

Launches Corel WEB. GALLERY 
from the Corel WEB.DESIGNER 
Application window.

Corel 
WEB.DATA

Launches Corel WEB. DATA from 
the Corel WEB.DESIGNER 
Application window.

Corel 
WEB.PhotoPain
t

Launches Corel WEB.PhotoPaint 
from the Corel WEB.DESIGNER 
Application window.

 Note
· The Applications toolbar buttons launch the corresponding program without closing your Corel WEB.DESIGNER 

window. This allows you to automatically merge work created in any Corel WebMaster Suite application with 
your Corel WEB.DESIGNER file, which ultimately improves the quality and variety of your pages.



Status Bar

Displays command or toolbar functions at the bottom of the Corel WEB.DESIGNER Application Window. The Status 
Bar also displays the Page Load Performance Indicator to estimate the download time of your Web page. 

CAP Indicates that the Caps Lock function is enabled.
NUM Indicates that the Number Lock function is enabled.
SCRL Indicates that the Scroll Lock function is enabled.
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Organizing files
After you have designed your Web pages using Corel WEB.DESIGNER's advanced Web authoring tools, you must 
organize your files for publication on the World Wide Web. If you choose to FTP your files to an external service 
provider, the Web pages that you create with Corel WEB.DESIGNER will be placed on a server that Internet users 
can access. Ideally, your service provider or "Webmaster" will assign a folder on the server to store your files. To 
ensure a seamless transfer of files from your machine to the server, we recommend that you emulate the 
server's folder structure on your local system.
Corel WEB.DESIGNER helps you mirror the server structure by instructing you to set a server root folder. Ideally, 
this root should have the same name as the folder that stores your files on the server. For example, if all your 
pages reside in the server folder USER, you should set up a folder called USER on your hard drive and set the 
document root to be the same. Parallel folder structures eliminates file transfer errors and makes it easy to 
update and edit your Web pages after they have been published on the Web.
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Working with subfolders
As you add more and more pages to your Web site, you can maintain an organized folder structure by 
establishing subfolders within your root folder. For example, you may want to have a subfolder called IMAGES 
that contains all your .GIF and .JPG files. 
When you create subfolders within your server root folder, it's important to consider the implications that file-
storage locations may have on previewing and testing your Web pages. To test your Corel WEB.DESIGNER 
documents locally, all files must be referenced relative to the location of the current page. For example, if you 
create a hyperlink in your Corel WEB.DESIGNER document that jumps to an image called LOGO.GIF in the 
subfolder IMAGES, the hyperlink must reference the image's location as IMAGES/LOGO.GIF. 

 Tip
· To view an accurate representation of your Corel WEB.DESIGNER documents on your local system, ensure that 

the main HTML file resides in the server root folder and that any referenced files reside in subfolders within the
server root folder.
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Working with common folders
Depending on the folder structure that you've designed for your Web pages, you may be required to access 
common images, e.g., logos, from a central folder that lies outside of your server root folder. However, file 
references outside of your server root folder may not work when you test your page locally with a browser. 
To view an accurate representation of your page on your local system, you can use a substitute file. Simply 
reference a file in your server root folder or in a subfolder of your server root to preview your page. However, 
when you place your page on a server for final publication, you must reference the file that resides in the 
common folder outside of the server root folder.

 Note
· If you reference a file that resides in a common folder, external to your server root folder, you will not be able 

to view an accurate representation of your page on your local system. However, all hyperlinks, images etc. 
that are referenced to common folders outside of the server root folder will function correctly when placed on 
the server.
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Understanding Corel WEB.DESIGNER's management tools
Corel WEB.DESIGNER's powerful document-management tools allow you to organize and view your pages prior 
to publishing them on the World Wide Web. Corel WEB.DESIGNER's server-root and preview features combine the
flexibility of HTML tags and the organized structure of a word-processing mechanism with the advanced interface
of a WYSIWYG Web editor.

Server Root
The first time that you launch the Corel WEB.DESIGNER application, you will be asked to set a server root folder 
for your HTML projects. The server root stores all the .HTML files that you create using Corel WEB.DESIGNER and 
provides the base location from which Corel WEB.DESIGNER resolves relative URLs to image files and other 
hyperlinked documents. To set a server root, type the path to a folder on your local system or click Browse and 
search your system for the appropriate location. 
You should store all referenced files, e.g., images, in the same folder as your Web page or in a subfolder of your 
server root. If you store referenced files in a folder other than your server root, you will not be able to view an 
accurate representation of your Web page on your local system.

Browser Preview
When Web pages were constructed solely in HTML code, they had to be saved and opened in a browser to view 
the results of your HTML programming.
Corel WEB.DESIGNER's Browser Preview command launches a Web browser directly from the main Application 
Window to allow you to see how your active document will be displayed on the World Wide Web. Although Corel 
WEB.DESIGNER's WYSIWYG interface accurately presents the structure and layout of your page, previewing 
displays the minor differences in color and style that might occur when you publish your documents on the Web. 
Previewing also allows you to test the links and objects in your page. 

 Note
· To preview documents, you must set a default browser. Click Tools, Set Browser, and choose your browser's 

executable file (.EXE). 
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Documentation conventions
As you read the Corel WebMaster Suite online Help, you'll notice a number of mouse and keyboard conventions 
that we've used to help speed up the learning process. The following table explains the conventions that you'll 
see most often.
When you see this... Do this...
Click File, New Using the mouse, click the File menu, then drag down to the New 

command, and click again.
Click Format, Heading, Heading 1 Using the mouse, click the Format menu, click the Heading 

command to open its submenu, then click the Heading 1 command.
Enable a check box Using the mouse, click the check box to place a check mark or an X 

inside the check box.
Disable a check box Using the mouse, click the check box to remove the check mark or 

X inside the check box.
Select Using the mouse, click or click and drag to highlight an object or 

text string.
Choose Top from the Alignment list box Using the mouse, click the Alignment list box and click the Top 

option.
Right-click, then click Paste Click the right mouse button to open a submenu, then click the 

Paste option with the left mouse button.
Press ENTER Press the ENTER key on your keyboard.
Press CTRL + SHIFT Press the CTRL and SHIFT keys at the same time.
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Using Help
The Corel WebMaster Suite features new and enhanced documentation to meet your most requested 
documentation needs. The comprehensive online Help system provides easy access to descriptions and 
procedures that cover all application features and functions. In addition to online Help, the Corel WebMaster 
Suite also includes an extensive User Manual.
The documentation set comprises the following:

Online Help
The online Help system allows you to retrieve all of the information that you need to operate effectively 
throughout the Corel WebMaster Suite. Help topics appear in a separate window on your Corel WEB.DESIGNER 
screen which allows you to locate information quickly and to return immediately to your work. For quick 
reference, you can keep the Help window displayed on top of the Corel WEB.DESIGNER Application Window. You 
can also print specific topics from the online Help system.

Online tutorial
The online tutorial gives you the skills you need to create dynamic World Wide Web pages using Corel 
WEB.DESIGNER's advanced authoring tools. 

Context-sensitive Help
The context-sensitive Help displays information that is relevant to the current status of the application and 
provides information on using commands.

Online ToolTips
Online ToolTips provide information about icons and buttons on the toolbars and the Toolbox. ToolTips display in a
balloon when you position the cursor over a button.

User's Guide
The Corel WebMaster Suite User's Guide provides comprehensive documentation that you read at your leisure.
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Using online Help
When you click Help Topics from the Help menu, the Corel WEB.DESIGNER Help dialog box opens. This dialog box
allows you to find the help you need by searching a table of contents, a keyword index, or specific words.

To access online Help
1. Click Help, Help Topics.
2. In the Corel WEB.DESIGNER Help dialog box, click one of the following tabs:

· Contents    to display conceptual and procedural information
· Index    to search by feature names, synonyms, and tasks
· Find    to search for specific words in online Help topics
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Accessing context-sensitive Help
Context-sensitive Help is accessible from wherever you are in Corel WEB.DESIGNER. You can access context-
sensitive Help from menus, dialog boxes, and all toolbars in Corel WEB.DESIGNER.
The following table shows the most common ways to access context-sensitive Help.
To get help on... Do this...
Dialog boxes Click the Help button or press F1.
Menu commands Click the Help button on the toolbar, click a menu, and click a 

command.
Or, press F1 when a command is highlighted.

Tools and controls Click the Help button on the toolbar, then click the item for which 
you want help.

 Tip
· Use the Status Bar at the bottom of the Corel WEB.DESIGNER Application Window to familiarize yourself with 

the tools. The Status Bar displays details about buttons, controls, and menu commands as you move the 
cursor over them.
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Printing Help
You can print specific Help topics or print entire sections of online Help.
To print... Do this...
An entire section of Help In the Contents page, click the book icon that represents the Help section, then 

click the Print button at the bottom of the dialog box.
An overview topic Click the Print button at the top of the topic window.
A How-to topic Right-click the topic window, then click Print Topic.
A context-sensitive Help topic Right-click the topic window, then click Print Topic.
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About Corel Corporation
Corel Corporation is recognized internationally as a world leader in the development of computer-based graphics 
and multimedia software. To help us continue to meet our quality standards, we actively seek your input. With 
this input, we can create products that work best for you, the users of Corel products.
Corel ships its products through a network of more than 160 distributors in 70 countries worldwide. Corel is 
traded on the Toronto Stock Exchange (symbol: COS) and the NASDAQ National Market System (symbol: COSFF). 
For more information about Corel and our products, visit our World Wide Web site at http://www.corel.com.

Contacting us
In our continuing efforts to help you get the most from the Corel WebMaster Suite, we are seeking new and 
better ways to document our products. If you've developed a unique Web page, please share it with us. Send us 
the details and we may include them, with due credit to you, of course, in future Corel WebMaster Suite learning 
materials. Contact us by email at webmastersuite@corel.ca or address your letter to:
Corel WebMaster Suite Documentation Manager,
Corel Corporation,
1600 Carling Avenue,
Ottawa, Ontario
Canada 
KIZ 8R7
Fax: (613) 728–9790

Visit the Corel WebMaster Suite Web page at http://www.corel.com/webmaster.
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Viewing application information
Program information consists of the program name, version number, serial number, and user name. This 
information doesn't change. You'll find this information particularly useful if you ever need help from Corel 
Technical Support Services.

To view program information
Depending on which application you’re currently working in, click Help, and click one of the following:
· About Corel WEB.DESIGNER
· About Corel WEB.DATA
· About Corel WEB.PhotoPaint
· About Corel WEB.SiteManager
· About Corel WEB.MOVE
· About Corel WEB.DRAW
· About Corel WEB.WORLD
· About Corel WEB.GALLERY
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